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Overview

Overview

About this manual

This manual describes how to create, program and simulate robot cells and stations using
RobotStudio. For online programming, this manual describes how to supervise, install,
configure and program a real robot controller. Terms and concepts related to offline and
online programming are also explained.

RobotStudio offers the following installation options:
e Complete
¢ Custom, allowing user-customized contents and paths
e Minimal, running RobotStudio in Online mode only

Usage
This manual should be used when working with either the offline or online functions of
RobotStudio.

Who should read this manual?
This manual is intended for RobotStudio users, proposal engineers, mechanical designers,
offline programmers, robot technicians, service technicians, PLC programmers, Robot
programmers, and Robot System integrators.

Prerequisites
The reader should have basic knowledge of:

* Robot programming
» Generic Windows handling
e 3D CAD programs

Organization of chapters
The operating manual is structured in the following chapters:

Chapter Contents

1. Introduction Contains installation instructions, basic explanations of the
terms and concepts related to robotics and programming, and a
description of the GUI.

2. How to build Describes how to build stations in RobotStudio. This includes
stations importing and configuring the equipment to be simulated, as
well as testing the reachability for finding the optimal station
layout.
3. How to program Describes how to create robot movements, I/O signals, process
robots instructions and logics in a RAPID program for the robots. It also
describes how to run and test the program.
4. How to simulate Describes how to simulate and validate robot programs.
programs
5. Deployment and Describes how to transfer systems between RobotStudio’s
distribution virtual controllers and real IRC5 controllers, how to copy

programs, how to package an active station for moving between
RobotStudio PCs, and how to capture a screen.

Continues on next page
3HAC032104-001 Revision: D 9




Overview

Continued
Chapter Contents
6. Working online Covers the functionality of the Minimal Installation, describing
such online functions as building systems (with offline
examples), handling I/O and events, and configuring systems.
7. The Application Describes the controls that can be accessed from the
Menu RobotStudio button in the upper left corner of the GUI.
8. The Home Tab Describes the controls required for building stations, creating
systems, programming paths and placing items.
9. The Modeling Tab  Describes the controls for creating and grouping components,
creating bodies, measurements and CAD operations.
10. The Simulation Tab Describes the controls for setting up, configuring, controlling,
monitoring, and recording simulations.
11. The Online and Describes the controls in Online tab and Offline tab.
Offline Tabs Online tab contains the controls for managing the real
controllers
Offline tab contains the controls for synchronization, configura-
tion and tasks assigned to the virtual controller (VC).
12. The Add-Ins Tab Describes the control for PowerPacs and the Visual Studio
Tools for Applications (VSTA).
13. The Context Menus Describes the options available from the context menus.
14. The ScreenMaker  Describes the ScreenMaker development tool, how to manage
tab projects in ScreenMaker and the various menus and commands
used in the application.
References
Reference Document Id
Product manual - IRC5 3HAC021313-001
Operating manual - IRC5 with FlexPendant 3HAC16590-1
Technical reference manual - RAPID overview 3HAC16580-1
Technical reference manual - System parameters 3HAC17076-1
Application manual - MultiMove 3HAC021272-001
Application manual - Conveyor tracking 3HAC16587-1

Continues on next page
10 3HAC032104-001 Revision: D
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Overview

Continued

Revisions

Revision
A

Description

First revision, called RobotStudio 2008, released for Partner Days. Tne
entire manual has been adapted to the new GUI, in which RobotStudio®™
line has been integrated.
Released with RobotStudio 5.12.
The following updates were made in the manual:

» Conveyor Tracking on page 311

e Create Conveyor mechanism on page 287

e Conveyor Simulation on page 312

» Two robot systems sharing the same task frame position on page
63

» Two robot systems having different task frame positions on page
65

» Creating a system with external axes automatically on page 67

e Setting up a system with track motion of type RTT or IRBTx003
manually on page 69

e Setting up a system with track motion of type IRBTx004 manually
on page 70
e The Operator Window on page 45
e Station Viewer on page 180
» Recording the simulation on page 310
» Viewpoint on page 230
e Linked Geometry on page 392
Released with RobotStudio 5.13.
* Merged chapters The Offline tab and The Online tab
» Added the missing information from RobotStudio Online manual.
* Integrated ScreenMaker. See ScreenMaker on page 328.
Added the following new sections:
e Smart Component on page 236
e The Simulation Watch window on page 266
e The Document Manager window on page 47
e Station Logic on page 304
e Simulation Setup on page 297
Updated the changes related to handling Task Frames.
» Updated Modifying Task frame on page 369.
» Added Placing robots on page 88.
e Updated Creating a system from layout on page 192.

Released with RobotStudio 5.13.02
The ScreenMaker tutorial was updated. See Tutorial on page 465 .

3HAC032104-001 Revision: D
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Product documentation, M2004

Product documentation, M2004

Categories for manipulator documentation

The manipulator documentation is divided into a number of categories. This listing is based
on the type of information in the documents, regardless of whether the products are standard
or optional.

All documents listed can be ordered from ABB on a DVD. The documents listed are valid for
M2004 manipulator systems.

Product manuals

Manipulators, controllers, DressPack/SpotPack, and most other hardware will be delivered
with a Product manual that generally contains:

Safety information.

Installation and commissioning (descriptions of mechanical installation or electrical
connections).

Maintenance (descriptions of all required preventive maintenance procedures
including intervals and expected life time of parts).

Repair (descriptions of all recommended repair procedures including spare parts).
Calibration.

Decommissioning.

Reference information (safety standards, unit conversions, screw joints, lists of tools ).
Spare parts list with exploded views (or references to separate spare parts lists).
Circuit diagrams (or references to circuit diagrams).

Technical reference manuals

The technical reference manuals describe the manipulator software in general and contain
relevant reference information.

RAPID Overview: An overview of the RAPID programming language.

RAPID Instructions, Functions and Data types: Description and syntax for all
RAPID instructions, functions, and data types.

RAPID Kernel: A formal description of the RAPID programming language.
System parameters: Description of system parameters and configuration workflows.

Continues on next page

12

3HAC032104-001 Revision: D

© Copyright 2008-2010 ABB. All rights reserved.



© Copyright 2008-2010 ABB. All rights reserved.

Product documentation, M2004

Continued

Application manuals

Specific applications (for example software or hardware options) are described in
Application manuals. An application manual can describe one or several applications.

An application manual generally contains information about:

The purpose of the application (what it does and when it is useful).

What is included (for example cables, 1/0 boards, RAPID instructions, system
parameters, CD with PC software).

How to install included or required hardware.
How to use the application.
Examples of how to use the application.

Operating manuals

The operating manuals describe hands-on handling of the products. The manuals are aimed
at those having first-hand operational contact with the product, that is production cell
operators, programmers, and trouble shooters.

The group of manuals includes (among others):

Emergency safety information

General safety information

Getting started, IRC5 and RobotStudio
Introduction to RAPID

IRC5 with FlexPendant

RobotStudio

Trouble shooting, for the controller and manipulator.

3HAC032104-001 Revision: D
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Safety

Safety

Safety of personnel

A robot is heavy and extremely powerful regardless of its speed. A pause or long stop in
movement can be followed by a fast hazardous movement. Even if a pattern of movement is
predicted, a change in operation can be triggered by an external signal resulting in an
unexpected movement.

Therefore, it is important that all safety regulations are followed when entering safeguarded
space.

Safety regulations

Before beginning work with the robot, make sure you are familiar with the safety regulations
described in the manual Operating manual - General safety information.

14
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1 Introduction

1 Introduction

1.1 Terms and Concepts

1.1.1. Hardware concepts

1.1.1. Hardware concepts

Overview

This section introduces the hardware in a typical IRC5 robot cell. For detailed explanations,
see the manuals related to IRC5 robots specified in References on page 10.

Standard hardware

The table below describes the standard hardware in an IRC5 robot cell.

Hardware

Robot manipulator
Control module

Drive module

FlexController

FlexPendant

Tool

Explanation

An ABB industrial robot.

Contains the main computer that controls the motion of the
manipulator. This includes RAPID execution and signal
handling. One control module can be connected to 1 — 4 drive
modules.

A module containing the electronics that power the motors of a
manipulator. The drive module can contain up to nine drive
units, each controlling one manipulator joint. Since the standard
robot manipulators have six joints, you usually use one drive
module per robot manipulator.

The controller cabinet for the IRCS5 robots. It consists of one
control module and one drive module for each robot manipulator
in the system.

The programming pendant, connected to the control module.
Programming on the FlexPendant is referred to as “online pro-
gramming”.

A device usually mounted on the robot manipulator to allow it to
perform specific tasks, such as gripping, cutting or welding.
The tool can also be stationary, see below for more information.

Optional hardware

The table below describes the optional hardware for an IRC5 robot cell.

Hardware

Track manipulator

Positioner manipulator

FlexPositioner

Stationary tool

Work piece

Explanation

A moving stand holding the robot manipulator to give it a larger
work space. When the control module controls the motion of a
track manipulator, it is referred to as a “Track External Axis”.

A moving stand normally holding a work piece or a fixture. When
the control module controls the motion of a positioner manipula-
tor, it is referred to as an “External Axis”.

A second robot manipulator acting as a positioner manipulator.
It is controlled by the same control module as the positioner
manipulator.

A device that stands in a fixed location. The robot manipulator
picks up the work piece and brings it to the device to perform
specific tasks, such as gluing, grinding or welding.

The product being worked on.

Continues on next page
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Continued
Hardware Explanation
Fixture A construction holding the work piece in a specific position so
that the repeatability of the production can be maintained.
16 3HAC032104-001 Revision: D
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1.1.2. RobotWare concepts

Overview
This section introduces terminology regarding RobotWare. For detailed explanations, see the
manuals related to IRC5 robots specified in References on page 10.

RobotWare

The table below describes the RobotWare terminology and concepts that can be useful when
working with RobotStudio.

Concept Explanation

RobotWare As a concept, refers to both the software used to create a
RobotWare System and the RobotWare systems themselves.

RobotWare DVD Delivered with each control module. On the DVD you will find

the RobotWare installation and some other useful software.
Check the Release Notes on your DVD for specifications.

RobotWare installation When installing RobotWare on a PC, you install into the
mediapool the specific versions of the files from which
RobotStudio uses to create the RobotWare system.

When installing RobotStudio, only one version of RobotWare
will be installed. To simulate a specific RobotWare system, the
RobotWare version used for this particular RobotWare system
must be installed on your PC.

RobotWare Key Used when you create a new RobotWare system or upgrade an
existing system. The RobotWare keys unlock the RobotWare
options included in the system, and determine the RobotWare
version from which the RobotWare system will be built.

For IRC5 systems there are three types of RobotWare keys:
* The controller key, which specifies the controller and
software options.
e The drive keys, which specify the robots in the system.
The system has one drive key for each robot it uses.
« Additional option keys, which specify additional options,
like positioner external axes.
A virtual key allows you to select any RobotWare options you

wish, but a RobotWare system created from a virtual key can
only be used in a virtual environment such as RobotStudio.

RobotWare system A set of software files that, when loaded into a controller,
enables all functions, configurations, data and programs
controlling the robot system.

RobotWare systems are created in the RobotStudio software.
The systems can be stored and saved on a PC, as well as on
the control module.

RobotWare systems can be edited by RobotStudio or the Flex-
Pendant.

RobotWare version Each RobotWare is released with a major and a minor version
number, separated by a dot. The RobotWare version for IRC5 is
5.xx, where xx identifies the minor version.

When ABB releases a new robot model, a new RobotWare
version will be released with support for the new robot.

Continues on next page
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Continued

Concept

Mediapool

Explanation

The mediapool is a folder on the PC in which each RobotWare
version is stored in a folder of its own.

The files of the mediapool are used to create and implement all
the different RobotWare options. Therefore, the correct
RobotWare version must be installed in the mediapool when
creating RobotWare systems or running them on virtual control-

lers.

18
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1.1.3. RAPID concepts

This section introduces the basic terminology of RAPID. For detailed explanations, see the
manuals related to RAPID and programming specified in References on page 10.

Terminology of the RAPID structure

The table below describes the RAPID terminology that you may come across when working
with RobotStudio. The concepts are listed by size, from most basic to increasingly large.

Concept

Data declaration

Instruction

Move instructions

Action instruction

Routine

Procedure
Function
Trap
Module

Program module (.mod)

System module (.sys)

Program files (.pgf)

Explanation

Used to create instances of variables or data types, like num or
tooldata.

The actual code commands that make something happen, for
example, setting data to a specific value or a robot motion.
Instructions can only be created inside a routine.

Create the robot motions. They consist of a reference to a target
specified in a data declaration along with parameters that set
motion and process behavior. If inline targets are used, the
position is declared in the move instructions.

Instructions that perform other actions than moving the robot,
such as setting data or sync properties.

Usually a set of data declarations followed by a set of instruc-
tions implementing a task. Routines can be divided into three
categories: procedures, functions and trap routines.

A set of instructions that does not return a value.
A set of instructions that returns a value.
A set of instructions that is triggered by an interrupt.

A set of data declarations followed by a set of routines. Modules
can be saved, loaded and copied as files. Modules are divided
into program modules and system modules.

Can be loaded and unloaded during execution.

Used mainly for common system-specific data and routines, for
example, an arcware system module that is common for all arc
robots.

In IRC5 a RAPID program is a collection of module files (.mod)
and the program file (.pgf.) that references all the module files.
When loading a program file, all old program modules are
replaced by those referenced in the .pdf file. System modules
are unaffected by program load.

3HAC032104-001 Revision: D
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1.1.4. Concepts of programming

Overview

This section introduces the terminology regarding programming. For detailed explanations,
see the manuals related to programming and IRC5 Robots specified in References on page 10.

Programming concepts

The table below describes the terminology and concepts that are used in robot programming.

Concept

Online programming
Offline programming

True offline

programming

Virtual controller

MultiMove

Coordinate systems

Frame
Workobiject calibration

Explanation

Programming connected to the control module. This expression
also implies using the robot to create positions and motion.

Programming without being connected to the robot or the
control module.

Refers to the ABB Robotics concept of connecting a simulation
environment to a virtual controller. This enables not only
program creation, but also program testing and optimizing
offline.

A software that emulates a FlexController to allow the same
software (the RobotWare system) that is controlling the robots
to run on a PC. This gives the same behavior of the robots
offline as you get online.

Running multiple robot manipulators with the same control
module.

Used to define positions and orientations. When programming a
robot, you can take advantage of using different coordinate
systems to more easily position objects relative to each other.

A synonym for coordinate system.

If all your targets refer to workobjects, you only need to calibrate
the workobjects when deploying offline programs.

20
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1.1.5. Targets and paths

Overview
Targets (positions) and paths (sequences of move instructions to targets) are used when
programming robot motions in RobotStudio.
When you synchronize the RobotStudio station to the virtual controller, RAPID programs are
created from the paths.
Targets
A target is a coordinate that the robot shall reach. It contains the following information:
Information Description
Position The position of the target, defined in a workobject coordinate
system, see Coordinate systems on page 22.
Orientation The orientation of the target, relative to the orientation of the
workobject. When the robot reaches the target, it will align the
TCP’s orientation with the target’s orientation, see Coordinate
systems on page 22.
Configuration Configuration values that specify how the robot shall reach the
target. For more information, see Robot axis configurations on
page 24.
Targets are converted to instances of the data type robtarget when synchronized to the virtual
controller.
Paths

A sequence of move instructions, paths are used to make the robot move along a sequence of
targets.

Paths are converted to procedures when synchronized to the virtual controller.

Move instructions

A move instruction consists of:
» areference to a target
* motion data, such as motion type, speed and zone
» areference to a tooldata

« aworkobject reference

Action instructions

An action instruction is a RAPID string that can be used for setting and changing parameters.
Action instructions can be inserted before, after or between instruction targets in paths.
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1.1.6. Coordinate systems

Overview
This section gives a short introduction to coordinate systems that are often used for offline
programming. In RobotStudio, you can use all coordinate systems described below, as well
as user-defined coordinate systems, for relating objects and elements to each other.
Hierarchy

The coordinate systems relate to each other hierarchically, where the origin of each
coordinate system is defined as a position in one of its ancestries. Below are descriptions of
commonly used coordinate systems, starting at the top of the hierarchy.

World coordinate system
The world coordinate system represents the entire station or robot cell. This is the top of the
hierarchy to which all other coordinate systems are related.

Task frame coordinate system
The task frame coordinate system is useful to define within a station or robot cell, in particular
with multiple robots or mechanisms. One task frame can coordinate the placement of several
mechanisms, whereas several task frames are suitable when working with MultiMove
Independent.

Base coordinate system

Each robot in the station has a base coordinate system, which is always located at the base of
the robot.

Tool Center Point coordinate system
The tool center point coordinate system, also called TCP, is the center point of the tool.
Several different TCPs may be defined for one robot. All robots have one predefined TCP at
the robot’s tool mounting point, called tool0.

When a program runs, the robot moves the TCP to the programed position.

Continues on next page
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Continued

WorkObject coordinate system
The workobject normally represents the physical work piece. It is composed of two
coordinate systems: the User frame and the Object frame, where the latter is a child to the
former. When programming a robot, all targets (positions) are related to the object frame of
a workobject. If no other workobject is specified, the targets will be related to the default
Wobj0, which always coincides with the base frame of the robot.

Using workobjects provides the chance to easily adjust robot programs with an offset, if the
location of the work piece has been changed. Thus, workobjects can be used for calibrating
offline programs. If the placement of the fixture/work piece relative to the robot in the real
station does not completely match the placement in the offline station, you simply adjust the
position of the workobject.

Workobjects are also used for coordinated motions. If a workobject is attached to a
mechanical unit (and the system uses the option for coordinated motions), the robot will find
the targets in the workobject even when the mechanical unit moves the workobject.

In the picture below the grey coordinate system is the world coordinate system, and the black
ones are the object frame and the user frame of the workobject. Here the user frame is
positioned at the table/fixture and the object frame at the workpiece.

SO

xx0500001519

User Coordinate Systems
User Coordinate Systems (UCSs) are used for creating reference points of your choice. For
example, you can create UCSs at strategic points in the work piece to facilitate programming.

3HAC032104-001 Revision: D 23



1 Introduction

1.1.7. Robot axis configurations

1.1.7. Robot axis configurations

Axis configurations

Targets are defined and stored as coordinates in a WorkObject coordinate system. When the
controller calculates the position of the robot axes for reaching the target, it will often find
more than one possible solution to configuring the robot axes.

xx0500002365 A A A
To distinguish between the different configurations, all targets have a configuration value that

specifies the quadrant in which each axis shall be located.

Storing axis configurations in targets

For targets that are taught after jogging the robot to the position, the used configuration will
be stored in the target.

Targets created by specifying or calculating positions and orientations get a default
configuration value (0,0,0,0), which might not be valid for reaching the target.

Common problems related to robot axis configurations

Common solutions for configuration problems

It is most likely that targets created by other ways than jogging cannot be reached at their
default configuration.

Even if all targets in a path have validated configurations, you might encounter problems
when running the path if the robot cannot move from one configuration to the other. This is
likely to occur where an axis shifts greater than 90 degrees during linear movements.

Repositioned targets keep their configuration, but the configurations are no longer validated.
As a result, the problems described above might occur when moving targets.

To resolve the problems described above, you can assign a valid configuration to each target
and verify that the robot can move along each path. You can also turn configuration
monitoring off, which means that you ignore the stored configurations and let the robot find
working configurations at runtime. If this is not done the proper way, you might get
unexpected results.

In some cases there might not be any working configurations. Possible solutions might then
be to reposition the work piece, reorient targets (if acceptable for the process) or add an
external axis that either moves the work piece or the robot for increasing reachability.

© Copyright 2008-2010 ABB. All rights reserved.
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Continued

How configurations are denoted
The robot’s axis configurations are denoted by a series of four integers, specifying in which
quadrant of a full revolution significant axes are located. The quadrants are numbered from
zero for positive (counterclockwise) rotation and from -1 for negative (clockwise) rotation.

For a linear axis, the integer specifies the range (in meters) from the neutral position in which
the axis is located.

A configuration for a six-axis industrial robot (like IRB 140) may look like:

[0 -1 2 1]
The first integer (0) specifies the position of axis 1: somewhere in the first positive quadrant
(between 0 and 90 degrees rotation).
The second integer (-1) specifies the position of axis 4: somewhere in the first negative
quadrant (between 0 and -90 degrees rotation).
The third integer (2) specifies the position of axis 6: somewhere in the third positive quadrant
(between 180 and 270 degrees rotation).

The fourth integer (1) specifies the position of axis x, a virtual axis used for specifying the
wrist center in relation to other axes.

Configuration monitoring
When executing a robot program, you can choose whether to monitor configuration values.
If configuration monitoring is turned off, configuration values stored with the targets are
ignored, and the robot will use the configuration closest its current configuration for reaching
the target. If turned on, it will only use the specified configuration for reaching the targets.

Configuration monitoring can be turned off and on for joint and linear movements
independently and is controlled by the ConfJ and ConfL action instructions.

Turning configuration monitoring off
Running a program without configuration monitoring may result in different configurations
each time a cycle is executed: When the robot returns to the start position after completing a
cycle, it may choose a different configuration then the original.

For programs with linear move instructions this might cause a situation where the robot gets
closer and closer its joint limits and eventually will not be able to reach the target.

For programs with joint move instructions this might cause sweeping, unpredictable
movements.

Turning configuration monitoring on
Running a program with configuration monitoring forces the robot to use the configurations
stored with the targets. This results in predictable cycles and predictable motions. In some
situations, however, like when the robot moves to a target from an unknown position, using
configuration monitoring may limit the robot’s reachability.

When programming offline, you must assign a configuration to each target if the program
shall be executed with configuration monitoring.
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1.1.8. Libraries, geometries and CAD files

Overview

For programming or simulating in RobotStudio, you need models of your work pieces and
equipment. Models for some standard equipment are installed as libraries or geometries with
RobotStudio. If you have CAD models of your work pieces and custom equipment, these can
be imported as geometries to RobotStudio. If you do not have CAD models, you can create
them in RobotStudio.

Difference between geometries and libraries

The objects you import to a station can be either geometries or libraries.

Geometries are basically CAD files, which, when imported, are copied to the RobotStudio
station.

Libraries are objects that have been saved in RobotStudio as external files. When you import
a library, a link from the station to the library file is created. Accordingly, the station file does
not grow in the same way as when importing geometries. Furthermore, besides the
geometrical data, library files can contain RobotStudio-specific data. For example, if a tool is
saved as a library, the tool data is saved together with the CAD data.

How geometries are constructed

An imported geometry is displayed as one part in the Objects browser. From RobotStudio’s
Modeling tab, you can see the components of the geometry.

The top node of the geometry is called a Part. The part contains Bodies, which can be of the
types solid, surface or curve.

Solid bodies are 3D objects, made up of Faces. You recognize a true 3D solid by this one
body containing multiple faces.

Surface bodies are 2D objects of just one face. A part that contains several bodies with one
face each that together constitute a 3D object is created from 2D surfaces, and is therefore not
atrue 3D solid. If these parts are not created correctly, they might cause problems both in their
display and graphical programming. see Troubleshooting and optimizing geometries on page
78.

Curved bodies, represented by the body node alone in the Modeling browser, do not contain
any child nodes.

From the Modeling tab, you can edit the parts by adding, moving, rearranging or deleting
bodies. Thus, you can optimize existing parts by removing unnecessary bodies, as well as
create new parts by grouping bodies.

Importing and converting CAD files

For importing geometries from single CAD files, you use RobotStudio’s import function, see
Importing a station component on page 75.

If you need to convert CAD files to other formats or want to change the default settings for
the conversion before making the import, you can use the CAD converter installed with
RobotStudio before making the import, see Converting CAD formats on page 77.

Continues on next page
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Continued

Supported CAD formats

Some of the CAD formats require a separate license for being imported or converted by
RobotStudio. The table below shows the supported CAD formats and whether a license is

required:
Format

Acis, reads/writes
versions v6 to R20

Iges, reads to version
5.3, writes version 5.3

Step, reads versions
AP203 and AP214
(geometry only),
writes version AP 214

Vdafs, reads to 2.0,
writes 2.0

Catia V4, reads
versions 4.1.9 to
4.2.4

Catia V5, reads
versions R2 - R19

Pro/Engineer, reads
versions 16 to
Wildfire3

Inventor, reads
versions 6 to 2010

Vrml

Jupiter, up to 6.4
STL

PLY

3DStudio

File extensions
sat
igs, iges

stp, step, p21

vda, vdafs

model, exp

CATPart,
CATProduct

prt, asm

ipt

wrl, vrml,vrml1, vrmI2
jt

stl

ply

3ds

License require-
ment

No
Yes

Yes

Yes

Yes

Yes

Yes

Yes

No
No
No
No
No

Default target
formats

Iges, Step, Vdafs
Acis, Step, Vdafs

Acis, Step, Vdafs

Acis, lges, Step

Acis, lges, Step,
Vdafs

Acis, lges, Step,
Vdafs

Acis, lges, Step,
Vdafs

Acis, lges, Step,
Vdafs

RsGfx
RsGfx
RsGfx
RsGfx
RsGfx

You need licenses for both the source format and the target format when converting licensed

formats.

Continues on next page
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Mathematical versus graphical geometries

A geometry in a CAD file always has an underlying mathematical representation. Its
graphical representation, displayed in the graphics window, is generated from the
mathematical representation when the geometry is imported to RobotStudio, after which the
geometry is referred to as a part.

For this kind of geometry, you can set the detail level of the graphical representation, thus
reducing the file size and rendering time for large models and improving the visual display
for small models you might want to zoom in on. The detail level only affects the visual
display; paths and curves created from the model will be accurate both with coarse and fine
settings.

A part can also be imported from a file that simply defines its graphical representation; in this
case, there is no underlying mathematical representation. Some of the functions in
RobotStudio,such as snap mode and creation of curves from the geometry, will not work with
this kind of part.

To customize the detail level settings, see RobotStudio Options on page 182.
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1.1.9. VSTA as the IDE

Overview
RobotStudio uses Microsoft Visual Studio Tools for Applications (VSTA) as its Integrated
Development Environment (IDE), enabling advanced users to extend and customize its
functionality. You can, for example, write an add-in in C# or VB.Net to create a toolbar or
macro, debug code or inspect variable values during execution.

In addition, the Add-In browser acts as a single window for both VSTA add-ins and non-
VSTA, RobotStudio-specific add-ins known as PowerPacs.

For a procedure, see Visual Studio Tools for Applications on page 374.

Types of add-ins
The following add-ins may be available in the Add-In browser:

Object Description

PowerPac An add-in that accords with RobotStudio specifications, but is
not part of the VSTA system itself.

VSTA Station Add-In A VSTA add-in that has been attached to a station, and saved
to the station file.

VSTA User Add-In A VSTA add-in that has not been attached to a station and is

active only on the current user’'s computer.

Using the shortcut menus of the Add-In browser, PowerPacs may be loaded or autoloaded,
while VSTA add-ins may be added, loaded, unloaded, reloaded, autoloaded, edited, deleted,
or removed from the station.
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1.2. Installing and Licensing RobotStudio

Installing RobotStudio

NOTE! You should have administrator privileges on the PC before installing RobotStudio.
RobotStudio is categorized into the following two feature levels:

» Basic - Offers selected RobotStudio functionality to configure, program, and run a
virtual controller. It also includes online features for programming, configuring, and
monitoring a real controller connected over Ethernet.

e Premium - Offers full RobotStudio functionality for offline programming and
simulation of multiple robots. The Premium level includes the features of the Basic
level and requires activation.

In addition to the Premium functionality, there are add-ins like PowerPacs and options for
CAD converters available.

» PowerPacs provides enhanced features for selected applications.
» Options for CAD converters allows import of different CAD formats.
RobotStudio offers the following installation options:

« Minimal - Installs only the features required to program, configure, and monitor a real
controller connected over Ethernet. If installed with this option, only the Online tab is
available.

e Complete - Installs all the features required to run the complete RobotStudio. If
installed with this option, additional features of Basic and Premium functionality are
available.

e Custom - Installs user-customized features. This option allows excluding unwanted
robot libraries and CAD converters.

How to install RobotStudio on a PC

Action

1. Insert the robot software DVD in the PC.
e If a menu for the DVD is opened automatically, continue with step 5.
e If no menu for the DVD is opened, continue with step 2.

2. On the Start menu, click Run.

3. Inthe Open box, type the drive letter for your DVD drive followed by:

:\launch.exe

If your DVD drive has the letter D, then type: D: \ launch.exe

Click OK.

Select language for the DVD menu.

On the DVD menu, click Install.

On the installation menu, click RobotStudio. This opens the installation wizard, which
guides you through the rest of the software installation.

Sl [ IO

8. Select the options Minimal, Complete, or Custom and follow the instructions in the
installation wizard.

9. Now, install RobotWare.

On the installation menu, click RobotWare. This opens an installation wizard, which
guides you through the rest of the RobotWare installation.

Continues on next page
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Action

10. NOTE! Steps 10 and 11 are optional. Proceed with installing the Track mediapool.
On the Install products menu, click Additional Options. This opens a file browser that
displays the Track mediapool installation and other available options.

11. Double-click the TrackMotion folder and then the file setup.exe to start the installation
wizard and proceed.

12. After installing RobotStudio, proceed with activating RobotStudio.

NOTE! RobotStudio works with Premium functionality without activation during a 30
days trial period. Activation is not required for Minimal installation, or for Basic function-
ality of the Complete or Custom installation.

Activate RobotStudio

To continue using the product with all of its features, you must activate it. RobotStudio
Product Activation is based on Microsoft anti-piracy technology and designed to verify that
software products are legitimately licensed.

Activation works by verifying that the Activation Key is not in use on more personal
computers than are permitted by the software license.

How do | activate RobotStudio?

Trial period

When you start RobotStudio for the first time after installation, you are prompted to enter
your 25-digit Activation Key (XXXXX-XXXXX-XXXXX-XXXXX-XXXXX).

Before entering a valid Activation Key, you can run the software, in Premium functionality
mode, with all the features enabled, for a trial period of up to 30 days.

NOTE! Trial period starts immediately after installation.
After entering a valid Activation Key, you will see only the features you have purchased.
NOTE ! If installed during the trial period, you will lose the trial period.

Basic Functionality mode

After the trial period, the software reverts to Reduced Functionality mode unless you have
entered a valid Activation Key. In Basic functionality mode, RobotStudio allows only the use
of the Online and basic Virtual Controller features. No existing files or stations are harmed in
Reduced Functionality mode. After activating your software, you will have full functionality
for the features you have purchased.

NOTE!

Activation is not required for the Online features for programming, configuring, and
monitoring a real controller connected over Ethernet.

Continues on next page
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Activate automatically over the Internet or manually

The Activation Wizard gives you two choices on how to proceed.

Automatic activation by using the Internet (recommended)

Manual activation

Once you have selected the option | want to activate RobotStudio over the Internet, the
Activation Wizard automatically contacts the ABB licensing servers over your Internet
connection. If you are using a valid Activation Key that has not exceeded the number of
installations allowed, your product is activated immediately.

When you activate over the Internet, your activation request is sent to ABB. Your license will
then be automatically installed and your product ready for use. If you choose to activate over
the Internet but are not currently connected, the wizard alerts you that there is no connection.

If the computer does not have an Internet connection, you must create a license file by
selecting the option Create a license request file. Proceed through the wizard, enter your
Activation Key and save the License Request File to your computer. Use a removable
medium, such as a USB stick or floppy disk, to transfer the file to a computer with an Internet
connection. Open a web browser, go to http://www101.abb.com/manualactivation/and follow
the instructions. The result will be a License File that should be saved and transferred back to
the computer holding your product. Relaunch the Activation Wizard and select the option
Install a license file. Proceed through the wizard, selecting the License File when requested.
Upon completion, RobotStudio is activated and ready for use.

How do | activate later?

If you do not want to activate your copy of the software at installation, you can do so later.
The following steps will launch the Activation Wizard.

If you have a problem with your activation, contact your local ABB customer support
representative at the e-mail address or telephone number provided at www.abb.com/robaotics.

Action

1. Click the RobotStudio Button, and then click RobotStudio Options and select
Licensing.

2. Click Activation wizard to launch the activation wizard.

3. If the RobotStudio installation is activated, you will have valid licenses for the features
covered by your subscription.

Which RobotStudio version is installed?

The version number of RobotStudio is displayed on the start page that appears when
RobotStudio is started.

How can | tell if my RobotStudio installation is activated?

Action

1. Click the RobotStudio Button, and then click RobotStudio Options and select
Licensing.
2. Click View Installed License Keys to see the status of your current license.

3. If the RobotStudio installation is activated, you will have valid licenses for the features
covered by your subscription.
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1.3 The Graphical User Interface

1.3.1. The Graphical User Interface

Overview
This section provides an introduction to the diffrent parts of the Graphical User Interface.

1

2 3 1
5 3 L
§)| Him-ato =
B2 Home Madeling Simulation oOffline Orling Add-Ins

239 e - o =
@ P UL B M &G K
AEE Import Raobat Import  Frame | Workobjeck Tooldata Target | Empty  Pathfrom  MultiMove

Library = Library «~ | Swstem - | Geometry v - Path Curve
Biuild Station Path Prograrmming
Layout | Paths&Targets ¥ X 1@' Wiewl |
ﬁ' [Ungaved Station]”
,__j Station Elements
EJ IRB1600_Bkg_1.2m_26

en0900000215

Parts Description

1 Application menu Accessed from the RobotStudio button in the upper left
corner of the GUI. For more information, see The
Application Menu on page 175.

2 Home tab Contains the controls required for building stations, creating
systems, programming paths and placing items. For more
information, see The Home Tab on page 189.

3 Modeling tab Contains the controls for creating and grouping
components, creating bodies, measurements and CAD
operations. For more information, see The Modeling Tab on
page 233.

4 Simulation tab Contains the controls for setting up, configuring, controlling,
monitoring and recording simulations. For more informa-
tion, see The Simulation Tab on page 295.

5 Offline tab Contains the controls for synchronization, configuration and
tasks assigned to the Virtual Controller (VC). For more infor-
mation, see The Online and Offline Tabs on page 313.

6 Online tab Contains the controls for managing the real controller. For
more information, see The Online and Offline Tabs on page
313.

7 Add-Ins tab Contains the control for PowerPacs and the VSTA. For

more information, see The Add-Ins Tab on page 373.
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1.3.2. The Getting Started window

Overview
The Getting Started window contains the following tabs:
Tab Description
Recent Stations ©ffine Use this tab to open recent stations (which are previewed), a
new station or any saved station.
Recent Controllers ©""®  Use this tab to open a recent controller, connect to a controller
with one click or add a controller.
Information Use this tab to access help files, browse tutorials, connect to the
online community, manage your licenses or browse
RobotStudio news.
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1.3.3. The Layout browser

Overview

The layout browser is a hierarchical display of physical items, such as robots and tools.

Icons

Icon

R-

xx0500001364

T

xx0500001365

=

xx0500001366

=

xx0500001367

|7

xx0500001478

7

xx0500001368

¥

xx0500001369

o

xx0500001370

B

xx0500001371

Ty

xx0500001479

L

xx0500001372

Node
Robot

Tool

Link collection

Link

Frames

Component group

Part

Collision set

Objects group

Collision set
mechanisms

Frame

Description

The robot in the station. The red lock in the lower
right corner of the icon indicates that the object is
connected to a library.

A tool.

Contains all the links of the objects.

A physical object in a joint connection. Each link
is made up of one or several parts.

Contains all the frames for an object.

A grouping of parts or other assemblies, carrying
its own coordinate systems. Itis used to structure
a station.

A physical object in RobotStudio. Parts with
geometric information are made up of one or
more 2D or 3D entities. Parts without geometric
information (such as imported .jt files) are empty.

Contains all collision sets. Each collision set
includes two groups of objects.

Contains references to the objects that are
subject to collision detection.

The objects in the collision set.

The frames in the station.
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1.3.4. The Paths & Targets browser

Overview
The paths & targets browser is a hierarchical display of non-physical items.
Icons
Icon Node Description
Station Your station in RobotStudio.
o
xx0500001373
Virtual Controller The system for controlling the robots, just like a
u real IRC5 controller.
xx0500001374
Task Contains all logical elements in the station, such
:‘rﬁl as targets, paths, workobjects, tooldata and
instructions.
xx0500001375
Tooldata Collection Contains all tooldata.
xx0500001376
Tooldata A tooldata for a robot or a task.
xx0500001471
Workobjects & Targets Contains all workobjects and targets for the task
or robot.
xx0500001377
Jointtarget Collection A specified position of the robot axes.
ﬂ? and Jointtarget
xx0500001477
Workobject Collection The workobject collection node and the
? and Workobject workobjects it contains.
xx0500001378
Target A defined position and rotation for a robot. A
@ target equals a RobTarget in a RAPID program.
xx0500001379
Target without assigned A target for which no axis configuration has been
configuration assigned, for example, a repositioned target or a
@ new target created by means other than
Xx0500001849 teaching.
Target without found con-  An unreachable target, that is, for which no axis
E} figuration configuration has been found.
xx0500001850
Path Collection Contains all paths in the station.
xx0500001380
Continues on next page
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Icon

&

xx0500001381

7]

xx0500001474

xx0500001851

=

xx0500001475

Node
Path

Linear Move Instruction

Joint Move Instruction

Action Instruction

1.3.4. The Paths & Targets browser

Continued

Description

Contains the instructions for the robot
movements.

A linear TCP motion to a target. If the target has
no valid configuration assigned, the move
instruction gets the same warning symbols as the
target.

A joint motion to a target. If the target has no valid
configuration assigned, the move instruction gets
the same warning symbols as the target.

Defines an action for the robot to perform at a
specified location in a path.
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1.3.5. The Modeling browser

Overview
The modeling browser is a display of editable objects and their building blocks.
Icons
Icon Node Description
Part Geometric items corresponding to the objects in

7
xx0600002704

Body
-

xx0600002705

O

xx0600002706

Face

the Layout browser.

Geometric building blocks that comprise the
parts. 3D bodies contain several faces, 2D bodies
one face, and curves no faces.

The faces of the bodies.
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1.3.6. The Offline and Online browsers

Overview
The offline and online browsers is a hierarchical display of controller and configuration
elements.
Icons
Icon Node Description
Controllers Contains the controllers that are connected to the Robot

&

xx0300000026

i

xx0300000027

&

xx0400000677

&

xx0300000028

{0

xx0600003287

@

xx0300000029

E

xx0300000030

%

xx0300000037

=

xx0300000434

Connected Controller

Connecting Controller

Disconnected Controller

Denied login

Configuration

Topic

Event Log

I/O System

View.

Represents a controller with a working connection.

Represents a controller which is currently being connected.

Represents a controller that has lost its connection. It might
have been turned off or disconnected from the network.

Represent a controller that denies you access to login.
Possible reasons for denied access:

e The user lacks grant to login
e Too many clients connected to the controller

e The RobotWare version of the system running on the
controller is newer than the version of RobotStudio
Online

Contains the configuration topics.

Each parameter topic is represented by a node:
e Communication

e Controller

« /O

e Man-machine communication
e Motion

With the Event Log you can view and save controller events.

Represents the controller I/O system. The 1/O system
consists of I/O buses and units.

Continues on next page
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Continued

I/0 Bus An 1/O bus is a connector for one or several I/O units.

b 4

xx0300000433

I/O Unit An 1/O Unit is a board, panel or any other device with ports
through which the 1/O signals are sent.

¥

xx0300000432

RAPID Tasks Contains the active tasks (programs) of the controller.
xx0300000031
Task A task is a robot program, which executes alone or together
with other programs. A program is composed of a set of
%_1 modules.
xx0300000032
Modules A container for either program modules or system modules.
._J i ]
i
xx0300000431
Program Module A program module contains a set of data declarations and
routines for a specific task. Program modules contains data
E_-| specific for this program.
xx0300000430
System Module A system module contains a set of type definitions, data dec-
larations and routines. System modules contains data that
ﬁ applies to the robot system, regardless which program
s GETETRRAE modules that are loaded.
Encrypted Module A module that is locked for editing and viewing.
XX
Nostepin Module A module that cannot be entered during step-by-step
execution. That is all instructions in the module are treated
@ as one if the program is executed step-by-step.
XX
Procedure A routine that does not return any value. Procedures are
j used as subprograms.
xx0300000429
Function A routine that returns a value of a specific type.
Flr]
xx0300000034
Trap A routine that provides a means of responding to interrupts.
xx0300000036
Documents Folder Folder for links to documents and files.

~1

xx0300000039

Continues on next page
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Document Link

=

xx0300000038

1.3.6. The Offline and Online browsers

Continued

Link to a document. The icon for the document is the same
as the Window icon for the document type.
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1.3.7. The Output window

Overview

The output window displays information about events that occur in the station, such as when
simulations are started or stopped. This information is useful when troubleshooting stations.

Layout of the Output tab

The Output tab contains two columns: the first states the event, the second the time the
message was generated. Each row is a message.

Event types

The three event types indicate the severity of the event:

Event type

Information

Warning

Error

Description

An information message is a normal system event, for example,
starting and stopping programs, changing the operational
mode, and turning motors on and off.

Information messages never require an action from you. They
can be useful for tracking errors, collecting statistics or
monitoring user-triggered event routines.

A warning is an event of which you should be aware, but it is not
so severe that the process or RAPID program needs to be
stopped.

Warnings must occasionally be acknowledged. Warnings often
indicate underlying problems that at some point will need to be
resolved.

An error is an event that prevents the robot system from
proceeding. The running process or RAPID program cannot
continue and will be stopped.

An error must occasionally be acknowledged. Some errors
require some immediate action from you in order to be resolved.
Double-click an error to display a detailed information box.

Some of the events are active. These are linked to an action for resolving the problem that
generated the event. To activate the linked action, double-click the message.

Handling messages in the Output window

Goal

To filter messages...

To save a message to file...

To clear the Output
window...

Procedure

Right-click in the Output window and then click Show
messages. From the options All Errors, information,
Warningsand Warnings and Errors, select the type of
messages you want to display.

Select it, right-click and then click Save to file. Choose a name
and location in the dialog box. Multiple messages can be
selected by pressing SHIFT while clicking each.

Right-click in the Output window and then click Clear.

Continues on next page
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Continued

The Controller tab

The controller status window shows the operational status of the controllers in your robot

view.

1. The System Name column

This column shows the name of the system that is running on the controller.

2. The Controller Name column

This column shows the name of the controller.

3. The Controller State column

This column shows the state of the controller:

When the controller is
in state...
Initializing
Motors off

Motors on
Guard Stop

Emergency Stop

Waiting for motors on after
e-stop

System Failure

the robot is...

starting up. It will shift to state motors off when it has started.

in a standby state where there is no power to the robot's
motors. The state has to be shifted to motors on before the robot
can move.

ready to move, either by jogging or by running programs.

stopped because the safety runchain is opened. For instance, a
door to the robot's cell might be open.

stopped because emergency stop was activated.

ready to leave emergency stop state. The emergency stop is no
longer activated, but the state transition isn't yet confirmed.

in a system failure state. A warm start is required.

4. The Program Execution State column

This column shows if the robot is running any program or not:

When the controller is
in state...

Running
Ready

Stopped
Uninitialized

the robot...

is running a program.

has a program loaded and is ready to run it when a PP (starting
point in the program) has been set.

has a program loaded, with a PP, and is ready to run it.

has not initialized the program memory. This indicates an error
condition.

5. The Operating Mode column

This column shows the operating mode of the controller:

When the controller

o the robot is...

is in mode...

Initializing starting up. It will shift to the mode selected on the controllers
cabinet when it has started.

Auto ready to run programs in production.

In Auto mode it is possible to get remote Write access to the
controller, which is necessary for editing programs, configurations
and other things with RobotStudio Online.

Continues on next page
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Continued

When the controller .

o the robot is...

is in mode...

Manual only able to move if the enabling device on the FlexPendant is
activated. Furthermore, the robot can only moved with reduced
speed in manual mode.

In manual mode it is not possible to get remote Write access to
the controller, unless it is configured for this and the remote Write
access granted on the FlexPendant.

Manual full speed only able to move if the enabling device on the FlexPendant is
activated.

In manual mode it is not possible to get remote Write access to the
controller, unless it is configured for this and the remote Write
access granted on the FlexPendant.

Waiting for acknowledge about to enter Auto mode, but the mode transition has not yet been
acknowledged.

6. The Logged on as column
This column shows the user name the PC is logged on to the controller with.
7. The Access column
This column shows who has write access to the controller, or if it is available.
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1.3.8. The Operator Window

Overview
Operator Window is an alternative to the corresponding feature in the Virtual FlexPendant for
communicating with the user during RAPID program execution. It displays the same output
as displayed on the Virtual FlexPendant Operator Window.

When running in a Virtual Controller, the RAPID program communicates with the operator
via messages on the FlexPendant screen. The Operator Window integrates this functionality
and allows the user to run interactive RAPID programs without starting the Virtual
FlexPendant.

Enabling Operator Window
To enable an operator window:
1. On the Application menu, click RobotStudio Options.
2. On the Navigation pane to the left, select Robotics:Virtual Controller.
3. On the Virtual Controller page to the right, select Show virtual Operator Window
option.
4. Click Apply.

NOTE!

ﬂ When the Show virtual Operator Window feature is enabled, an Operator Window is
automatically created for each controller in the station. By default, the window is located in
the tab area below the graphics window.

RAPID Instructions
List of RAPID instructions supported by the Operator Window:

e TPErase

e TPReadFK

e TPReadNum

e  TPWrite

* UlAlphaEntry
e UlIMsgBox

¢ UINumEntry

NOTE! When these instructions are executed, the behavior is similar to that of Virtual
FlexPendant.

List of RAPID instructions not supported by the Operator Window:

e TPShow
e UlShow
e UINumTune
e UlListView

NOTE! When these instructions are executed, an error message is displayed in the Operator
Window prompting you to use the Virtual Flexpendant instead.

Continues on next page
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Continued

NOTE!
H You should not run both the Virtual Flexpendant and Operator Window simultaneously.
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1.3.9. The Document Manager window

Overview

The Document Manager window allows you to search and browse the RobotStudio
documents like libraries, geometry and so on in large numbers and from different locations.

Opening a Document Manager window

1. Onthe Home tab, click Import Library and select Documents from the dropdown
menu.

The Documents window appears.

Layout of the Document Manager window
The Documents window is a docked area that by default takes the right-hand corner. The
upper part of the window contains controls for searching and browsing the document
locations. The lower part consists of a list view that displays the documents and folders and
a status area.

Control Description

Search Allows to search for keywords or query. See Using the Search
mode on page 48.

Browse Displays a folder structure of the document locations. See Using
the Browse mode on page 50.

Location Allows to configure the document location. See Document
Locations window on page 52.

Continues on next page
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Continued

Using the Search mode
1.

Select Search and enter a query or syntax in the text box.
For more information about the available syntaxes, see Search syntax on page 48.

NOTE!

The dropdown list contains the search history of the previous ten queries between
sessions.

Click the Expand button to access additional controls.

This allows you to specify if the search should cover all the enabled locations or one
specific location.

Select Search in results check box to search for the resulting documents of the previous
search.

NOTE!

The search is performed automatically, after you stop typing in the text box or manually,
by clicking the glass icon. During the search, this icon is changed to a cross and clicking
this cancels the search operation.

Search syntax

The search field supports certain keywords and operators which allows you to specify an
advanced search query.

NOTE! Keywords are not localised.

The following table displays the keywords that specifies an advanced search query:

Keywords Description

filename matches the filename of the documents.

title matches the title field of the document metadata.
type matches the type field of the document metadata.

For library (.rslib) files, this is a user-defined string. For
example, Robot.

For other files, this is the Windows description of the file type.
For example, Text Document.

author matches the author field of the document metadata.
comments matches the comment field of the document metadata.
revision matches the revision field of the document metadata.
date matches the last time the file was modified.

For the colon operator, the match is done against a string repre-
sentation of the modified date.

For other operators, the search string should interpret as a date
according to .NET standards.

size matches the file size (in KB).

and, or, parentheses (), not used to group or invert queries.

Continues on next page
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Continued

The following table displays the operators that specifies an advanced search query

Operator Description

H NOTE!

Examples

matches if the field contains the search string.
matches if the field equals the search string.
matches if the field is smaller than the search string.

matches if the field is greater than the search string.

Quotation marks can be used to specify a string with whitespace. An empty string is

specified by "".
All search strings are case insensitive.

Text without a preceding keyword is matched against the filename and all metadata.
If queries are specified without a grouping keyword, "and" is implied.

Some metadata (title, author, comments and revision) is not available for all file types.

1400 - Matches documents with the string 1400 in the filename or any metadata.

not author:ABB - Matches documents where the author field does not contain the
string ABB.

size>1000 and date<1/2009 - Matches documents larger than 1000KB and modified
before 1/1/2009.

IRBP comments=""ABB Internal’* - Matches documents with the string IRBP in the
filename or any metadata, and where the comment field equals ABB Internal.

Continues on next page
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Using the Browse mode

1. Select Browse from the Document Manager window.
A folder structure of the document location is displayed.

NOTE!

The top level of the folder structure lists the configured locations. If a location is
unavailable (for example, an offline network path) it is marked as Unavailable and cannot
be opened. The text box displays the path of the current folder relative to the location root.

2. You can open a folder in either of the two ways:

» Double-click the document location.

* Right-click the document location and select Open from the context menu.
3. You can navigate through the folders in either of the two ways:

« Click the folder icon at the top-right corner.

« Select the parent folder from the dropdown list.
4. Click Refresh icon in the text box to manually refresh the contents of the folder.

NOTE!

The refresh operation can be time consuming, if a folder resides in a network location or
contains many documents. During this time, the refresh icon changes to a cross icon
allowing you to cancel the operation.

Results view

In the Browse mode, items are grouped into folders and documents. The resulting folders and
documents are displayed in a list view.

The search result appears in the status bar at the bottom, displaying the number of items
found, and progress made during the search. The Search results are grouped beneath headers
according to their location.

Each document is represented by an image, the document title or filename in black text, and
the metadata and file information in grey text. For library files, the image can be a screenshot
or other custom image. For other document types, the image is the icon associated with the
file type.

Continues on next page
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Continued

Using the Context menu
In the results view, right-click a document or folder. The following context menu items

appears:
Item Description
Open Opens the selected folder, library or geometry files, station files,
and document.

* For folders, browses into the selected folder.

e For library or geometry files, imports the file into the
station. (If no station is open ,a new empty station is first
created.)

» For station files, opens the station.

e For other documents, attempts to open the selected
document according to its file association. For example,
Microsoft Word starts when a .doc file is opened.

Open containing folder Opens the folder containing the document or the folder in the
Windows Explorer.
Properties Opens a dialog that displays complete metadata and file

information about the selected document.
NOTE! This is disabled for folders.

NOTE! Double-click an item to import the library and geometry files and open the other
documents.

In the results view, right-click an empty area. The following context menu appears that
controls how the documents are grouped and sorted:

Items Description

Group by: Controls how the documents are arranged in groups.
The following options are available:
e Location
* Folder
 Type
Sort by: Controls how the documents are sorted within the group.
The following options are available:
* Name
* Date
e Size
Ascending and Items are sorted in the ascending and descending order.
Descending

Using the drag and drop feature
You can import a library or a geometry file into the station by dragging it from the results view
into either the graphics window, or onto a object node in the Layout browser.

< When dragging into the Layout browser, the component will be placed as a child
object under the station, component group or smart component.

« When dragging into the graphics window, the component will be positioned at the
point on the station floor where you drop it. You can snap the point to the UCS grid by
enabling the Snap Grid or by holding down the ALT key while dragging.

Continues on next page
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Document Locations window
You can launch the Document Locations window in any one of the following ways:
1. Select Locations from the Documents window.

2. Click RobotStudio Button and then click RobotStudio Options, select
Files&Folders under General. Click Document Locations on the right side.

3. On the Home tab, click Import Library and select Locations from the dropdown
menu.

Layout of the Document Locations window
It consists of a menu bar and a list displaying the configured locations. The list displays
general information about the locations. The menu bar contains the following controls:

Controls Description

Locations The following options are available from the dropdown menu:

* Import : Opens a dialog box to import document
locations from an xml file. If a location with the same URL
already exists, you have the option to retain or delete the
existing location.

* Export : Opens a dialog box to export all the configured
locations to an xml file.

* Reset to Default : Loads the default locations (ABB
Library, User Library, and User Geometry).

Add Location Opens a dialog box to add a document location. By default,
there is one location type available.

For more information, see File System location on page 52.
Remove Deletes the selected location.

Edit Opens a dialog box to modify the selected location. For more
information, see File System location on page 52.

File System location
1. Click Add Locations and select File System from the dropdown menu. The File
System dialog box appears.

The File System dialog box contains the following controls:

Control Description
Location Name Specifies a name associated with the location.
Path Specifies the file system directory that corresponds to the root

folder of the location. This can be on a local or network disk.

Filter Specifies a filename filter to include only certain files when
searching and browsing. Multiple filters are separated by a
semicolon. If the filter is empty all files are included.

Cache files from network  Specifies that the library and geometry files from a network
location should be copied to a local directory and imported from
there, rather than directly from the network path.

This will ensure that a station containing such files can be
opened even if the network location is unavailable. This option
is only available for network locations.

Directory Specifies the directory where to store the local copies. This must
be on a local disk.

Continues on next page
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Control

Show as gallery

Style

Include when searching all
locations

1.3.9. The Document Manager window

Continued

Description
Specifies that the contents of the location should be displayed
as a gallery in the specified ribbon menu.

* Flat - Specifies that all documents are displayed in a
single gallery with subfolder names as headers.

* Recursive - Specifies that the documents are displayed
in submenus corresponding to the folder structure.

Specifies if the search should cover all the enabled locations.
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1.3.10. Using a mouse

Navigating the graphics window using the mouse
The table below shows how to navigate the graphics window using the mouse:

To

Select items

L
1

xx0500002417

Rotate the station

xx0500002424

Pan the station

xx0500002422

Zoom the station

xx0500002426

Zoom using window

xx0500002425

Use the keyboard /
mouse combination

»

xx0500002421
CTRL + SHIFT +

»

xx0500002421

C;O
—
Y
=

+

xx0500002421
CTRL +

a

xx0500002423

SHIFT +

a

xx0500002423

Select using window SHIFT +

xx0500002428

xx0500002421

Description

Just click the item to select. To select
multiple items, press CTRL key while
clicking new items.

Press CTRL + SHIFT + the left mouse
button while dragging the mouse to rotate
the station.

With a 3-button mouse you can use the
middle and right buttons, instead of the
keyboard combination.

Press CTRL + the left mouse button while
dragging the mouse to pan the station.

Press CTRL + the right mouse button while
dragging the mouse to the left to zoom out.
Dragging to the right zooms in.

With a 3-button mouse you can also use
the middle button, instead of the keyboard
combination.

Press SHIFT + the right mouse button
while dragging the mouse across the area
to zoom into.

Press SHIFT + the left mouse button while
dragging the mouse across the area to
select all items that match the current
selection level.
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1.3.11. Selecting an item

1.3.11. Selecting an item

Overview
Each item in a station can be moved to achieve the required layout, so you first have to
determine its selection level. The selection level makes it possible to select only specific types
of items, or specified parts of objects.

The selection levels are curve, surface, entity, part, mechanism, group, target/frame and path.
The target/frame and path selection can be combined with any of the other selection levels.

Objects may also be grouped together as component groups, see Component Group on page
234.

Selecting an item in the graphics window
To select items in the graphics window, follow these steps:

1. At the top of the graphics window, click the desired selection level icon.
2. Optionally, click the desired snap mode icon for the part of the item you wish to select.
3. In the graphics window, click the item. The selected item will be highlighted.

Multiple selection of items in the graphics window
To select multiple items in the graphics window, do the following:

1. Press the SHIFT key, and in the graphics window drag the mouse diagonally over the
objects to select.

Selecting an item in the browsers
To select items in a browser, do the following:

1. Click the item. The selected item will be highlighted in the browser.

Multiple selection of items in the browsers
To select multiple items in a browser, follow these steps:

1. Make sure that all the items to be selected are of the same type and located in the same
branch of the hierarchical structure; otherwise, the items will not be operable.

2. Do one of the following:

« To select adjacent items: In the browser, hold down the SHIFT key and click the first
and then the last item. The list of items will be highlighted.

» To select separate items: In the browser, hold down the CTRL key and click the items
you want to select. The items will be highlighted.
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1.3.12. Attaching and detaching objects

Overview
You can attach an object (child) to another object (parent). Attachments can be created on part
level and on mechanism level. When an object has been attached to a parent, moving the
parent also moves the child.

One of the most common attachments is to attach a tool to a robot. For procedures, see Attach
to on page 378 and Detach on page 385.
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1.3.13. Keyboard shortcuts

Keyboard shortcuts

The following table lists the keyboard shortcuts.:

Command

General

Activate menu bar

Open API Help

Open Help

Open Virtual FlexPendant
Switch between windows

General Commands
Add Controller System
Open Station

Take Screenshot
Teach Move Instruction
Teach Target

Toggle View Representation
General Editing

Copy

Cut

Paste

Redo

Refresh

Rename

Select All

Undo

Import Geometry
Import Library

New Station

Save Station

Program Editor Intellisense
Complete Word

Parameter Info

PickList

Program Editor Commands
Start Program Execution
Step In

Step Out

Step Over

Stop

Key Combination

F10

ALT + F1

F1

CTRL + F5
CTRL + TAB

F4
CTRL + O
CTRL+B

CTRL + SHIFT + R
CTRL +R

F7

CTRL+C
CTRL + X
CTRL +V
CTRL+Y
F5

F2

CTRL +A
CTRL +Z
CTRL+G
CTRL +J
CTRL+N
CTRL+S

CTRL + SPACEBAR
CTRL +1
CTRL + SHIFT + SPACEBAR

F8

F11

SHIFT + F11
F12

SHIFT + F8

Continues on next page
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Continued

Command

Toggle Breakpoint
Apply Changes
Print

Program Editor Hotkeys
Copy

Cut

Cut marked lines

Delete marked lines

Delete to beginning of word
Delete to end of word

Indent

Make the selected text lowercase
Make the selected text uppercase
Move to beginning of document
Move to beginning of line

Move to end of document
Move to end of line

Move to next word

Move to previous word

Move to visible bottom

Move to visible top

Open line above

Open line below

Outdent

Paste

Redo

Scroll down

Scroll up

Select block down

Select block left

Select block right

Select block to next word
Select block to previous word
Select block up

Select down

Select left

Select page down

Select page up

Select right

Select to beginning of document
Select to beginning of line
Select to end of document

Key Combination

F9
CTRL + SHIFT + S
CTRL +P

CTRL + Insert

SHIFT + Delete

CTRL + L

CTRL + SHIFT + L
CTRL + BACKSPACE
CTRL + Delete

Tab

CTRL +U

CTRL + SHIFT + U
CTRL + Home

Home

CTRL + End

End

CTRL + Right

CTRL + Left

CTRL + Page Down
CTRL + Page Up
CTRL + Enter

CTRL + SHIFT + Enter
SHIFT + TAB

SHIFT + Insert

CTRL + SHIFT + Z
CTRL + Down

CTRL + Up

ALT + SHIFT + Down
ALT + SHIFT + Left
ALT + SHIFT + Right
CTRL + ALT + SHIFT + Right
CTRL + ALT + SHIFT + Left
ALT + SHIFT + Up
SHIFT + Down

SHIFT + Left

SHIFT + Page Down
SHIFT + Page Up
SHIFT + Right

CTRL + SHIFT + Home
SHIFT + Home

CTRL + SHIFT + End

Continues on next page
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Command

Select to end of line
Select to next word

Select to previous word
Select to visible bottom

Select to visible top
Select up
Select word

Toggle overwrite mode

Transpose characters

Transpose lines

Transpose words

1.3.13. Keyboard shortcuts

Continued

Key Combination

SHIFT + End

CTRL + SHIFT + Right
CTRL + SHIFT + Left
CTRL + SHIFT + Page Down
CTRL + SHIFT + Page Up
SHIFT + Up

CTRL + SHIFT + W

Insert

CTRL+T

CTRL + ALT + SHIFT + T
CTRL + SHIFT + T

3HAC032104-001 Revision: D

59



1 Introduction

1.3.13. Keyboard shortcuts

60

3HAC032104-001 Revision: D

© Copyright 2008-2010 ABB. All rights reserved.



© Copyright 2008-2010 ABB. All rights reserved.

How |

2.1. Workflow for building a new station

2 How to build stations

2.1. Workflow for building a new station

Overview

This is an overview of how to build a station by including the equipment necessary to create
and simulate robot programs.

The first part of this overview describes the alternatives for creating a station with a system.
The second part describes importing or creating the objects to work with. The third part
describes the workflow for optimizing the station layout by finding the best placement of
robots and other equipment.

In most cases, following the workflows from start to finish is recommended, even if other
sequences are also possible.

Creating a station with a system
The table below shows the alternatives for creating a station with a system.
For procedures, see New Station on page 176.

Activity Description
Create a station with a This is the simplest way to create a new station containing a
template system robot and a link to a rudimentary system template.

Create a station with an ~ This creates a new station containing one or more robots in
existing system accordance with an existing, built system.

Create a station with no  An advanced user can build a station from scratch and then add
system a new or existing system to it.

Manually starting the VC

The table below shows the alternatives for manually starting with a system. Perform only
those steps applicable to your station.

Activity Description

Manually connecting a See Starting a VC on page 71.
library to the VC

Restarting the VC See Restarting a VC on page 73.

Continues on next page
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Continued

Importing station components

The table below shows the workflow for importing station components. Perform only those
steps applicable to your station.

For procedures, see Importing a station component on page 75.

Activity

Import a robot model
Import a tool

Import a positioner
Import a track

Import other equipment

Add work piece

Description

See Robot System on page 192.
See Import Library on page 191.
See ABB Library on page 190.

See Import Library on page 191.

If you have CAD models of the equipment, you can import them,
see Import Library on page 191. Otherwise, you can create
models in RobotStudio, see Mechanisms on page 82.

If you have CAD models of the work piece, you can import them,
see Workobject on page 199. Otherwise, you can create models
in RobotStudio, see Objects on page 80.

Placing objects and mechanisms
The table below shows the workflow for placing the objects in the station.

Activity

Place objects

Attach tools

Attach robots to tracks

Attach work pieces to
positioners

Test reachability

Description

If you are building a model of a real station, start by placing all
objects with known positions. For objects without known
positions, find a suitable placement, see Placing objects on
page 85 and Placing external axes on page 86.

Attach the tools to the robot, see Attach to on page 378.

If track external axes are used, attach the robots to the tracks,
see Attach to on page 378.

If positioner external axes are used, attach the work pieces to
the positioners, see Attach to on page 378.

Test if the robot can reach critical positions on the work piece. If
you are satisfied with how the robot reaches the positions, your
station is ready for programming. Otherwise, continue adjusting
the placement or trying other equipment as described below,
see Testing positions and motions on page 108.
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2.2 Setting up a conveyor tracking station with two robots working on the same

conveyor

2.2.1. Two robot systems sharing the same task frame position

Overview

This section describes what happens when both the robot systems share the same task frame
position. The baseframes of the mechanical units in both the robot systems have the same task
frame position.

Prerequisite

Two robot systems with conveyor tracking option (system 1 and system 2)

A conveyor mechanism saved as library

NOTE! See Create Conveyor mechanism on page 287 to create conveyor tracking systems.

Setting up the conveyor tracking station
1. Add the existing system (system 1) to the station. See Robot System on page 192.

NOTE! After starting the system, when asked to select the library, browse and select the
already saved conveyor mechanism library.

2. Modify the baseframe positions of conveyor and robot.

1.
2.

Move the mechanical unit (conveyor/robot) to its new location.

See Updating the baseframe position on page 370 to update the baseframe position of
the conveyor/robot.

3. Repeat steps 1 and 2to modify the baseframe position of the robot.

In the System Configuration window, click OK. When asked if you want to restart
the system, answer Yes. Close the System Configuration window.

3. Add the existing system (system 2) to the station. See Robot System on page 192.

NOTE! After starting the system, when asked to select the library, browse and select the
same library as the one selected for system 1 or any other library. Later, this conveyor
library will be removed from the station since system 2 shall use the same conveyor
library as system 1.

4. Refer both systems (system 1 and system 2) to the same conveyor library.

1.

In the Offline browser, click System Configuration to bring up a dialog box for
system 2.

Select the library node in the hierarchical tree.

Select the option Select from Station. Click Change. The Select Library dialog box
appears.

Select the same conveyor library as the one selected for system 1. Click OK.

Continues on next page
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Continued

NOTE! Now both systems (system 1 and system 2) use the same conveyor library and the
library previously referenced by system 2 is removed from the station.

. Modify the baseframe positions of robot (system 2).
1.
2.

Move the mechanical unit (robot) to its new location.

See Updating the baseframe position on page 370to update the baseframe position of
the robot.

Repeat steps 1 and 2 to modify the baseframe position of the robot.

In the System Configuration window, click OK. When asked if you want to restart
the system, answer Yes. Close the System Configuration window.
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2.2.2. Two robot systems having different task frame positions

Overview
This section describes what happens when two robot systems have different task frame
positions but uses the same sync switch. This means the Baseframes of the conveyor
mechanical units in both the robot systems have different values.

Prerequisites
Two robot systems with conveyor tracking option (system 1 and system 2)

NOTE! See Create Conveyor mechanism on page 287 to create conveyor tracking systems.

Setting up the conveyor tracking station
1. Add the existing system (system 1) to the station. See Robot System on page 192.

NOTE! After starting the system, when asked to select the library, browse and select the
already saved conveyor mechanism library.

2. Modify the baseframe positions of conveyor and robot.
1. Move the mechanical unit (conveyor/robot) to its new location.

2. See Updating the baseframe position on page 370 to update the baseframe position of
the conveyor/robot.

3. Repeat steps 1 and 2 to modify the baseframe position of the robot.

4. In the System Configuration window, click OK. When asked if you want to restart
the system, answer Yes. Close the System Configuration window.

3. Add the existing system (system 2) to the station. See Robot System on page 192.

NOTE! After starting the system, when asked to select the library, browse and select the
same library as the one selected for system 1 or any other library. Later, this conveyor
library will be removed from the station since system 2 shall use the same conveyor
library as system 1.

4. Update both systems (system 1 and system 2) to use the same conveyor library.

1. In the Offline browser, click System Configuration to bring up a dialog box for
system 2.

2. Select the library node in the hierarchical tree.

3. Select the option Select from Station. Click Change. The Select Library dialog box
appears.

4. Select the same conveyor library as the one selected for system 1. Click OK.

NOTE! Now both systems (system 1 and system 2) use the same conveyor library and the
library previously referenced by system 2 is removed from the station.

5. Modify the task frame position of the conveyor mechanism. See Set Task Frames on page
369.

NOTE! Before modifying the task frame, make a note of the current conveyor position in
world coordinates. After modifying the task frame, move the conveyor back to the
position it was before modifying the task frame.

Continues on next page
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Continued

6. Modify the baseframe positions of robot (system 2).

Repeat step 2 to modify the baseframe position of the robot (system 2)

1.
2.

Move the mechanical unit (robot) to its new location.

See Updating the baseframe position on page 370 to update the baseframe position of
the robot.

3. Repeat steps 1 and 2 to modify the baseframe position of the robot.

In the System Configuration window, click OK. When asked if you want to restart
the system, answer Yes. Close the System Configuration window.

7. Modify the baseframe position of the conveyor (system 2).

1.

In the Offline browser, click System Configuration to bring up a dialog box for
system 2.

Select the conveyor in the hierarchical tree. The BaseFrame property list for the
conveyor is now displayed.

Select the option Use Current Station Values to update the baseframe value of the
robot in the controller.

Deselect the option Check BaseFrame on Startup.

5. In the System Configuration window, click OK. When asked if you want to restart

the system, answer Yes.

NOTE! By deselecting the option Check BaseFrame on Startup, RobotStudio will not
compare the BaseFrame values in the station and the controller every time the controller
is started. This avoids repositioning the conveyor library.

NOTE! If the two robot systems use the same part on the conveyor, the relation between
the part and the two conveyor workobjects should be the same.
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2.3. Creating a system with external axes automatically

Automatically create a system with external axes

1.

Import the desired robots, positioners, and track libraries into the RobotStudio station. See
Import Library on page 191.

NOTE! If a robot and track are selected, attach the robot to the track. See Attach to on
page 378.

NOTE!

Robot system supports the following tracks with lengths 1.7 m to 19.7 m in a separate task
or same robot task. Depending on the manipulator type, the system allows one to three
tracks per task. However with IRBTx004, only one track of this type can be used per
system.

« IRBT4003

« IRBT4004

+ IRBT6003

« IRBT6004

* IRBT7003

* IRBT7004

e RTT_Bobin

e RTT_Marathon
» Paint Rail

Create a robot system from layout. See Robot System on page 192.

NOTE!

To create a robot system with IRBT4004, IRBT6004, or IRBT7004, the TrackMotion
mediapool must be installed. For more information, see Installing and Licensing
RobotStudio on page 30.

Continues on next page
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Continued

Supported external axes configuration
The following table shows a combination of different external axes configurations:

Positioner type
Combination
A B C D K L 2xL

One IRB (Positioner in Y Y Y Y Y Y Y Y
same task)

One IRB (Positioner in Y Y Y Y Y Y Y Y
separate task)

Two IRB (Positioner in Y Y Y Y Y Y N Y
separate task)

One IRB on Track Motion Y N N N YX Y Y N
(Positioner in same task)

One IRB on Track Motion Y N N N YX Y Y N
(Positioner in separate task)

Two IRB on Track Motion Y N N N YX Y N N

(Positioner in separate task)

e Y - Combination is supported
e N - Combination is not supported

e YX - Combination is supported and manual mapping of mechanical units and joints
required

NOTE!

H Creating a system from layout only supports tracks of type RTT and IRBTx003 in
combination with positioners. i.e. IRBTx004 is not supported in combination with the
positioners.

Manual mapping of mechanical units and joints
If the system contains more than one mechanical unit, the number of tasks and base frame
positions of the mechanism should be verified in the System Configuration.

1. In the Offline browser, click System Configuration to bring up a dialog box.
2. Select the robot from the node in the hierarchical tree.
The property page of this node contains controls for mapping and setting axes and joints.
3. Click Change to open a dialog box.
4. Manually map the mechanical unit and mechanism joints. Click Apply.

5. Modify the baseframe positions of the mechanical unit. See Updating the baseframe
position on page 370.
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2.4 Manually setting up a system with track motion

2.4.1. Setting up a system with track motion of type RTT or IRBTx003 manually

Manually set up a system with track motion of type RTT or IRBTx003
Use this procedure to manually set up a system with track motion type RTT Bobin, RTT
Marathon or IRBT4003, IRBT6003, or IRBT7003.

1. Build and start a new system. See Building a new system on page 148.

Action Description
1  Select the desired robot variant In the New Controller System wizard of the
(IRB6600). System Builder, naviagte to Modify Options

page and scroll down to Drive Module 1 > Drive
module application group and expand ABB
Standard manipulator option and select
Manipulator type (IRB6600).

2  Select the Additional axes In the New Controller System wizard of the
configuration. System Builder, naviagte to Modify Options
page of the System Builder, scroll down to Drive
Module 1> Additional axes configuration group
and expand the Add axes IRB/drive module
6600 option and select the 770-4 Drive W in pos
Y2 option.

NOTE! The option 770-4 Drive W in pos Y2, the
Drive module, and the Position varies depending
on the Additional axes configuration selected.
Make sure to select at least one drive in any
position.

3  Click Finish. Close the Modify Options page.

2. Add the system to the station. See Adding a system on page 72

3. Addthe corresponding track configuration file of the desired robot variant (IRB 6600) and
the desired track model to the station. See Adding the track to the system on page 75.

NOTE! In the Select Library group, select either the existing track or import a different
track.

NOTE! The system may fail unless the correct additional axes configuration is selected.
4. Specify whether the baseframe is moved by another mechanism.

1. In the Offline browser, click System Configuration to bring up a dialog box.

2. Select ROB_1 node from the hierarchical tree.

3. Select the option Track from the BaseFrame moved by list.

4

. Click OK. When asked if you want to restart the system, answer Yes. Close the
System Configuration window.
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2.4.2. Setting up a system with track motion of type IRBTx004 manually

Overview

For configuration of tracks of type IRBT4004, IRBT6004, or IRBT7004, the TrackMotion
mediapool must be installed. For more information, see Installing and Licensing RobotStudio
on page 30.

Manually set up a system with track motion of type IRBTx004

4

5

Action

Add additional options for
IRBTx004.

Select the desired robot variant
(IRB6600).

Select Additional axes configura-
tion.

Select the desired track motion
(IRBT 6004).

Click Finish.

1. Build and start a new system. See Building a new system on page 148.

Description

See Adding additional options on page 149.

NOTE! Browse and select the key file (.kxt)
located in the mediapool Track 5.XX.YYYY where
5.XX indicates the latest RobotWare version being
used.

On the Modify Options page of the System
Builder, scroll down to Drive Module 1 > Drive
module application group and expand ABB
Standard manipulator option and select
Manipulator type (IRB6600).

On the Modify Options page of the System
Builder, scroll down to Drive Module 1>
Additional axes configuratin group and expand
the Add axes IRB/drive module 6600 option and
select the 770-4 Drive W in pos Y2 option.
NOTE! The option 770-4 Drive W in pos Y2, the
Drive module, and the Position varies
depending on the Additional axes configuration
selected. Make sure to select at least one drive in
any position.

On the Modify Options page of the System
Builder, scroll down to the TRACK and expand
the Drive module for Track motion group. Select
Drive Module 1 >Track Motion type > IRBT
6004 > Irb Orientation on Track > Standard
carriage In Line > Select Track Motion Length
>1.7m (or any other variant).

Close the Modify Options page.

2. Add the system to the station. See Adding a system on page 72.
3. Add the desired track model to the station. See Adding the track to the system on page 75.
NOTE!

In the Select Library group, click Other to import a different track motion library.

System Configuration window.

2. Click OK. When asked if you want to restart the system, answer Yes. Close the
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2.5.1. Starting a VC

Overview

RobotStudio uses virtual controllers for running the robots. Virtual controllers can run both
systems for real robots and specific virtual systems for testing and evaluation purposes. A
virtual controller uses the same software as the controller to execute the RAPID program, to
calculate robot motions and to handle 1/0O signals.

When starting a virtual controller, point out which system to run on it. Since the system
contains information about the robots to use and important data such as robot programs and
configurations, it is important to select the right system for the station.

Starting a VC

The table below describes the different ways a virtual controller may start:

Startup

Automatic, when creating a
station

Automatic, when adding a
system to an existing
station

Manually, when connecting
to an imported library

Description

In most cases, a VC is automatically started when you create a
new station. Library files for the robots used by the system are
then imported to the station.

If your station uses several systems or if you started with an
empty station, you can add systems to an open station. Library
files for the robots used by the the systems are then imported to
the station.

If you have manually imported a robot library you want to use
with a system, instead of importing a new library at startup, you
can connect this library to a controller.

If you have manually imported a robot library you want to use
with a system, instead of importing a new library at startup, you
can connect this library to a controller.

A library may only be connected to a single-robot system and
may not be already connected to another VC.

Continues on next page

3HAC032104-001 Revision: D

71



2 How to build stations

2.5.1. Starting a VC

Continued

Adding a system

To start a system in a new virtual controller and automatically import the robots used by the

system, follow these steps:

1. « If you have the Select system dialog box open, continue with the next step.

« Ifyou do not have the Select system dialog box open, go to the Controller menu and

click Add System.

2. Depending on whether the system to start on the virtual controller is ready or not, do one

of the following:
Activity
Create and start a copy of an existing

system

This is recommended when you plan to add
station-specific configurations or programs.

Start an existing system as is

This is useful when you already have created
a specific system for the station.

It is also useful if you do not plan to create
station-specific configurations or programs
and want a quick start.

Modify and start an existing system

This is the way to add or change options in
the systems, for example, adding or replacing
robots and external axes.

Build and start a new system

This option is used for building and starting a
completely new system, either from
RobotWare keys or from virtual keys.

Description

From the Select system pool list, select the
folder on your PC that contains the system to
use. Select the system to copy from the
Systems Found list and click Copy. In the
Copy System dialog box, enter a name for
the system and click OK.

From the Select system pool list, select the
folder on your PC that contains the system to
use.

From the Select system pool list, select the
folder on your PC that contains the system to
modify. Select the system to modify from the
Systems Found list and click Modify. This
starts the System Builder from which you
make the modifications. For detailed informa-
tion, see Modifying a system on page 152.

Click Create to start the System Builder
from which you build the new system. For
detailed information about creating the
system, see Building a new system on page
148.

3. From the Systems Found list, select the system to use and click Start.
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2.5.2. Restarting a VC

Overview

This section describes when and how to restart a VC in RobotStudio. See also Restart on page
330.

Prerequisites

The following are the prerequisites for restarting a controller:
* You must have Write access to the controller you are restarting.

« For the advanced restart methods X-start and C-start, you must have access to the
controller's FlexPendant.

When to restart a virtual controller

Warm restart

Cold restart

Advanced restarts

Some operations require a restart of the controller to take effect. When working in
RobotStudio, you will be notified when a restart is necessary.

Typically, you need to make an ordinary warm restart of a virtual controller when:

« you have changed the baseframe of any of the robots belonging to that virtual
controller.

» you have changed the robot's configuration, either with the Configuration Editor or by
loading new configuration files.

» you have added new options or hardware to the system.

« A system failure has occurred.

A cold restart is useful for restoring the system running on a virtual controller to the state it
was created in. The cold restart deletes all RAPID programs, data and custom configurations
that have been added to the system.

In addition to warm and cold restarts, several advanced restarts are available. See Advanced
restart options on page 74.

Continues on next page
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Advanced restart options
The controller can be restarted with the following advanced restart options:

Option
|-Start

P-Start

X-Start

C-Start

B-Start

Description

Restarts the controller with the current system and the default
settings.

This method discards the changes made to the robot's configu-
ration. It reverts the current system to the state it had when it
was installed on the controller (an empty system).

Restart the controller with the current system and reinstall
RAPID.

This method deletes all RAPID program modules. It can be
useful if the system has changed in such a way that the
programs no longer are valid, for instance if system parameters
used by the program are changed.

Saves the current system and starts the boot application.

This method saves the current system, with the current settings,
and starts the boot application from which you can choose a
new system to start with. You can also configure the controller's
network settings from the boot application.

Deletes current system and starts the boot application.

This method deletes the current system and starts the boot
application from which you can choose a new system to start
with. You can also configure the controller's network settings
from the boot application.

Restarts the controller with the current system and the last
known good settings.This method restores changes made to
the robot's configuration to a previously good state.
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2.6 Station components

2.6.1. Importing a station component

Importing arobot model

This is how to import a robot model without a controller to your station.

A robot which is not connected to a controller cannot be programed. To import a robot
connected to a virtual controller, configure a system for the robot and start it in a virtual
controller, see Building a new system on page 148 and Starting a VC on page 71, respectively.

To import a robot model, in the Home tab, click Robot System and then select a robot model
from the gallery.

Importing a tool

Atool is a special object, for example, an arc weld gun or a gripper, that operates on the work
piece. For achieving correct motions in robot programs, the parameters of the tool have to be
specified in the tool data. The most essential part of the tool data is the TCP, which is the
position of the tool center point relative to the wrist of the robot (which is the same as the
default tool, tool0).

When imported, the tool will not be related to the robot. So in order for the tool to move with
the robot, you must attach it to the robot.

To import a tool, in the Home tab, click Tool and then select a tool from the gallery.

Importing a positioner

To import a tool, in the Home tab, click Positioner and then select a positioner from the
gallery.

Adding the track to the system

To select the model of the external axis to use, follow these steps:
NOTE!

This procedure is not applicable for a robot system with track motions IRBT4004, IRBT6004,
or IRBT7004. They are configured by the TrackMotion mediapool and not by adding
separate configuration files. For information on installation instructions, see Installing and
Licensing RobotStudio on page 30.

1. Start the system in a virtual controller, either in a new empty station or in an existing
station, see Robot System on page 192.

In the Layout browser, select the system to add the track to.
3. On the Offline tab, click System Configuration.

Continues on next page
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4. Click Add to add parameters for the track to the system. Browse to the parameter file
(.cfg) for the track to add and click Open.

If you have a specific parameter file for you track, use that one. Otherwise, parameter files
for some standard tracks are delivered with the RobotStudio installation. These can be
found in the folder ABB Library/ Tracks in RobotStudio’s installation folder. The ABB
Library folder can also be opened from the Quick access pane at the left of the Open
dialog box used for adding parameter files.

The file name of each parameter file tells which tracks it supports. The first part tells the
length of the track and the second the number of tasks.

For example, the file TRACK _1_7.cfg supports all tracks with the length 1.7 meters in
systems with one single task. For Multimove systems or other systems with several tasks,
use the configuration file with the matching number of tasks.

For example, if the track length is 19.9 m and the robot attached to the track is connected
to task 4 of the MultiMove system, then select TRACK 19 9 Task4.cfg file.

5. In the System Configuration window, click OK. When asked if you want to restart the
system, answer Yes.

6. During the restart a list of all tracks compatible with the configuration file is displayed.
Select the one to use and click OK.

After the restart the track appears in the station. Continue with attaching the robot to the
track.

Importing a library, geometry or piece of equipment

A library component is a RobotStudio object that has been saved separately. Normally,
components in a library are locked for editing.

A geometry is CAD data which you can import to use in RobotStudio. For a list of importable
CAD formats, see Libraries, geometries and CAD files on page 26.

To import a library, geometry or piece of equipment, see Import Library on page 191.
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2.6.2. Converting CAD formats

Overview

A CAD converter is installed together with RobotStudio by default. In most cases you do not
have to convert CAD files before importing them to RobotStudio, but the CAD converter
might be useful for converting several files at once, or for converting with custom settings.

Prerequisites

Most of the file formats require separate licenses, see Libraries, geometries and CAD files on
page 26 for more information.

Starting the CAD converter

Click Start menu, point to Programs, ABB Industrial IT, Robotics IT and click CAD
Converter.

Converting CAD files

To convert CAD files, follow these steps:

1.

Click Add files and select the files to convert. Optionally, click Add files, again to add
more files from another location.

Each file is now added to a row in the grid.

Optionally, change the suggested file name or target format by clicking that column for
the file to change.

In the Target directory box, specify the folder in which to save the new files.

Optionally, click Settings and change the settings for the conversion. For details about the
conversion settings, see Conversion settings on page 77.

Click Convert Files.

Conversion settings

The table below describes the settings for the conversion:

Setting Description

Acis save file format Select which version of ACIS to save to when using ACIS as
target format.

Enable Healing Controls whether the conversion engine attempts to heal
geometric entities. Only supported for specified formats.

Translate hidden/no- Controls whether the hidden entities are translated or

show entities discarded. Only supported for specified formats.

VRML/STL Scale factors VRML and STL are often created in units that RobotStudio does

not expect; they thus need to be resized.

Delete all generated log Makes the CAD converter delete log files when exiting.
files on exit
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2.6.3. Troubleshooting and optimizing geometries

Overview

The characteristics of the geometries and CAD models in the station may have great effect on
your work in RobotStudio, both in aspects of making the objects easier to program as well as

enhancing simulation performance.

Below are some guidelines for troubleshooting geometries.

Trouble

The pointer snaps to the
wrong parts of the objects
when selecting in the
graphics window

The graphics window
redraws or updates slowly

Information

This problem might be caused by wrong snap mode settings,
imprecise selecting, hidden or lack of geometrical information.
To resolve these problems, do the following:

Check the selection level and snap mode settings. For
more information, see Selecting an item on page 55.

When making the selection, zoom and rotate the object
so that you are sure to click inside the object.

Check if the object has hidden details that might affect
the snapping. Remove details that are not necessary for
your programming or simulation. For more information,
see Modifying a part on page 81.

Some file formats only contain a graphical representa-
tion and no geometrical data. Import the geometry from
a file format that also contains geometrical data. For
more information, see Libraries, geometries and CAD
files on page 26.

This might be due to the performance of your computer not
being high enough for the size of the geometry files in your

station.
To reduce the size of the geometry files, do any of the following:

Use a lower detall level for rendering the geometry. For
more information, see Graphic Appearance on page
387.

Blends, chamfers and holes can be automatically
simplified by using the Defeature function. This can
greatly reduce graphic complexity, speed up simulations
and reduce memory usage.

Check if the object has unnecessary details. Remove
details that are not necessary for your programming or
simulation. For more information, see Modifying a part
on page 81.

Continues on next page
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Continued

Information

If parts of the geometry are not visible from some views, a
probable cause is that the object is made up of 2D surfaces and
the option Backface culling is on.

Backface culling means that the faces of the object are only
visible from the front, and if the object (or any of its faces) is
oriented differently, they will not be visible.

To correct the problem, do one of the following:

Switch to modeling mode and invert the direction of the
face that is not displayed correctly. This not only corrects
the display, it also decreases the chance of faulty orien-
tations during graphical programming. For more informa-
tion, see Invert on page 390 or To invert the direction of
all faces of a part on page 79.

Turn backface culling off for the specific object. This
makes the object display correctly, but does not affect
the direction of the face, which might cause problems if
the face will be used for graphical programming. For
more information, see To deactivate backface culling for
a single object on page 79.

Turn backface culling off for all objects in the station. This
makes the objects display correctly, but does not affect
the direction of the face, which might cause problems if
the face will be used for graphical programming. It also
decreases the performance of the graphic handling. For
more information, see To change the generic setting for
backface culling on page 79.

To invert the direction of all faces of a part

To invert the direction of all faces of a part, follow these steps:

1. Select the part on which faces you want to invert the directions.

2. On the Modify menu, click Graphic Appearance.

3. On the Rendering tab, click Flip normals and then click OK.

To deactivate backface culling for a single object
To change the backface culling setting for a single object, follow these steps:

1. Select the part for which you want to change the backface culling setting.

2. On the Modify menu, click Graphic Appearance.

3. On the Rendering tab, clear the Backface culling check box and then click OK. The
faces of the object will now be displayed even if the generic setting for backface culling

is on.

To change the generic setting for backface culling

The generic setting for backface culling affects all new objects and existing objects that do
not have backface culling specifically deactivated.

1. On the Application menu, click RobotStudio Options.

2. On the Navigation pane to the left, select Graphics: Performance.

3. On the Performance page, select or clear the Cull back-facing triangles check box and

then click OK.
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2.7 Modeling

2.7.1. Objects

Overview

This section describes how to create or modify geometrical objects.

Creating a frame

A frame is a generic coordinate system that you can use as reference when positioning
objects. Generic frames can also be converted to special kinds of coordinate systesm, like
workobjects or tool center points.

For procedures, see Frame on page 196 and Frame from Three Points on page 197.

Creating a solid

With the create solids commands you can create and build models of objects you do not have
CAD files or libraries for. With the create solids commands you create primitve solid bodies;
these can later be combined to more complex bodies.

For procedures, see Solid on page 268.

Creating a surface

For procedures, see Surface on page 272.

Creating a curve

When creating paths with targets based on the object geometries, curves are the geometrical
objects that RobotStudio uses. For example, if you want the robot to run along the edge of an
object, you can first create a curve along the border and then generate a complete path along
that curve, instead of manually finding and creating the necessary targets.

If the CAD model/geometry of the work piece does not already contain curves, you can create
the curves i RobotStudio.

For procedures, see Curve on page 274.

Modifying a curve

When creating paths with targets based on the objects geometries, curves are the geometrical
objects that RobotStudio uses. By optimizing the curves before starting programming, you
reduce the touch-up of the generated paths.

For procedures, see Modify Curve on page 399.

Creating a border

For procedures, see Border on page 279.

Creating a line from normal

A line can be created as a new part and body perpendicular to a surface.
For a procedure, see Line from Normal on page 285.

Continues on next page
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Extruding a surface or curve
Curves and surfaces and curves can also be extruded to 3D objects, which may then be
converted to solids. You can extrude along either a vector or a curve.

For procedures, see Extrude Surface or Curve on page 284.

Modifying a part
When you import a geometry or create an object, it will be one part. A part can, however,
contain several bodies. In RobotStudio’s modeling mode you can modify the parts by adding,
moving and deleting the bodies.
To modify a part, follow this step:

1. Inthe Modeling browser, expand the node for the part to modify. Then modify the part
by doing any of the following:

To Do this

Delete a body Select the body and press the DEL key.

Move a body from one part Drag the body or use the Copy and Paste commands on the
to another Edit menu.

Move one body relative to  Select the body and then move it using any of the ordinary
the others commands for moving objects, see Placing objects on page 85.

Modifying a library component
As external files, libraries are merely linked from a station. Therefore, to modify an imported
library component, the link must first be broken and later reestablished. For procedures, see
The Library Group on page 393.
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2.7.2. Mechanisms

Workflow
This information topic describes how to create a new mechanism, that is, a graphical
representation of a robot, tool, external axis or device. The various parts of a mechanism
move along or around axes.
Creating a mechanism is dependent upon skillful construction of the main nodes of the tree
structure. Four of these—Ilinks, joints, frames/tools and calibration—are initially marked red.
As each node is configured with enough subnodes to make it valid, the marking turns to
green. As soon as all nodes have become valid, the mechanism will be considered compilable
and can be created. For additional validity criteria, see the table below.
Node Validity critera
Links e |t contains more than one subnode.
e The BaseLink is set.
e All'link parts are still in the station.
Joints « Atleast one joint must be active and valid.
Frame/tool Data » At least one frame/tool data exists.
* For a device, no frames are needed.
Calibration « For a robot, exactly one calibration is required.
* For an external axis, one calibration is required for each
joint.
» For atool or device, calibrations are accepted, but not
required.
Dependencies * None.
The modify mode of the Mechanism Modeler has two purposes: to enable modification of an
editable mechanism in its tree structure, and to complete the modeling of a new or modified
mechanism.
It is recommended to configure each main node in the tree structure from the top down.
Depending on its current status, right-click or double-click a node or subnode to add, edit or
remove it.
For procedures, see Create Mechanism on page 287.
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2.7.3. Tools and tooldata

Overview

To simulate the robot tool, you need tooldata for the tool. If you import a predefined tool or
if you create a tool using the Create Tool Wizard, the tooldata is automatically created;
otherwise, you have to create the tooldata yourself.

The tooldata simplifies the programming work with respect to the different tools that may
come in use. Defining separate sets of tooldata for different tools makes it possible to run the
same robot program with different tools: only the new tooldata has to be defined. The tooldata
contains the information required for moving and simulating the tool.

Two methods for manipulating tooldata in RobotStudio are as follows:

« Create or modify tooldata, see Tooldata on page 200 and Modify Tooldata on page
407, respectively. This will create all data necessary for programming, but there will
be no visual tool during the simulation.

» Create tooldata for an existing geometry, Create Tool on page 293.

Creating and setting

up a stationary tool
This information topic describes how to create a stationary tool. For information about
creating a robot hold tool, see Create Tool on page 293.

Using a stationary tool, the robot holds and moves the work piece in relation to the tool. Thus,
both the tooldata and the workobject must be set up correctly.

To create the tooldata for a stationary tool, follow these steps:
1. Import the geometry or library that represents the tool, see Import Geometry on page 195.

If you do not have the geometry or library at hand but know the position, you can skip this
step. The tool will be programable, but not visible in the station.

2. Create the tooldata for the tool, see Tooldata on page 200.
Make sure to set the Robot holds tool option to false.

3. Create a workobject that is moved by the robot. see Workobject on page 199.
Make sure to set the Robot holds workobject option to true.

4. If you have a geometry or library component for the work piece, attach it to the robot, see
Attach to on page 378.
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2.7.4. Setting the local origin of an object

Overview
Each object has a coordinate system of its own called local coordinate system in which the
object dimensions are defined. When the object’s position is referred from other coordinate
system, it is the origin of this coordinate system that is used.
With the Set Local Origin command you reposition the object’s local coordinate system, not
the object itself.

For a procedure, see Set Local Origin on page 419.
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2.8.1. Placing objects

Overview

To achieve the required layout of your station, you need to import or create objects, place
them accordingly and, if applicable, attach them to other objects.

Placing objects means setting their position and rotation. If the objects are to be attached to
robots or other mechanisms, they will be placed at their attachment point automatically.

The following table describes the actions relating to placement:

Actions

Placing an object

Rotating an object

Measuring distance or
amgles

Creating a component
group
Attaching or detaching

an object

Jogging a robot

Modifying the task frame

Modifying the baseframe
position

Description

To place an object is to put the object in the required position in
the station, see Place on page 411 and Set Position on page
421.

The objects in the station can be rotated to achieve the required
layout, see Rotate on page 417.

The measurement functions calculates distances, angles and
diameters between points you select from the graphics window.

When using measurements, results and instructions on how to
proceed are displayed in the Output window, see The Measure
Group on page 286.

A component group groups related object in the browser, see
Component Group on page 234.

Objects that are to be used by the robots in any way, such as
tools, need to be attached to the robot, see Attach to on page
378 and Detach on page 385.

Robots can be placed by jogging. The robot axes can also be
postioned by jogging, see Jogging mechanisms on page 93.

Modifying the task frame repositions a controller and all its
robots and equipment in the station.

By default the controller world and the station world coordinate
system coincide. This is convenient when building a station with
one single controller. For a procedure, see Set Task Frames on
page 369.

However, when you have several controllers in one station, or
need to reposition a controller in an existing station, you need to
modify the System Configuration on page 370.

Modifying the baseframe position sets an offset between the
controller’s world coordinate system and the baseframe of the
mechanical unit.This is necessary when having several
mechanical units belonging to one controller, for example,
several robots in MultiMove systems or when using positioner
external axes. For a procedure, see System Configuration on
page 370.
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2.8.2. Placing external axes

Overview
When starting a system with a track or positioner external axis in a RobotStudio station, you
have to set up the system to load a model for the track or positioner and get the motions to
work properly.

Prerequisites
The system shall be created with support for track or positioner external axes, see A system
with support for one robot and one positioner external axis on page 162.

Attaching the robot to the track
To attach the robot to the track, follow these steps:

1. Inthe Layout browser, drag the robot icon and drop it on the track icon.
2. Tothe question Should the robot be coordinated with the track?, answer Yes to be able

to coordinate the track’s position with that of the robot in robot programs. To program the
track and the robot independently, answer No.

3. When asked if you want to restart the system, answer Yes.

The track is now added to the system and ready to be programmed, see Programming
external axes on page 117 for more information on how to program the track.

CAUTION!
@ If the system is cold started , the setup is deleted and the procedures described here must be
performed again.

Placing the positioner in the station
To place the positioner in the station, follow these steps:

1. Move the positioner to the desired position using any of the ordinary functions for placing
and moving objects, see Placing objects on page 85.

2. Modify the baseframe position of each mechanical unit of the positioner except the
INTERCH unit, if it exists. When asked if you want to restart the system, answer Yes.

After the restart the system is updated with the positioner’s new location. Continue
attaching fixtures and workobjects to the positioner.

Continues on next page
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Attaching objects to the positioner
To program robot motions on an object that is held by the positioner, the targets must be
created in a workobject that is attached to the positioner. For a complete visual simulation,
CAD models that are moved by the positioner should also be attached. To attach the objects,
follow these steps:

1.

Import the models of the fixture and the work piece if you do not have them in the station
already, see Importing a station component on page 75.

Attach the fixture to the positioner, see Attaching and detaching objects on page 56. When
asked whether to keep the current position, answer No.

If the positioner has several stations, you will be asked which one to attach the object to.

Attach the work piece to the fixture. When asked whether to keep the current position,
answer No.

Attach the workobject in which you will program the work piece to either the fixture, the
work piece or the positioner. If you have defined calibration positions on either the work
piece or the fixture, it is a good practice to use that object. When asked whether to keep
the current position, answer No.

The positioner is now set up and ready to be programed, see Programming external axes
on page 117 for more information.

TIP!

Q If the positioner is of an interchangeable type with several stations, you can either attach
individual fixtures, work pieces and workobjects to each station flange, or you can use one
set of objects that you attach and detach to the different flanges by events.

CAUTION!
@ If the system is cold started, the setup is deleted and the procedures described here must be
performed again.
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2.8.3. Placing robots

Overview
When modifying the position of a robot connected to a VVC there is a possibility to modify the
related task frame or any stationary RAPID objects (tooldata, workaobjects) connected to the
robot.

Prerequisites
A robot library must be present in the station and connected to a VC, see Creating a station
with a system on page 61.

Modifying the robot position using a positioning tool

1. Modify the baseframe position of a robot connected to a VC using any of the following
options:
» Set Position. See Positioning an item on page 421.
« Place object by One Point, Two Points, Three Points, Frame, and Two Frames. See

Placing an item on page 411.

* Rotate. See Rotating an item on page 417.

2. Click Apply.
To the question, Do you also want to move the Task Frame?. Click Yes or No.

» Click Yes to move the task frame, but the base frame keeps its relative placement to
the task frame.

« Click No to move the base frame and the placement relative to the task frame will
change.

NOTE!

ﬂ If there are any stationary RAPID objects (tooldata, workobjects) in the corresponding task,
the following question appears Do you want to keep the positioning of all stationary
RAPID objects?

« Click Yes to keep all the stationary RAPID objects in their global coordinates.

e Click No to move all the stationary RAPID objects along with the base frame (same
coordinates relative to base frame). Workobjects attached to any other object in the
station will not be affected. Workobjects attached to any other object in the station will
not be affected.

If the base frame configuration of the VC is updated, the VC has to be restarted for the
changes to take effect. i.e. if the base frame changes its placement relative to task frame, the
following question appears Do you want to update the controller configuration and
restart?

» Click Yes to restart the controller and update the base frame configuration of the
connected VC.

¢ Click No if the base frame is not in accordance with the controller.

Continues on next page
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Modifying the robot position using Freehand move or rotate
1. Modify the baseframe position of a robot connected to a VVC using the following Freehand
options:
¢ Move. See Moving an item on page 225.
* Rotate. See Rotating an item on page 226.

For information on updating the robot baseframe, see Updating the baseframe position on
page 370.

2. A warning message is displayed in the Output window.
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3 How to program robots

3.1. Workflow for programming a robot

3.1. Workflow for programming a robot

Overview

In most cases, going through the workflow from start to finish is recommended, even if it
possible to work in other sequences as well.

Synchronizing will save and load text files containing RAPID modules, and create RAPID

programs from your station.

Prerequisites

Before creating a program for your robot, you should set up the station, including robots,
work pieces and fixtures, in which your robot will work.

Programming a robot

The table below describes the workflow for programming a robot to perform the task you

require.

Task

Create targets and paths

Check the target orienta-
tions

Check reachability
Synchronizethe program
to the virtual controller
Perform text-based

editing

Collision detection

Test the program

Description

Create the targets and paths the robot requires to perform the
work tasks.

To create targets and paths, do one of the following:

e Create a curve to match your required shape. Then use
the Create path from curve command to generate a
path, complete with targets, along the shape you have
created. See Curve on page 274 and Path from Curve on
page 208.

» Create targets at the requested positions, then create a
path and insert the created targets into it. See Create
Target on page 202, Teach Target on page 201 and
Empty Path on page 207.

Make sure that the targets are oriented in the most efficient way
for the tasks to be performed. If not, reorient the targets until you
are satisfied. See Orientations on page 99.

Check that the robot and tool reach all targets in the path. See
Testing positions and motions on page 108.

Generates RAPID code from the RobotStudio items and
enables the program to be simulated.

If you need to edit the instructions or data created by RobotStu-
dio, you can start the Program Editor. See Using the RAPID
editor on page 121.

Check that the robot or tool does not collide with the
surrounding equipment or the fixtures. If it does, adjust the
placements or orientations until no collisions occur. See
Detecting collisions on page 127.

Test the program by moving along the paths. See Testing
positions and motions on page 108.
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3.2. Workobjects

Creating a workobject
A workobject is a coordinate system used to describe the position of a work piece. The
workobject consists of two frames: a user frame and an object frame. All programed positions
will be related to the object frame, which is related to the user frame, which is related to the
world coordinate system.

xx0500001519
For a procedure, see Workobject on page 199.

Modifying a workobject
For a procedure, see Modify Workobject on page 408.

Converting a frame to a workobject

You can create a new workaobject from an existing frame. The converted workobject gets the
same name and position as the selected frame.

For a procedure, see Convert Frame to Workobject on page 382.

Creating a frame by points
You can create a frame by specfiying points on the axes of the coordinate system and letting
RobotStudio calulate the placement and orientation of the frame’s origin.

For a procedure, see Frame from Three Points on page 197.
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3.3. Jogging mechanisms

Jogging arobot

To check if the robot can reach all positions on the work piece, you can jog the TCP or the
joints of the robot, either with the freehand commands of through dialog boxes. Jogging the
robot close to its boudaries is best done with the latter method.

To

Jog the joints of a robot

Jog the TCP of a robot

Procedure

For freehand, see Jog Joint on page 227. For a dialog box, see
Mechanism Joint Jog on page 394.

For freehand, see Jog Linear on page 228. For a dialog box, see
Mechanism Linear Jog on page 396.

Prerequisites

To jog the TCP of a robot, the robot’s VC must be running.

Jogging several mechanisms

Function

Mutlirobot jog

Jogging with locked TCP

Description

When using multirobot jog, all selected mechanisms will follow
the TCP of the one being jogged.

Multirobot jog is available for all kinds of jogging.

See MultiRobot Jog on page 229.

When jogging a mechanism that moves a robot (like a track
external axis) with locked TCP, the robot will reposition so that
the position of the TCP does not change, even though its
baseframe is moved.

When jogging an external axis that moves the work object with
locked TCP, the robot will reposition so that its TCP follows the
work object in the same way as when using multirobot jog.
Locked TCP is available when jogging a mechanism that
belongs to the same task as a robot.

See Mechanism Joint Jog on page 394.
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3.4. Targets

Creating a target

You can create a new target manually either by entering the position for the target in the
Create Target dialog box or by clicking in the graphics window.

The target will be created in the active workobject.
For a procedure, see Create Target on page 202.

Creating a jointtarget

A jointtarget is a specification of the position for the robot axes.
For a procedure, see Create Jointtarget on page 204.

Teaching targets

You can create a new target by jogging the robot and teaching a target at the active TCP.
Taught targets will be created with the axis configuration used when jogged to the target.

The target will be created in the active workobject.
For a procedure, see Teach Target on page 201.

Modifying a target position

By using the modify position command you can modify the position and rotation of a target.
For procedures, see Set Position on page 421 and Rotate on page 417, respectively.

Modifying a target with ModPos

The position of an existing target can be modified by jogging the robot to a new, preferred
position. By selecting a move instruction for the target in a path, the ModPos command can
be used to move the target to the TCP of the active tool.

When ModPos is executed, the target, referenced to by the move instruction, will be updated
with the following information:

« position and orientation corresponding to the TCP of the active tool
« the current configuration of the active robot

« the current position and orientation values of all active external axes for the active
robot

NOTE: To jog arobot linearly, a virtual controller must be running for that robot. For detailed
information, see Starting a VC on page 71.

Continues on next page
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Continued

Renaming targets

With this command you can change the name of several targets at once. You can either rename
targets individually, or you can rename all targets in one or several paths at once.

The new target names will consist of an optional prefix, an incremental number and an
optional suffix.

For a precedure, see Rename Targets on page 415.

When renaming targets, make sure that the new targets conform to the naming rules. The
target names must:

 start with an alphabetical character in the 1ISO 8859-1 encoding (that is, an ordinary
letter from the English alphabet)

* be shorter than 16 characters
e not be empty strings

« not contain any characters illegal in RAPID. See the RAPID reference manual for
details.

Removing unused targets

If deleting or changing paths or move instructions during programming, you might end up
with large numbers of targets that are no longer used in any instructions. To make the
workobjects and their targets easier to grasp, you can delete all unused targets.

For a procedure, see Remove Unused Targets on page 414.
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3.5. Paths

Creating an empty path
A path is a sequence of targets with move instructions that the robot follows. An empty path
will be created in the active task.

For a procedure, see Empty Path on page 207.

Creating a path from curve
If the work piece has curves or contours that correspond to the path to be created, you can
create the paths automatically. The create path from curve command generates paths,
complete with targets and instructions along existing curves.

The path will be created in the active task.

The orientation of the targets that will be created will be according to the settings of the
approach/travel vectors in the Options dialog box.

To create a path from a curve, the curve must have first been created in the station.
For a procedure, see Path from Curve on page 208.

Setting robot axis configuration for paths
The robot axis configuration specifies the position of the axes as the robot moves from target
to target, when multiple solutions are possible. This is necessary for executing move
instructions using configuration monitoring.

Taught targets have validated configurations, but targets created in any other way do not.
Also, targets that are repositioned lose their configuration. In RobotStudio, targets without a
valid configuration are marked with a yellow warning symbol. See Robot axis configurations
on page 24 for more information about configurations.

To set a configuration for all targets in a path, see Auto Configuration on page 379.

To set a configuration for a single target, see Configurations on page 381.

Reversing paths
The reverse path commands change the sequence of targets in the path so that the robot moves
from the last target to the first. When reversing paths, you can reverse either the target
sequence alone or the entire motion process.
For procedures, see Reverse Path on page 416.
NOTE!

H When reversing paths, the original paths are deleted. If you want to keep them, make copies
before reversal.

H NOTE!

When reversing paths, only move instructions are handled. Action instructions, if any exist,
have to be inserted manually after the reversal.

Continues on next page
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Rotating paths

With the rotate path command you can rotate complete paths and move the targets used by
the paths accordingly. When rotating paths, the included targets will lose their axis
configurations, if any have been assigned.

A frame or target must exist at the position to rotate around before starting the rotate path
command.

For a procedure, see Rotate Path on page 418.

Translating a path

The translate path function moves a path and all included targets.
For a procedure, see Translate Path on page 423.

Compensating paths for tool radius

You can offset a path so that it compensates for the radius of a rotating tool. Since the targets
in the path are moved, they will lose their axis configurations, if any have been assigned.

For a procedure, see Tool Compensation on page 422.

Interpolating a path

No interpolation

The interpolate functions reorient the targets in a path so that the difference in orientation
between the start and end targets is distributed evenly among the targets in between. The
interpolation can be either linear or absolute.

Linear interpolation distributes the difference in orientation evenly, based on the targets’
positions along the length of the path.

Absolute interpolation distributes the difference in orientation evenly, based on the targets’
sequence in the path.

Below are examples of the difference bewteen linear and absolute interpolation.

The interpolate functions reorient the targets in a path so that the difference in orientation
between the start and end targets is distributed evenly among the targets in between. The
interpolation can be either linear or absolute.

For a procedure, see Interpolate Path on page 389.

This is the path before any interpolation. Note that the last target is oriented differently than
the others.

b4

xx0500002029

Continues on next page
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Linear interpolation

Absolute interpolation

This is the same path after linear interpolation.

xx0500002030

Note that the targets are oriented based on their placement relative to the start and end targets.

If a target were moved and you reran the linear interpolation, it would be reoriented according
to its new position.

If new targets were inserted between the existing ones and you reran the linear interpolation,
it would not affect the orientation of the existing targets.

This is the same path after absolute interpolation

xx0500002031
Note that the targets are orientated based on their sequence in the path: each target has been
reoriented equally, regardless of its place.

If a target were moved and you reran the absolute interpolation, it would not affect the
orientation.

If new targets were inserted between the existing ones and you reran the absolute
interpolation, it would change the orientation of all targets.

Mirroring a path

The mirror path function mirrors all motions instructions and their targets to a new path.

For a procedure, see Mirror Path on page 397.
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3.6. Orientations

Overview
This is an overview of the tools for automating the modification of target orientations.

When creating paths from curves in RobotStudio, the orientation of the targets depends on the
characteristics of the curves and the surrounding surfaces. Below is an example of a path with
unordered target orientations and examples of how the different tools have affected the
targets.

Unordered orientations
In the path below, the target orientations are unordered. The function View tool at target has
been used for illustrating how the targets point in different directions.

Stat Page ) align:View1 | 4F X

xx0500001864

Effect of target normal to surface
In the picture below, the targets, which previously were orientated randomly, have been set
normal to the flat round surface at the right side of the path. Note how the targets’ Z axis has
been orientated normal to the surface; the targets have not been rotated in the other directions.

Start Page )V align:View | P x

s
xx0500001865

Continues on next page
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Setting a target normal to surface

To set a target orientation normal to a surface is to make it perpendicular to the surface. The
target can be oriented normal to the surface in two different ways:

« Theentire surface can be used as a reference for the normal. The target will be oriented
as the normal to the closest point at the surface. The entire surface is the default surface
reference.

» Aspecific point on the surface can be used as the reference for the normal. The target
will be orientated as the normal to this point, regardless of whether the normal to the
closest point at the surface has another orientation.

Objects imported without geometry (for example, .jt files) can only refer to specific points on
the surface.

For a procedure, see Set Normal to Surface on page 420.

Effect of align target orientation

In the picture below, the targets, which were previously orientated with the Z axis normal to
the surface but with the X and Y axes orientated randomly, have been organized by aligning
the targets’ orientation around the X axis with the Z axis locked. One of the targets in the path
has been used as reference.

Start Page )/ align:View] | 4 x

b

(

xx0500001866

Aligning a target orientation

With the align target orientation command you align the rotation of selected targets around
one axis without changing the rotation around the others.

For a procedure, see Align Target Orientation on page 377.
TIP!

You can also align ordinary frames in the same way.

Continues on next page
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Effects of copy and apply orientation
In the picture below, the targets, which were previously oriented randomly, have been
organized by copying the exact orientation of one target to all the others. This is a quick way
to fix workable orientations for processes where variations in approach, travel, or spin
directions either do not matter or are not affected, due to the shape of the work piece.

Start Page )V align:Viewl | P x

xx0500001867

Copying and applying an orientation for objects
To transfer an orientation from one object to another is an easy way to align different frames
for simplifying the programming of the robot. Target orientations may also be copied.

For procedures, see Copy / Apply Orientation on page 384.
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3.7. RAPID Instructions

Move and action instructions

For RAPID programming, RobotStudio’s main advantage is in the area of motion
programming.

A move instruction is an instruction for the robot to move to a specified target in a specified
manner. With RobotStudio, you can create move instructions in three ways:

Method Description

Create a move instruction Creates move instructions based on one or several targets
based on an existing target  selected in the Paths&Targets browser. For a procedure, see
Add to Path on page 375.

Create a move instruction Creates a move instruction and a corresponding target at

and a corresponding target  once. The position of the target can either be selected from the
graphics window or typed numerically. For a procedure, see
Move Instruction on page 220.

Teach a move instruction Teaching a move instruction creates a move instruction and a
corresponding target at the robot’s current position. Teaching
a move instruction also stores the current configuration with
the target. For a procedure, see Teach Instruction on page
219.

In addition to move instructions, you can also create and insert action instructions from
RobotStudio. An action instruction is an instruction other than a move instruction that can,
for example, set parameters, or activate or deactivate equipment and functions. The action
instructions available in RobotStudio are limited to those commonly used for affecting the
robot’s motions. For inserting other action instructions or another kind of RAPID code in the
program, use the Program Editor. For a procedure, see Action Instruction on page 221.

The table below lists the action instructions that can be created. For details, see the RAPID
Reference Manual.

Action instruction Description

ConfL On/Off ConfL specifies whether to monitor the robot’s configurations
during linear movements. When ConfL is set to Off, the robot
may use another configuration than the programed one for
reaching the target during program execution.

ConfJ On/Off ConfJ specifies whether to monitor the robot’s configurations
during joint movements. When ConfJ is set to Off, the robot may
use another configuration than the programed one for reaching
the target during program execution.

Actunit UnitName Actunit activates the mechanical unit specified by UnitName.

DeactUnit UnitName Deactunit deactivates the mechanical unit specified by
UnitName.

ConfJ On/Off ConfJ specifies whether to monitor the robot’s configurations

during joint movements. When ConfJ is set to Off, the robot may
use another configuration than the programed one for reaching
the target during program execution.

Actunit UnitName Actunit activates the mechanical unit specified by UnitName.
DeactUnit UnitName Deactunit deactivates the mechanical unit specified by
UnitName.

Continues on next page
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Modifying an instruction

Most instructions have arguments that specify how the instruction shall be carried out. For
example, the MoveL instruction has arguments that specify the speed and accuracy with
which the robot moves to the target.

For a procedure, see Modify Instruction on page 405.
NOTE!

Some arguments are read from the virtual controller. If the virtual controller has not been
started, only the arguments stored in the station can be modified.

Converting to move circular

To create a circular motion to an instruction target, you must convert the motion type to
circular motion (that is, MoveC in RAPID).

A circular motion is defined by two motion instructions, where the first is the via-point and
the second contains the end point of the circular motion.

The circular motion can only be used for open circular arcs, not for closed circles. To create
a path for a closed circle, use two circular motions.

For a procedure, see Convert to Move Circular on page 383.

Creating RAPID instructions for setting 1/0 sighals

For controlling 1/0 signals in the robot program, you use RAPID commands that set the
signals. These require that you first create instruction templates for the instructions that set
the signals. See the RAPID reference manual for details about the instructions that control 1/
O signals.

To add RAPID instructions that set I/O signals, follow these steps:

1. Synchronize the system in which you want to add the instructions to the virtual controller,
see Synchronization on page 120.

2. In programming mode, select the module for editing, right-click it and then click Edit
program.

In the program editor, add the instructions for setting the signals.

4. When you are done adding instructions, synchronize the task and paths from the Virtual
Controller back to the station.

Continues on next page
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Using cross-connections and groups for setting 1/O signals

You can also create cross-connections and signal groups, which make one signal set the value
of several other signals. See the System parameters reference manual for details about cross-
connections and groups.

To make one signal set several others, follow these steps:

1. Request write access, and then open the configuration topic 1/0 in the configuration
editor. Add configure instances for the cross-connections and groups to create.

Instruction templates

Instruction templates contain predefined sets of argument values that are applied to the
instructions you create using the template. You can create templates for all instructions in the
system running on the virtual controller. To see which instructions are available and what
their arguments do, see the RAPID reference manual for your RobotWare version and the
reference sections in manuals for software options, if you have any installed on the system.

Move instruction templates are always part of process templates. The process templates
contain one instruction template for each type of move instruction that might be used by the
process.

The process templates are instances of process definitions, which define the types of move
instructions (move instruction definitions) that might be used by the process.

To create new move instruction templates, start by creating a new process template for a
process that uses the type move instructions you want to create templates for. If such a process
does not exist, you first have to create a new process definition.

If no move instruction definition for the type of instruction you want to create a template for
exists, you must create it first.

When creating instruction descriptions, the virtual controller must be running, since the
available instruction types are read from the system.

Method Description

Creating a process Move instructions are always related to processes.
template with move
instruction templates on

page 105

Creating a move To create templates for other instructions than the one that

instruction description on  already exists in the tree view, you first have to create an

page 106 instruction description that defines the arguments that belong to
the instruction.

Editing an instruction XXX

template on page 106

Creating a process XXX

definition on page 107

Creating an action XXX

instruction template on

page 107

Creating an action To create templates for other instructions than the one that

instruction description on  already exists in the tree view, you first have to create an

page 107 instruction description that defines the arguments that belong to

the instruction.

Continues on next page
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Templates can be imported and exported on four levels: tasks, move instruction descriptions,
action instruction descriptions and process definitions. The default directory for imported and
exported template files is My Documents/RobotStudio. Simply choosing another directory
will then make that directory default. The default file format is .xml.

The validation procedure checks for duplicate names, incomplete process definitions and
virtual controller equality. It is performed automatically, after a template file has been
imported or a node renamed or deleted.

For procedures, see Instruction Template Manager on page 222.

Instruction Template Manager
The Instruction Template Manager is used to add support for instructions other than the
default set that comes with the RobotStudio.

For example, a robot controller system with the RobotWare Dispense option has specialized
move instructions related to glueing like DispL and DispC. You can manually define the
instruction templates for these using the Instruction Template Manager. The instruction
templates are exported to XML format and reused later.

The instruction template supports the following Robotware options:
» Cap (Continuous Application Process)
» Disp (Dispense)
« Trigg (Fixed Position Events)
e Spot Pneumatic
¢ Spot Servo
* Spot Servo Equalizing
e Paint

RobotStudio has pre-defined XML files that are imported and used for robot controller
systems with the appropriate RobotWare options.These XML files has both the Move and
Action instructions.

NOTE! It is recommended to use RobotStudio ArcWelding PowerPac while using
RobotWare Arc.

Creating a process template with move instruction templates

1. Onthe Home tab, from the active Task list, select the task for the robot for which you
want to create the instruction template.

2. On the Create menu, click Instruction Template Manager. This opens the Instruction
templates page in the work space.

3. Inthe Instruction Templates tree to the left, make sure there are move instruction
definitions for the types of move instructions you want to create templates for. If not,
follow the procedure in Creating a move instruction description on page 106 for creating
them.

4. Make sure there is a process definition that uses the types of move instructions you want
to create templates for. If not, follow the procedure in Creating a process definition on
page 107 for creating it.

5. Right-click the process definition for which you want to create a new templates and click
Create Process Definition.

Continues on next page
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6.

In the Create Process Definition dialog box, enter a name, with characters from ASCI|I
set, for the new template and click Create. A new process template node with a set of
move instruction templates is now created.

Select each new template one at a time, and in the arguments grid to the right of the tree
view, set the argument values that shall be applied when you create new instructions based
on the template. Finish for each template by clicking Apply changes at the bottom of the
grid.

For details about available arguments and what they do, see the RAPID reference manual
for ordinary RAPID instructions and the option manual for software option instructions.

Creating a move instruction description
To create the instruction description, follow these steps:

1.

Right-click the Move Instructions node and click Create Move Instruction
Description. This opens the Create Move Instruction Description dialog box.

In the Controller Description list, select the instruction you want to make a description
for. All action instructions installed on the controller, both through RobotWare and
software options, are available.

In the Motion type list, select the motion type for the instruction.

Optionally, in the Information text box, enter a comment to the instruction.

5. Click Create. The instruction description appears in the tree view and its settings are

displayed in the grid.

In the instruction grid, set the point type values. If necessary, also change the other
settings.

After changing the settings, click Apply Changes in the bottom of the grid view.

Editing an instruction template
To edit an instruction template, follow these steps:

1.

In the active task list, select the task for the robot for which you want to edit the instruction
template.

On the Create menu, click Instruction Template Manager. This opens the Instruction
templates page in the work space.

In the Instruction Templates tree to the left, browse to and select the template to edit.

In the arguments grid to the right of the tree view, set the argument values that shall be
applied when you create new instructions based on the template. Finish by clicking Apply
changes at the bottom of the grid.

For details about available arguments and what they do, see the RAPID reference manual
for ordinary RAPID instructions and the option manual for software option instructions.

Continues on next page
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Creating a process definition
To create a process definition, follow these steps:

1.

Make sure there are move instruction definitions for the types of move instructions you
want to create templates for. If not, follow the procedure above for creating them.
Right-click the Process definitions node and click Create Process Definition. This
opens the Create Process Description dialog box.

In the Create Process Definitions dialog box, enter a name for the process definition, a
name for its first process template and then select the move instruction types to use. Finish
by clicking Create.

Creating an action instruction template
To create a template for an action instruction, follow these steps:

1.

In the active task list, select the task for the robot for which you want to create the
instruction template.

On the Home menu, click Instruction Template Manager.

In the Instruction Templates tree to the left, right-click the instruction description
(corresponding to the instructions as described in the RAPID reference manual) for which
you want to create a new template and click Create Action instruction Template.

If the instruction description does not exist in the tree, create it by following the procedure
described in Creating an action instruction description on page 107.

In the Create Action Instruction Template dialog box, enter a name for the new
template and click Create. The new template is now created under the instruction
description node it belongs to.

Select the new template and in the arguments grid to the right of the tree view, set the
argument values that shall be applied when you create new instructions based on the
template. Finish by clicking Apply changes at the bottom of the grid.

For details about available arguments and what they do, see the RAPID reference manual
for ordinary RAPID instructions and the option manual for software option instructions.

Creating an action instruction description
To create the instruction description, follow these steps:

1.

Right-click the Action Instructions node and click Create Action Instruction
Description. This opens the Create Instruction Description dialog box.

In the Controller Description list, select the instruction you want to make a description
for. All action instructions installed on the controller, both through RobotWare and
software options, are available.

3. Optionally, in the Information text box, enter a comment to the instruction.

Click Create. The instruction description appears in the tree view, and its settings are
displayed in the grid.

After changing the settings (if necessary), click Apply Changes in the bottom of the grid
view.

Continue with creating templates for the instruction description, as described in Creating
an action instruction template on page 107.
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3.8. Testing positions and motions

Overview
RobotStudio has several functions for testing how robots reach and move to targets. They are
useful both for finding the optimal layout when building a station and during programming.

Below are brief descriptions of the functions for testing reachability and motions.

Checking reachability
The check reachability function displays whether the robot can reach selected targets and
motion instructions by changing the frames’ colors in the graphic view. Reachable frames are
colored green, unreachable red, and frames with reachable positions but not with current
orientation are colored yellow.

The reachability check is useful when building the station, since the reachability of several
targets are displayed at once. For a procedure, see Check Reachability on page 380.

Jumping to target
Jump to target tests whether the robot can reach a specific position. This is useful when
building the station: by creating targets at critical positions on the work piece and jumping
the robot to them, you get an early indication of whether the items are positioned correctly or
not. For a procedure, see Jump to Target on page 391.

Viewing a robot at target
When View robot at target is activated, the robot is automatically positioned with the tool at
the target when one is selected. If several robot axis configurations are possible for reaching
the target, the robot will use the one nearest the configuration it had before jumping to the
target. For a procedure, see View Robot at Target on page 424.

Viewing tool at target
View tool at target displays the tool at target, without checking that the robot can reach it. This
test is useful both when building the station and when programming the robot, since the
orientation of targets both affects the reachability and the process performance. For a
procedure, see View Tool at Target on page 425.

Executing move instructions
Execute move instruction tests if the robot can reach a specific position with the programed
motion properties. This is useful for testing motions during programming. For detailed
information, see Execute Move Instruction on page 386.

Moving along path
Move along path executes all move instructions in a path. It is thereby a more complete test
than Execute move instructions, but not as complete as a full simulation, since it ignores
RAPID code that is not move instructions. For a procedure, see Move Along Path on page
4009.

Continues on next page
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Moving to a pose
Moving to a pose moves a mechanism to a predefined joint value at a predefined time without
using the Virtual Controller. This is useful when movement of the external equipment (such
as a clamp or conveyer) must be simulated. For a procedure, see Move to Pose on page 410.

Simulating programs
Simulating programs involves running a program on the virtual controller as it is run on a real
controller. It is the most complete test whereby you can see how the robot interacts with
external equipment through events and 1/0 signals. For a procedure, see Simulation Setup on
page 297.

Improving the reachability
If the robot cannot reach the target, or if you are not satisfied with the motions, try the
following for improving the reachability:

Set ConfL or ConfJ to Off for enabling the robot to use new configurations for reaching
the target.

Change the orientation of the target.
Change the position of either the robot or the work piece.
Use a system with a track external axis for increasing the robot’s range.

Use a system with a positioner external axis for enabling different work piece positions
for different targets.
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3.9 Programming MultiMove systems

3.9.1. About programming MultiMove

About MultiMove
The MultiMove functions helps you create and optimize programs for MultiMove systems
where one robot or positioner holds the work piece and other robots operate on it. Below is
an outline of the main workflow for programming MultiMove systems with RobotStudio,
with references to detailed instructions further down in the section.

Prerequisites
For using the MultiMove functions you must first have the following:

* Avirtual controller running a MultiMove system started in RobotStudio, see A
MultiMove system with two coordinated robots on page 160 for an example.

« All coordinate systems and tools used by the system.

» The paths along which the tool shall move. The paths must be created in a workobject
that belongs to a tool robot and is attached to the work piece robot. A wizard will guide
you through attaching the workobjects if this has not been done before starting the
MultiMove functions.

For detailed information about MultiMove in RobotWare systems and RAPID programs, see
the MultiMove application manual.

Normal workflow
This is the typical workflow for creating MutliMove programs using the MultiMove function:

Action Description

Setting up the MultiMove Select the robots and paths to use in the program, see
Setting up the MultiMove on page 112.

Testing the MultiMove Execute the motion instructions along the paths, see
Testing the MultiMove on page 113.

Tuning the motion behavior Tune motion behavior, such as tolerances and constraints
for TCP motions, see Tuning the motion behavior on page
114.

Creating the program Generate the tasks for the robots, see Creating paths on
page 116.

Continues on next page
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Continued

Additional actions

In addition to using the functions that calculate and create optimized MulitMove paths, you
can program MulitMove manaully using a combination of the ordinary programming tools in
RobotStudio and a set of tools specific for MultiMove programming.

The main actions for programming MulitMove manually are outlined below. Not all actions
might be necessary, but the order in which they shall be carried out depends on the contents

of the station and your goals.

Action

Creating Tasklists and
Syncidents

Adding and updating 1D
arguments to the instructions to
synchronize

Adding and adjusting Sync
instructions to the paths.

Teaching MultiMove instructions

Description

This data specifies the tasks and paths that shall be syn-
chronized with each other. See The Create Tasklist tool on
page 218 and The Create Syncident tool on page 218,
respectively.

To add IDs to the intructions, you can use one of the
following methods:

Using The Recalculate ID tool on page 217 to add and
update IDs for instructions in paths that already are syn-
chronized.

Using The Convert path to MultiMove path tool on page
218 to add IDs to instructions in paths that have not yet
been synchronized.

Add SyncMoveon/Off or WaitSyncTask instructions
to the paths to synchronize and set their tasklist and
Syncident parameters. See Creating an action instruction
on page 221.

It is also possible to jog all robots to the desired positions
and then teach instructions to new synchronized paths.
See MultiTeach tab on page 214.
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3.9.2. Setting up the MultiMove

Selecting robots and paths
This procedure is for selecting the robots and paths in the station that shall be used for the
MutliMove program. All robots for the MultiMove program must belong to the same system.

1
2.
3.

On the Home tab, click MultiMove. Click the Setup tab below the MutliMove work area.
In the work area, click the System config bar for expanding the system config section.
In the Select System box, select the system that contains the robots to program.

The robots of the selected system are now displayed in the System grid below the Select
system box.

For each robot that shall be used in the program, select the check box in the Enable
column.

For each robot that shall be used in the program, specify whether it carries the tool or the
work piece using the options in the Carrier column.

In the work area, click the Path config bar for expanding the path config section.

. Select the Enable check box for the tool robot and click the expand button. This displays

the paths of the robot.

Select the order of the paths to execute by specifying them in right order using Path name
column.

For each path that shall be included in the program, select the check box in the Enable
column.

10. When you have set up the robots and paths, continue testing the Multimove and then tune

the motion properties, if necessary.
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3.9.3. Testing the MultiMove

Overview

Testing the MultiMove executes the motion instructions along the paths according to the
current settings on the setup and motions properties pages.

Testing Paths

This procedure is for setting the robots start position and testing the resulting movements
along the path sequence.

1.
2.

Jog the robots to what seems to be a good start position.

On the Home tab, click MultiMove. Click the Test tab at the bottom of the MultiMove
work area for displaying the test area.

Optionally, select the Stop at end check box to make the simulation stop after moving
along the paths. Clearing this check box makes the simulation continue in a loop until you
click Pause.

Click Play to simulate the motions along the paths based on the current start position.

If you are satisfied with the motions, continue generating multimove paths. If the
simulation cannot complete or if you are not satisfied with the motions, pause the
simulation and perform any of the actions below to adjust the motions:

Action Description

Examine the robots’ positions Click Pause and then use the arrow buttons to move to one
for critical targets. target a time.

Jog the robots to new start New start positions might result in changed motions, since the
positions. robots will use different configurations. In most cases,

positions near the robots’ joint limits shall be avoided.

Go to the Motion Behavior  The default setting for the motion properties is no constraints.
tab and remove constraints.  If this has been changed, constraints might exist that limit

motions more than necessary.
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3.9.4. Tuning the motion behavior

Overview

Tuning the motion behavior means to set up rules for the robot’s motions, for example,
constraints on the position or orientation of the tool. Generally, the MultiMove program will
obtain the smoothest motions with the fastest cycle and process times with as few constraints
as possible.

For procedures, see Motion Behavior tab on page 212.

Modifying the joint influences

The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while increasing
it will promote motion on this axis relative to alternative axes.

1. On the Home tab, click the Motion Behavior tab.

2. Expand the Joint Influence group by clicking its title bar.

3. In the Select Robot box, select the robot whose joint influence you want to modify.
The weight values for the robot axes are now displayed in the grid.

4. For each axis whose mation you want to restric or promote, adjust the Weight value. A
lower value restricts, and a higher value promotes, motions on that axis.

Modifying the TCP constraints

The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while increasing
it will promote motion on this axis relative to alternative axes.

1. On the Simulation tab, click the Motion Behavior tab.

2. Expand the TCP Constraints group by clicking its title bar.
The directions and rotations in which you can constrain the TCP’s motion are now
displayed in the grid

3. For each pose you want to constrain, select the Enable check box and specify the

constraint values (location in the TCP coordinate system). To use the values from the
current TCP position, click Pick from TCP.

4. Optionally, adjust the Weight value for the constraint. A low value results in a harder
constraint, while a high value allows a larger deviation.

Continues on next page
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Continued

Modifying the tool tolerance

The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while increasing
it will promote motion on this axis relative to alternative axes.

1. On the Simulation tab, click the Motion Behavior tab.

2. Expand the Tool Tolerance group by clicking its title bar.
The directions and rotations in which you can enable tolerances are now displayed in the
grid

3. For each offset you want to set, select the Enable check box.

4. In the Value column, specify the allowed deviation.

5. Optionally, adjust the Weight value for the tolerance. A low value increases the use of the
tolerance, while a high value promotes motions that do not use the tolerance.

Modifying the tool offset
The tool offset sets a fixed distance between the tool and the paths.

1. On the Simulation tab, click the Motion Behavior tab.
2. Expand the Tool Offset group by clicking its title bar.
The directions and rotations in which you can set offsets are now displayed in the grid.
3. For each offset you want to set, select the Enable check box.
4. In the Offset column, specify the offset distance.
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3.9.5. Creating paths

Overview

When you are satisfied with the motions displayed when testing the Multimove program, the
next step is to convert the temporary move instructions used by the MultiMove function to
ordinary paths in RobotStudio.

Creating the paths

To create paths for the MultiMove program in RobotStudio, follow these steps:
1. Onthe Home tab, click Create Paths tab.

2. Expand the Settings group by clicking on the its title bar.

3. Optionally, change the naming settings in the following boxes:

Box
Start ID

ID step index
Sync ident prefix

Task list prefix

Description

Specify the first ID number for the synchronization of the instruc-
tions for the robots.

Specify the increment between ID numbers.

Specify a prefix for the syncident variable, which connects the
sync instructions in the tasks for the tool robot and the work
piece robot with each other.

Specify a prefix for the tasklist variable, which identifies the tasks
for the tool robot and the work piece robot to synchronize.

4. Expand the WP Robot Settings group by clicking on its title bar and then check the
settings in the following boxes:

Box
WP Workobject

WP TCP

Path prefix
Target prefix

Description

Specify the workobject to which the targets generated for the
workpiece robot shall belong.

Specify which tooldata the workpiece shall use when reaching
its targets.

Specify a prefix for the generated paths.
Specify a prefix for the generated targets.

5. Expand the Generate path group by clicking on its title bar and then click Create Paths.
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3.9.6. Programming external axes

Overview

This is a brief overview of the functions and commands for programming external axes in
RobotStudio. For a more detailed description of external axes and how to program them, see
the product manual for the external axis to use and the RAPID reference manual.

Coordinated motions

Normally, external axes are used to move the workpiece, the robot or any other mechanism.
The motions of an external axis can be coordinated with those of a robot in two ways,
depending on the task in which the external axis is defined.

Task for external axis

Same task as the robot’s

Other task than the robot’s

Coordination method

If the external axis is in the same task as the robot, the current
position of active external axes is stored with each target that is
created. When the robot then moves to the target, the external
axis will move to the stored position as well.

Modifying and optimizing the position of positioner external axes
can be automated using the MultiMove function, or be
performed manually for selected targets. Positions of track
external axes can only be modifed manually.

For information about using the MultiMove function, see About
programming MultiMove on page 110. For information about
how to modify the position of external axes manually, see below.

If the external axis is in another task than that of the robot it shall
be coordinated with, the motions of the external axis are created
by MoveExt instructions, and the coordination is made by sync
instructions.

For positioner external axes creating or optimizing MoveExt and
sync instructions can be automated way using the MultiMove
function, or be performed manually by creating a path with
MoveEXxt instructions for the positioner and then adding sync
instructions to the path for the robot and the external axis. Track
external axes can only be programed manually.

For information about using the MultiMove function see About
programming MultiMove on page 110. For information about
how to use the sync instructions, see the RAPID reference
manual and the MultiMove application manual.

Continues on next page
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Continued

Modifying positions of external axes

When programming external axes, you often need to adjust the position of the external axis
for some targets. For example, if you create a path from curves on a work piece that is
attached to a positioner, the positioner will initially have the same position for all targets. By
repositioning the work piece for some of the targets you might improve process time and
reachability.

When targets are created in stations with a coordinated external axis, the position values of
the external axis are stored in the target. With the Modify External Axis function you can
reposition the external axis, thus making it possible for the robot to reach the target in new
ways. For a procedure, see Modify External Axis on page 404.

To modify the external axis values for a target, the following conditions must be met:

e The external axis must be added to the system and set up correctly. For examples of
how to add support for an external axis to a system, see A system with support for one
robot and one positioner external axis on page 162. For information about how to set
up an external axis in a RobotStudio station, see Placing external axes on page 86.

* The external axis must be defined in the same task as the robot.

* The external axis must be activated.

Activation and deactivation

Activating a mechanical unit makes it controlled and monitored by the controller.
Consequently, the mechanical unit must be activated before programming or running
programs. If a system uses several external axes or interchangeable models with several work
stations, several mechanical units might share common drive units. If this is the case, you
must make sure to set the mechanical unit as active.

For more information about activating and deactivating mechanical units, see the RAPID
reference manual on the instructions ActUnit and DeactUnit.

Activating and deactivating mechanical units can be done either manually, see Activate
Mechanical Units on page 305, or programmatically by RAPID instructions, see below.

To activate or deactivate mechanical units programmatically

To set the mechanical units to be active programmatically by RAPID instructions, follow
these steps:

1. Inthe Paths&Targets browser, browse down to the path in which you want to insert the
activation or deactivation instruction. To insert it as the first instruction in the path, select
the path node and to insert it between existing instructions, select the instruction before
the intended insertion point.

2. On the Home tab, click Action Instruction to bring up a dialog box.
In the Instruction Templates list, select one of the ActUnit or DeactUnit instructions.

4. In the Instruction Arguments grid and the MechUnit list, select the unit to activate or
deactivate.

5. Click Create. When the path is executed either through the Move along path command,
or running the RAPID program, the instruction will be carried out.
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3.10. Loading and saving programs and modules

Overview
RAPID programs and modules are normally stored in the RobotWare systems, as they are
created. You can also save the programs to files on the PC, which makes it possible to load
them to other controllers, either other virtual controllers or real IRC5 controllers.

Programs are saved from the VC
When saving a program to files on the PC from RobotStudio, it is the RAPID program stored
in the system of the VC that is saved. This program is created and updated by synchronizing
the station to the VC, see Synchronize to VC on page 364.

Procedures
To create or load a module or load a program, see:

« New Module on page 318.

e Load Module on page 319.

e Load Program on page 321.
To save a module or program, see:

« Save Module As on page 320.

e Save Program As on page 322.
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3.11. Synchronization

Overview
To synchronize is to make sure that the RAPID program in the system running on the virtual
controller corresponds to the programs in RobotStudio. You can synchronize both from
RobotStudio to the virtual controller and from the virtual controller to RobotStudio.

In a RobotStudio station, robot positions and movements are defined by targets and move
instructions in paths. These correspond to data declarations and RAPID instructions in the
modules of the RAPID program. By synchronizing the station to the virtual controller, you
create RAPID code out of the data in the station. By synchronizing the virtual controller to
the station, you create paths and targets out of the RAPID program in the system running on
the virtual controller.

When to synchronize the station to the VC
Synchronizing the station to the VVC updates the RAPID program of the virtual controller with
the latest changes in the station. This is useful to do before:

e Performing a simulation.
» Saving a program to files on the PC.
« Copying or loading RobotWare systems.
To synchronize a station to the VC, see Synchronize to VC on page 364.

When to synchronize the VC to the station
Synchronizing the VC to the station creates paths, targets and instructions that correspond to
the RAPID program in the system running on the virtual controller. This is useful to do when
you have:

« Started a new virtual controller which system contains existing programs.
e Loaded a program from a file.
» Text-edited the program.

To synchronize the VC to a station, see Synchronize to Station on page 363.
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3.12. Using the RAPID editor

Overview

The integrated RAPID program editor is useful for editing all robot tasks other than robot
motion. This section provides instructions on launching the editor and case examples
illustrating several useful functions, such as keyboard shortcuts, IntelliSense, code snippets
and the watch window.

Opening the program editor

v

To access the program editor, perform the following steps:

1. Click the Offline tab.

2. Inthe Program browser, select a module for editing and then click RAPID Editor.
The RAPID code of the program appears as a tabbed document window.

TIP!

The graphical layout can be consulted without closing the editor by clicking the graphics
window tab.

Searching: a case example

Assume that you have programed targets and motion instructions and sychronized them to the
controller. The number of targets is large, so you decide to distribute them among several
modules.

You may have forgotten in which module your main procedure is found.
1. Press CTRL + F to bring up the Search and Replace dialog box.

2. Inthe Search Pattern box, type "PROC main". Since no modules are open, in the Search
In list, select Current System, and then click Search All.

The search result is displayed in the output window.
3. Double-click the line matching your search to launch the program editor.

The entire RAPID program is then checked for errors.

Continues on next page
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Code Snippets

Code Snippets are pieces of code inserted in the RAPID Editor. The editor integrates these
codes with the pick list. The following are the predefined code snippets in RobotStudio:

e array2x2x4.snippet

e array2x4.snippet

e array2x4x2.snippet

o array4x2.snippet

« function with return value bool.snippet

* module header.snippet

e procedure parameters.snippet

e procedure with error handler.snippet

* robtarget.snippet

« tooldata.snippet

* TRAP routine example.snippet

* wobjdata.snippet
You can create customized code snippets and add to the existing list.
NOTE!

Code Snippets can be edited in an XML editor such as Microsoft Visual Studio. The
RobotStudio .snippet files are saved in the folder C:\<Documents and Settings>\<user
name>\RobotStudio\Code Snippets. The folder <Documents and Settings> may be
configured with different names, for example, Data. It may also be translated on localized
versions of Windows.

For information on creating customized code snippets, see http://msdn.microsoft.com/.

Editing: a case example

Assume that you wish to create an infinite loop whereby the controller receives commands
from a line PLC. The controller communicates with the PLC using digital 1/0 signals, but you
have forgotten the exact name of the function that reads an input signal.

1. Using code snippets, create a new procedure.
2. Press CTRL + SHIFT + SPACE to open the pick list.

3. Double-click the 1/0O folder, and then double-click the DOutput instruction to insert it at
the insertion position.

4. Press the spacebar to display the parameter information ToolTip. As you enter parameters,
the ToolTip is updated, displaying the current argument in bold. The ToolTip is closed
either by concluding the instruction with a semicolon (;), or by pressing ESC.

TIP!

At any time you may press CTRL + SHIFT to complete what you have begun typing. This
will either bring up a narrowed-down list of selectable parameters, or, if only one selection
remains, will automatically complete your text.

Continues on next page
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Continued

Adding breakpoints: a case example
Now that you have finished editing, you may want to test your loop and add some
breakpoints.

1.

Place the insertion on the new statement and press F9 to set a breakpoint.

The breakpoint, indicated by a grey circle, is stored in the editor until changes are applied,
whereupon it turns red.

Ensure that the Ignore breakpoints button in the Program editor toolbar is not clicked,
and click the Play button on the Simulation toolbar.

The program will run and then stop at the breakpoint.

To run the program statement by statement, click the Step over button in the Program
editor toolbar.

Applying and verifying the edits
To apply and verify your edits, follow these steps:

1.

To apply your edits, click the Apply icon in the editor toolbar.
The statement is highlighted, and breakpoint locations are adjusted, if necessary.

To verify the syntactic and semantic correctness of the modules, click the Check
Program icon in the editor toolbar.

Executing: a case example
You might want to debug your loop or monitor a specific variable.

1.

In the program editor browser, right-click the procedure you want to set as entry point,
and then click Set Entry.

The icon is marked in red.

In the Simulation tab, click the Play button.

The program will run and then stop at the next breakpoint.
Select a variable for monitoring and drag it to the watch window.
Restart the loop and monitor the variable at each iteration.

NOTE!

To manually refresh the variable list, click Refresh from the context menu.
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4 How to simulate programs

4.1. Simulation Overview

About this chapter

This chapter describes how to simulate and validate robot programs. Below are short
introductions to the simulation functions in RobotStudio.

Function

Play simulations

Collision detection

Event handling

1/O Simulation

Simulation Monitoring

Process time
measurement

Description

Simulations run entire robot programs on a virtual controller.

Before you run a simulation you need to decide which paths are
to be simulated. To set up a simulation, see Simulation Setup on
page 297. To run a simulation, see Simulation Control on page
306.

Collision detection displays and logs collisions and near-misses
for specified objects in the station. Normally used during
simulation of robot programs, it can also be used when building
the station.

For more information, see Detecting collisions on page 127.

Events can be used to connect an action to a trigger. For
example, you can attach one object to another when they collide
or a signal is set. For more information, see Creating an event
on page 130.

In simulations I/O signals are normally set either by the robot
program or by events. With the I/0 simulator you can set signals
manually, which provides a quick test of specific conditions. For
more information, see Simulating /O signals on page 131.

With the simulation monitoring functions you enhance the
simulation by adding traces along the TCP movements or alerts
triggered by defined speeds or motions. For more information,
see Enabling simulation monitoring on page 132.

With the process timer you measure the time for a process to
complete. For more information, see Measuring process time on
page 133.

Continues on next page
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Continued

Time handling during simulation

Free runtime

Time Slice

When simulating stations with events or several controllers, or other time managing
equipment, time can be managed in two modes: either as free runtime or as time slices.
RobotStudio uses time slice mode by default, but you can switch to free runtime, if required.

Since all controllers use the same computer resources, their synchronization might not be
exactly as in the real world if they run independently of each other (called free run mode).
The cycle time will be correct, but the timing for setting signals and triggering events might
be inaccurate.

Time slices can be used to ensure that the timing for signals and other interaction between
controllers is accurate. In this mode, RobotStudio synchronizes the controllers by dividing a
time segment into small slices and waiting for all controllers to complete a current time slice
before any controller can start anew. Thus, the controllers are synchronized, and the cycle
time will be calculated correctly. The drawbacks are that the virtual FlexPendant cannot be
open, and that the simulation might be somewhat slow and jerky, depending on the
complexity of the simulation and the performance of the computer.

NOTE!

If the simulation uses events or involves several different controllers, the virtual time mode
Time Slice shall be used to make sure that the timing between the controllers is correctly
simulated.
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4.2. Detecting collisions

Overview

With RobotStudio you can detect and log collisions between objects in the station. The basic
concepts of collision detection are explained below.

Collision sets

A collision set contains two groups, Objects A and Objects B, in which you place the objects
to detect any collisions between them. When any object in Objects A collides with any object
in Objects B, the collision is displayed in the graphical view and logged in the output window.
You can have several collision sets in the station, but each collision set can only contain two
groups.

A common use of collision sets is to create one collision set for each robot in the station. For
each collision set you then put the robot and its tool in one group and all objects you do not
want it to collide with in the other. If a robot has several tools, or holds other objects, you can
either add these to the robot’s group as well or create specific collision sets for these setups.

Each collision set can be activated and deactivated separately.

Collisions and near-misses

In addition to collisions, the collision detection can also watch for near-misses, which is when
an object in Objects A comes within a specified distance from an object in Objects B.

Recommendations for collision detection

In general, the following principles are recommended to facilitate collision detection:

< Simplify and defeature your models by removing everything that is not necessary for
simulation purposes.

« Use as small collision sets as possible, splitting large parts and collecting in the
collision sets only relevant parts.

« Enable coarse detail level when importing geometry.
e Limit the use of near-miss.
< Enable last collision detection, if the results are acceptable.

Results of creating a collision set

After you have created a collision set, see Create Collision Set on page 296, RobotStudio will
check the positions of all objects and detect when any object in ObjectsA collides with any
object in ObjectsB.

Activation of detection and displayal of collisions depend on how the collision detection is
set up.

If the collision set is active, RobotStudio will check the positions of the objects in the groups,
and indicate any collision between them according to the current color settings.

Continues on next page
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Collision detection

Collision detection checks whether robots or other moving parts collide with equipment in
the station. In complex stations, you can use several collision sets for detecting collisions
between several groups of objects.

After collision detection has been set up, it does not need to be started, but automatically
detects collisions according to the setup.

Setting when to check for collisions

To set whether to detect collisions always or only during simulation, follow these steps:

1. Onthe Application menu, click RobotStudio Options and under Simulation, click
Collision.

2. Inthe Perform collision detection option, select one of the following:

Option Description

During simulation Collision detection is active only during simulation (when running
RAPID programs in the virtual controller).

Always Collision detection is always active, even when moving objects
manually or testing reachability.

Setting the objects for collision detection

To set the objects for collision detection, follow these steps:
1. Make sure that the objects for collision detection are placed correctly in collision sets.

2. Make sure that the collision set for the objects is activated, which is indicated by an icon
in the Layout browser:

Icon Description
Active. Collisions between objects in this set will be detected.

o

xx0500001552

oD

xx0500001370

Not active. Collisions between objects in this set will not be detected.

To activate or deactivate collision sets, continue with the following steps:

3. Right-click the collision set to change and then click Modify Collision set to bring up a
dialog box.

4. Select or clear the Active check box and then click Apply.

Setting near-miss detection

Near-misses occur when objects in collision sets are close to colliding. Each collision set has
its own near-miss settings. For setting near-miss detection, follow these steps:

1. Inthe Layout browser, right-click the collision set to change and then click Modify
Collision set to bring up a dialog box.

2. Inthe Near miss box, specify the maximum distance between the objects to be considered
a near-miss and then click Apply.

Continues on next page
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4.2. Detecting collisions

Continued

Setting logging options
In addition to the graphical display of collisions, you can also log the collisions to the output
window or a separate log file:

1. Onthe Application menu, click RobotStudio Options and under Simulation, click
Collision.

2. Fordisplaying the collision log in the output window, select the Log collisions to Output
window check box.

3. For logging collisions to a separate file, select the Log collisions to file check box and
enter the name and path to the log file in the box below the check box.
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4.3. Creating an event

Overview

Events enhance your simulations by defining actions that are carried out when specific trigger
conditions are fulfilled. You can use events to:

< Attach one object to another, for example, a work piece to a gripper when simulating
material handling, see Attaching and detaching objects on page 56.

« Setsignals, for example, when simulating signals set by equipment other than the
controller, see Simulating 1/O signals on page 131.

« Start or stop the process timer, see Measuring process time on page 133.

Used for creating new events, the Create New Event Wizard is launched from the Event
manager, see Event Manager on page 298.

Prerequisites

Before creating the event, make sure that the station contains all signals and objects that are
planned to be used as triggers or affected by the action.
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4.4. Simulating /0O signals

4.4. Simulating 1/0O signals

Procedures
When simulating 1/0 signals you can either create events that set signal values when specified
trigger conditions are fulfilled, or you can set signal values manually.

For procedures using the event manager, see Event Manager on page 298.
For procedures using the I/0 simulator, see 1/0 Simulator on page 307.

Related information
For information about controlling 1/0 signals from the RAPID program, see Creating RAPID
instructions for setting 1/0 signals on page 103.
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4.5. Enabling simulation monitoring

Overview

The simulation monitor commands are used to visually detect critical robot movements
during simulation by drawing a colored line that follows the TCP.

To enable TCP tracing

To enable TCP tracing, follow these steps:

1.
2.
3.

On the Simulation tab, click Monitor to bring up a dialog box.
In the left pane, select the appropriate robot.

On the TCP Trace tab, select the Enable TCP Trace check box. This activates TCP
tracing for the selected robot.

Optionally, change the length and color of the trace. For detailed information, see Monitor
on page 309.

To enable simulation alerts
To enable simulation alerts, follow these steps:

1.
2.
3.

On the Simulation menu, click Monitor to bring up a dialog box.
In the left pane, select the appropriate robot.

On the Alerts tab, select the Enable Simulation Alerts check box. This activates
simulation alerts for the selected robot.

In the threshold value boxes, specify the threshold for the alerts. Setting the threshold to
0 is equivalent to disabling the alert. For detailed information, see Monitor on page 309.
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4.6. Measuring process time

4.6. Measuring process time

Overview
The process timer measures the time it takes for robots to run a simulation or move along a
path. When the timer is activated, the clock will start as soon as a process is started. If two
processes are started at the same time, the timer will not stop until the last one has stopped.

To measure the process time
To measure the process time, follow these steps:

1. On the Simulation tab, click the Clock button.
2. Play the simulation or move along path.

The timer stops when the last process has stopped. If you start another process without
having deactivated the Clock button, the timer will continue.

3. To reset the clock to zero, click the Reset Process Timer.
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5 Deployment and distribution

5.1. Copying programs

Overview

RAPID programs are normally stored in the systems that run on the virtual controllers of your
station. To copy programs to systems on other controllers, save the programs to file on the PC
and then load these files to the destination controllers. You can save either entire programs or
specific modules.

Copying a program

To copy a program from one controller to another, follow these steps:

1.

In the Offline browser, select the controller that contains the program to copy.

2. Save the program to file on the disc. For details, see Saving a program on page 322.
3.
4

If necessary, copy the files to a location that is accessible to the other controller.
For instructions on loading the program to a system on a virtual controller, a Flex-

Controller or a non-running system, see the table below.

System location Do this

Virtual controller, running See Saving a module on page 320.
in RobotStudio

FlexController Connect to the FlexController and load the program.
A non-running system Start the system in a virtual controller, then load the program,
stored on the PC see Adding a system on page 72 and Saving a module on

page 320, respectively.
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5.2. Pack & Go / Unpack & Work

Overview
The Pack & Go / Unpack & Work feature makes it possible to create a package (zip file) of
an active station that can be unpacked on another computer. The package contains all
necessary files, except media pools, but additional, option-based media pools are included.

For procedures, see Pack & Go on page 178 and Unpack & Work on page 179.
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5.3. Screen Capture

Overview
Screen capture entails two functions useful for demonstrations and training purposes:

» The screenshot function allows you to capture an image of the application, see
Screenshot on page 177.

e The recorder allows you to make a recording of your work in RobotStudio, either of
the entire GUI or just the graphics window, see Record Movie on page 310.

Prerequisites
Recording a movie requires that Windows Media Encoder (WME) 9 is installed on your
computer.
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6 Working online

6.1. Connecting a PC to the service port

NOTE!

The service port shall only be used for direct connection to a PC as described in this
procedure. It must not be connected to a LAN (Local Area Network), since it has a DHCP
server that automatically distributes IP addresses to all units connected to the LAN.

Contact your network administrator for more information.

NOTE!

The maximum number of connected network clients using robapi is:
« LAN:3
e Service: 1
* FlexPendant: 1

The total max. number of applications using robapi running on the same PC connected to one
controller has no built-in maximum; however, UAS limits the number of logged-on users to
50.

The total max. number of concurrently connected FTP clients is 4.

Ports DSQC639

The illustration below shows the two main ports on the computer unit: the Service Port and
the LAN port. Make sure the LAN (factory network) is not connected to any of the service
ports!
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A Service port on the computer unit
B LAN port on computer unit (connects to factory LAN)

Continues on next page
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Continued

Connecting a PC to the service port

Action lllustration

1. Make sure the network setting onthe PCto Refer to the system documentation for
be connected is correct. your PC, depending on the operative
system you are running.
The PC must be set to “Obtain an IP
address automatically” or set as described
in Service PC Information in the Boot

Application.
2. Use the delivered category 5 Ethernet The cable is delivered in the RobotWare
crossover boot cable with RJ45 product box.

connectors.

3. Connect the boot cable to the network port
of your PC.

xx0400000844

¢ A: network port
The placement of the network port may
vary depending on the PC model.

4. Connect the boot cable to the service port
on the computer unit.
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6.2. Network settings

Overview

This topic describes the network settings for a PC connected to a controller, which is a
prerequisite for working online.

You can connect the PC to the controller through an Ethernet network in the following ways:
« Local network connection
« Service port connection

* Remote network connection

Local network connection

You can connect your PC to the same Ethernet network that the controller is connected to.
When the PC and the controller are connected correctly and to the same subnet, the controller
will be automatically detected by RobotStudio.

The network settings for the PC depend on the network configuration. For setting up the PC,
contact the network administrator.

Service port connection

Automatic IP address

Fixed IP address

When connecting to the controller's service port, you can either obtain an IP address for the
PC automatically, or you can specify a fixed IP address.

If you are not sure how to set up the service port connection, contact the network
administrator.

The controller's service port has a DHCP server that will automatically give your PC an IP
address if it is configured for this. For detailed information see Windows help on configuring
TCP/IP.

Instead of obtaining an IP address automatically, you can also specify a fixed IP address on
the PC you connect to the controller.

Use the following settings for a fixed IP address:

Property Value
IP address 192.168.125.2
Subnet mask 255.255.255.0

For detailed information about how to set up the PC network connection, see Windows help
on configuring TCP/IP.

Continues on next page
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6.2. Network settings

Continued

NOTE!

Obtaining an IP address automatically might fail if the PC already has an IP address from
another controller or Ethernet device.

To ensure that you get a correct IP address if the PC was previously connected to an Ethernet
device, do one of the following:

« Restart the PC before connecting to the controller.

* Runthe command ipconfig /renew from the command prompt after connecting
the PC to the controller.

Remote network connection

To enable a connection to a controller on a remote subnet or over the local network, the
relevant network traffic must be allowed through any firewalls between the PC and the
controller.

The firewalls must be configured to accept the following TCP/IP traffic from the PC to the
controller:

» UDP port 5514 (unicast)
e TCP port 5515
» Passive FTP

All TCP and UPD connections to remote controllers are initiated by the PC, that is the
controller only responds on the given source port and address.

Firewall settings

The firewall settings are applicable for both the Online and Offline modes.
The following table describes the necessary firewall configurations:

Status | Name Action | Direction | Protocol | Remote | Local Remote Application
Address | Service | Service

RobMetscanHost | Allow | Out UDP/IP | Any Any 5512,5514 | robnetscanhost.exe
IRCSController Allow | In upe/ip | Any 5513 Any robnetscanhost.exe
RobComCtriServer | Allow | Out TCR/IP | Any Any 5515 robcomctriserver.exe
RobotFTP Allow | Qut TCR/IP_ | Any Any FTP(21) Any

€n0900001008

NOTE!

RobotStudio uses the current Internet Options, HTTP, and proxy settings to retrieve latest
public information on the Robotics products and activities (RobotStudio News).

Connecting to the controller

1. Make sure the PC is connected to the controller's service port and that the controller is
running.

2. On the Application menu, point to Online and then click One Click Connect.
3. Select the controller in the Online tab
4. Click Request Write access.

If the controller is in mode Then

Auto You will now get Write Access if it is available.

Manual A message box on the FlexPendant will allow you to grant
remote Write Access to RobotStudio Online.
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6.3. User Authorization

Overview

This section describes the controller's User Authorization System (UAS), which restricts
what different users are allowed to do with the robot. This is for protecting data and
functionality from unauthorized use.

The user authorization is managed by the controller, which means that the UAS settings
remain for the controller regardless of which system it is running. It also means that the UAS
settings apply to all tools for communicating with the controller, like RobotStudio Online or
the FlexPendant. The UAS settings defines the users and groups that can access the controller,
and what actions they are granted access to.

For procedures, see User Accounts on page 354.

Users

The Default user

In UAS users are accounts with which persons log on to the controller. Furthermore, the users
are added to groups to which access grants are given.

The users are defined in the controller by a user name and a password. For logging on to a
controller, the user must type in a defined user name with a correct password.

A user can either have the state activated or deactivated in the UAS. When a user is
deactivated it is not possible to log on to the controller using that account. It is the UAS
administrator that activates and deactivates the users.

All controllers have a default user named Default User, which does not have any password
and cannot be removed. Other users can be added and removed by the user having the grant
Manage UAS settings.

Groups

The Default group

In UAS, groups are defined sets of grants for accessing the controller. To the groups you then
add the users who shall have the grants defined by the group.

A good practice is to create groups that resembles the professions that work with the robots
in your organization. For example, you can create groups for administrators, programmers
and operators.

All controllers have a default group named Default Group, to which all grants are given and
to which the default user belongs. This group cannot be removed, but it can be changed by
the user having the grant Manage UAS settings.

NOTE!

There is a risk changing the group membership of the default user. If you by mistake clear the
Default User check box or any Default Group grant, you will get a warning. Make sure that
there is at least one user defined that has the grant Manage UAS settings. If the Default group
and no other group have the grant Manage UAS settings, you may lose your ability to manage
users and groups.

Continues on next page
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Continued

Grants

Controller grants

Application grants

Grants are permissions to perform actions or access data on the controller. You use the grants
by giving them to groups, to which you then add the users who shall have the grants.

Grants may be either controller grants or application grants. Depending on the actions that
you will perform, you may need several grants. For procedures, see UAS Grant Viewer on
page 359.

Controller grants are validated by the robot controller and apply to all tools and devices
accessing the controller.

Application grants are used by a specific application, for example the FlexPendant, and will
only be valid using that application. Application grants can be added by additional options
and used in customer applications.
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6.4 The System Builder

6.4.1. System Builder Overview

Overview

This section describes how you create, build, modify and copy systems to run on virtual and
real controllers. These systems may even be converted to boot media and downloaded to a
real controlller.

The system points out the robot models and options to use; it also stores configurations and
programs for the robots. Therefore, it is good practice to use a unique system for each station
even if the stations use the same basic setup. Otherwise, changes in one station may
accidently overwrite data used in another station.

About virtual and real systems

The system you run on virtual controllers can either be a real system built on real RobotWare
keys or a virtual system built on virtual keys.

When using real systems, the RobotWare keys define which options and robot models shall
be used, thus helping you to configure the system correctly. Real systems can be run both on
virtual controllers and real IRC5 controllers.

When using virtual keys, all options and robot models are available, which is useful for
evaluation purposes, but requires more configuration when creating the system. Systems built
on virtual keys can only be run on virtual controllers.

Prerequisites

Creating a system entails applying a predefined template to a station, reusing an existing
system or letting RobotStudio propose a system based on a layout.

To create a system, the following conditions must be met:
* The RobotWare media pool must be installed on your PC.

¢ You must have a RobotWare key for the system, if creating a system to run on a real
controller. The RobotWare key is a license key that determines which robot models to
use and which RobotWare options to run on the controller. The license key is delivered
with the controller.

« If you want to create a system for virtual use only, you can use a virtual key instead.
Virtual keys are generated by the wizard. When using virtual keys, you select the robot
models and options to use in the Modify Options section of the wizard.

< Downloading to the real controller requires a direct connection from your computer to
the service or Ethernet port of the controller.

Continues on next page
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Continued

Administering systems
Systems can be administered from the System Builder dialog box in the following ways:

« View system properties, see Viewing system properties on page 147.

e Build a system, see Building a new system on page 148.

« Modify or delete a system, see Modifying a system on page 152.

« Copy a system, see Copying a system on page 156.

« Create a system from backup, see Creating a system from backup on page 157.

« Download a system to a controller, see Downloading a system to a controller on page
158.

« Create boot media, see Creating boot media on page 159.
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6.4.2. Viewing system properties

Overview
All systems you create with the System Builder are stored locally on your computer. It is
recommended that you store them in one or more dedicated system directories.

Viewing system properties
To view system properties and add comments, follow these steps:
1. Inthe System Builder dialog box, select a system from the Systems box.

If necessary, in the System directory list, you can navigate to the folder in which your
systems are stored

2. The system properties are then displayed in the System Properties box. Optionally, type
a comment in the Comments box, and click Save.
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6.4.3. Building a new system

Overview

The New Controller System Wizard, used for building a new system, is launched from the
System Builder.

Starting the wizard

To start the wizard, follow these steps:

1. Click System Builder to bring up a dialog box.

2. Inthe Actions group, click Create New. This starts the wizard.
3. Read the information on the welcome page and click Next.

Specifying the name and location

To determine where on your computer to store the system you are creating, follow these steps:

1. Inthe Name box, enter a name for the system you are creating.

2. Inthe Path box, enter the path to the system directory in which you will store the system.
You can also click the Browse button and browse to the system directory.

3. Click Next.

Entering the RobotWare keys

The RobotWare keys determine which RobotWare versions and parts to use in the system.

Creating a system to run on either IRC5 controllers or virtual controllers requires at least two
keys: one for the controller module and one for each drive module in the cabinet. The keys
are delivered together with the controller.

For creating a system to run on virtual controller only (for example, in Virtual IRC5), you can

use virtual keys. Virtual keys give access to all options and robot models, but limits the use

of the system to virtual controllers only.

To enter the key for the controller module, follow these steps:

1. Inthe Controller Key box, enter the controller key. You can also click Browse and
browse to the key file. If creating a system for virtual use only, select the Virtual Key
check box, and the controller key will be generated by the wizard.

2. In the Media Pool box, enter the path to the media pool. You can also click Browse and
browse to the folder.system

3. Inthe RobotWare Version list, select which version of the RobotWare you want to use.
Only RobotWare versions that are valid for the used key are available.

4, Click Next.

Continues on next page
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6.4.3. Building a new system

Continued

Entering the drive keys

To enter the keys for the drive modules:

1.

In the Drive Key box, enter the key for the drive module. You can also click the Browse
button and browse to the key file. If you used a virtual controller key, a virtual drive key
is already generated by the wizard.

Click the right arrow button next to the Drive Key box. The key now appears in the
Added drive key list.

For real systems the drive key determines the connected robot model. For virtual systems
you select the robot model in the Modify Options page. The default model is IRB140.

If you have a MultiMove system, repeat steps 1 and 2 for each drive key to add.

If you have a MultiMove system, make sure that the keys are numbered in the same way
as their corresponding drive modules are connected to the controller module. Use the up
and down arrows to rearrange the drive keys, if necessary.

Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to modify options, or add options, parameter data or additional files to the
home directory, click Next.

Adding additional options
Here you can add options, such as external axes and dispense applications, that are not
included in the basic system. Options require a license key and must be first imported to the
media pool. To add additional options, follow these steps:

1.

In the Key box, enter the option key. You can also click the Browse button and browse
to the option’'s key file.

Click the Arrow button.
The option that the key unlocks is now displayed in the Added Options list.

NOTE!

If several versions of an additional option exists, only the latest version can be selected.
To use an older version, remove the other versions of the additional option from the
Mediapool.

Repeat steps 1 and 2 for all options you want to include.
Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to modify options, or add parameter data or additional files to the home
directory, click Next.

Continues on next page
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Continued

Modifying options
Here you can set up and configure the options in your system. For virtual systems, you also
select the robot models to use. To modify any options, follow these steps:

1. Inthe Option tree, expand the option folders to the level where you find the option you
want to modify.

Only the options unlocked by the used keys are available.

2. Modify the option.

3. Repeat steps 1 and 2 for all options you want to modify.

4. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to add parameter data or additional files to the home directory, click Next.

Adding parameter data
Parameter data is stored in the parameter data files (.cfg files). Each parameter topic has its
own parameter file. You can add only one parameter file for each topic. To add parameter
data, follow these steps:

1. Inthe Parameter data box, enter the path to the folder for the parameter data files. You
can also click the Browse button and browse to the folder.

2. Inthe list of parameter data files, select the file you want to include and press the Arrow
button. Repeat for all files you want to include.

The included parameter data files will now appear in the Added parameter data files list.
Repeat steps 1 and 2 for each parameter data file you want to add.

3. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to add additional files to the home directory, click Next.

Adding files to the home directory
You can add any type of file to the system’s home directory. When the system is loaded to a
controller, these files will also be loaded. To add files to the system's home directory, follow
these steps:

1. Inthe Files box, enter the path to the folder for the files you want to include. You can also
click the Browse button and browse to the folder.

2. Inthe list of files, select the file to add and click the Arrow button. Repeat for all files you
want to add.

The added files will now appear in the Added files list.
3. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to read a summary before you create the system, click Next.

Continues on next page
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Continued

Completing the New Controller System Wizard
To complete the wizard, follow these steps:

1. Read the system summary.
2. If the system is OK, click Finish.

If the system is not OK, click Back and make modifications or corrections.
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6.4.4. Modifying a system

Overview

The Modify Controller System Wizard, used to modify existing systems, is launched from
the System Builder. The wizard helps you with tasks like changing robots, adding and
removing external axes and other options. A system that is running must be first shut down
before modification.

Starting the wizard

To start the wizard when creating a new station:

1.

If the system is currently running, on the Controller menu, point to Shutdown and then
click Shutdown.

On the Controller menu, click System Builder to bring up a dialog box.

In the System directory list, enter or browse to the system directory. Select a system from
the list beneath, review the system properties and add and save any comments.

In the Actions group, click Modify. This starts the wizard.
Read the information on the welcome page and click Next.

Modifying the program revision
The RobotWare versions that are available for the system are determined by the controller
key. The key is essential to the system and cannot be modified.

To use another RobotWare version than the available ones, create a new system with another
key.

To optionally modify the program revision, follow the appropriate step or steps:

1.
2.
3.

To keep the current RobotWare version, select Yes and then click Next .
To replace the current RobotWare version, Select No, replace it..

In the Media pool box, enter the path to the media pool. You can also click the Browse
button and browse to the folder.

In the New program revision box, select which version of RobotWare you want to use.
Only RobotWare versions that are valid for the RobotWare key are available.

Click Next.

Continues on next page
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6.4.4. Modifying a system

Continued

Adding or removing drive keys
The drive key corresponds to the drive modules in your controller. For MultiMove systems,
you have one drive module (and one key) for each robot. The keys for your system are
delivered together with the controller.

the system is created with a vritual controller key, virtual drive keys are generated by the
wizard. when you have added one virtual drive key for each robot, you select which robot to
use for each key on the Modify Options page.

To optionally add or remove the keys for the drive modules, follow these steps:

1.

To add a key for a drive module, enter the key in the Enter Drive Key box. You can also
click the Browse button and browse to the key file.

Click the right arrow button. The key now appears in the Added drive key list.
If you have a MultiMove system, repeat steps 1 and 2 for each drive key to add.

To remove a drive module, select the corresponding key in the Added drive key list and
click Remove drive key.

If you have a MultiMove system, repeat step 3 for each drive key to remove.

If you have a MultiMove system, make sure that the keys are numbered in the same way
as their corresponding drive modules are connected to the controller module. Use the up
and down arrows to rearrange the drive keys, if necessary.

Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to modify options, parameter data or add files to or remove files from the
home directory, click Next.

Adding or removing additional options
To optionally add or remove additional options:

1.

To add an addtional option, in the Enter Key box, enter the option key. You can also click
the Browse button and browse to the option's key file.

Click the Arrow button.
The option that the key unlocks is now displayed in the Added Options list.

NOTE!

If several versions of an additional option exists, only the latest version can be selected.
To use an older version, remove the other versions of the additional option from the
Mediapool.

Repeat steps 1 and 2 for all options you want to include.

To remove an additional option, iln the Added options list, select the option you want to
remove.

Continues on next page

3HAC032104-001 Revision: D 153



6 Working online

6.4.4. Modifying a system

Continued

5. Click Remove.
6. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to modify parameter data or add files to or remove files from the home
directory, click Next.

Modifying options
To optionally modify any options, follow these steps:

1. Inthe Option tree, expand the option folders to the level where you find the option you
want to modify.

Only the options unlocked by the used keys are available.

2. Modify the option.

3. Repeat steps 1 and 2 for all options you want to modify.

4. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to modify parameter data or add files to or remove files from the home
directory, click Next.

Adding or removing parameter data
Parameter data is stored in the parameter data files (.cfg files). each parameter topic has its
own parameter file. You can add only one parameter file for each topic. To addor remove
parameter data, follow these steps:

1. To add parameter data, in the Parameter data box, enter the path to the folder for the
parameter data files. You can also click the Browse button and browse to the folder.

2. Inthe list of parameter data files, select the file you want to include and press the Arrow
button. Repeat for all files you want to include.

The included parameter data files will now appear in the Added parameter data files list.
Repeat steps 1 and 2 for each parameter data file you want to add.

3. Toremove parameter data, in the Added parameter data files list, select the parameter
data file to remove.

4. Click Remove.
5. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.

If you want to add to or remove files from the home directory, click Next.

Continues on next page
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6.4.4. Modifying a system

Continued

Add files to or remove files from the home directory

You can add any type of file to the system’s home directory, or remove files from it. When
the system is loaded to a controller, these files will also be loaded. To optionally add files to
or remove files from the system's home directory, follow these steps:

1. To add files, in the Files box, enter the path to the folder for the files you want to include.
You can also click the Browse button and browse to the folder.

2. Inthe list of files, select the file to add and click the Arrow button. Repeat for all files you
want to add.

The added files will now appear in the Added files list.

3. To remove files, in the Added files list, select the file to remove.

4. Click Remove.

5. Choose whether you want to create the system as it is now, or to continue with the wizard.
If you want to create the system as it is now, click Finish.
If you want to read a summary before you create the system, click Next.

Complete the Modify Controller System wizard

To complete the wizard, follow these steps:
1. Read the system summary.
2. If the system is OK, click Finish.
If the system is not OK, click Back and make modifications or corrections.

Result

Modifications will take effect when the wizard is completed.

If the system has been downloaded to a controller, it must be downloaded again before the
modifications will take effect on the controller.

Deleting a system

To delete a system, follow this steps:

1. From the System Builder dialog box, select the system and then click Delete.
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6.4.5. Copying a system

Copy a system
To copy a system, follow these steps:

1. From the System Builder dialog box, select the system and then click Copy to bring up
a dialog box.

2. Enter a name for the new system and a path, and then click OK.

156 3HAC032104-001 Revision: D

© Copyright 2008-2010 ABB. All rights reserved.



© Copyright 2008-2010 ABB. All rights reserved.

6 Working online

6.4.6. Creating a system from backup

6.4.6. Creating a system from backup

Overview
The Create System from Backup Wizard, which creates a new system from a controller
system backup, is launched form the System Builder. In addition, you can change the program
revision and options.

Starting the wizard
To start the wizard, follow these steps:

1. From the System Builder dialog box, click Create from Backup. This starts the wizard.
2. Read the information on the welcome page and click Next.

Specifying the name and location
To specify the destination folder, follow these steps:

1. Inthe Name box, enter a name for the system you are creating.

2. Inthe Path box, enter the path to the system directory in which you will store the system.
You can also click the Browse button and browse to the system directory.

3. Click Next.

Locating the backup
To locate a system from backup, follow these steps:
1. Inthe Backup folder box, enter the path to the backup folder. Alternatively, click the
Browse button to browse to it. Click Next.
2. In the Media Pool box, enter the path to the media pool containing the appropriate

RobotWare program. Confirm the backup information that now appears in the wizard.
Click Next.
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6.4.7. Downloading a system to a controller

Overview

All systems you access from the System Builder are stored on your computer. If you wish to
run a system on a robot controller, you must first load it to the controller, which then requires
a restart.

Load a system

To load a system to a controller, follow these steps:

1. From the System Builder dialog box, select a system and then click Download to
Controller to bring up a dialog box.

2. Specify the Destination Controller for the system.

You can select by using the... if...

Select controller from list option the controller has been detected automati-
cally.

Specify IP address or controller name your PC and the robot is connected to the

option same network.

You can only use the controller name in
DHCP networks.

Use service port option your PC is directly connected to the control-
ler's service port.

3. Optionally, click Test Connection to confirm that the connection between the computer
and the Controller is OK.

4. Click Load.

5. Answer Yes to the question Do you want to restart the controller now?

Yes The controller restarts immediately and the downloaded system starts
automatically.
No The controller does not restart immediately.
To start using the downloaded system, you have to:
1. perform a C-start or an X-start
2. select the system manually

Cancel The downloaded system is removed from the controller.
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6.4.8. Creating boot media

Overview
Boot media is an entire system which the System Builder packs to a single file and commonly
stores on a hard disk or USB memory. The controller then accesses the file through its
Ethernet port or USB port, respectively.

Creating boot media
To create boot media, follow these steps:

1. From the System Builder dialog box, select a system and then click Boot Media.

2. In the Path box, enter the path to the folder where you want to store the boot media file.
Alternatively, browse to the location.

3. Click OK.

Result
To load the boot media system to a controller, first connect it and then restart the controller
with the advanced restart method X-start.
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6.4.9. Examples using the System Builder Offline

6.4.9.1. A MultiMove system with two coordinated robots

Overview
In this example we will use the System Builder to create a coordinated offline system with
one IRB2400 and one IRB1600 robot to use in a new RobotStudio station.

Starting the New Controller System Wizard
To create a system like the one described above, follow these steps:

1. Click System Builder to bring up the dialog box.
2. Inthe dialog box, click Create New to bring up the New Controller System Wizard.
3. Read the welcome text, and click Next to continue to the next page.

Entering the name and path
1. Inthe Name box, enter the name of the system. The name must not contain blank spaces
or non-ASCII characters.

In this example, name the system MyMultiMove.

2. In the Path box, enter the path for the folder to save the system in, or click the Browse
button to browse to the folder or create a new one.

In this example, save the system in C:\Program Files\ABB Industrial IT\Robotics
IT\RobotStudio\ABB Library\Training Systems.

3. Click Next to continue to the next page.

Entering the controller key
1. Select the Virtual key check box. A virtual controller key now appears in the Controller
Key box. In this example we will use the default media pool and RobotWare version.

2. Click Next to continue to the next page.

Entering drive keys
1. Click the Right Arrow button next to the Enter Drive key box twice to create one drive
key for each robot.

2. Click Next to continue to the next page.

Continues on next page
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6.4.9.1. A MultiMove system with two coordinated robots

Continued

Adding options

This system does not require any additional option keys. Click Next and continue to the
next page of the wizard.

Modifying options

When creating robot systems from real robot keys, the key sets the options. But since we are
using a virtual key, we have to set the options manually.

To set the options necessary for a MultiMove, follow these steps:

1.

Scroll down to the RobotWare / Motion Coordination 1 group and select the
MultiMove Coordinated check box.

Scroll down to the RobotWare / 1/0 control group and select the Multitasking and the
Advanced RAPID check boxes.

Scroll down to the DriveModulel / Drive module application group and expand the
ABB Standard manipulator option. Select the IRB 2400 Type A option, manipulator
variant IRB 2400L Type A.

Scroll down to the DriveModule2 / Drive module application group and expand the
ABB Standard manipulator option. Select the IRB 1600 option, manipulator variant
IRB 1600-5/1.2.

Click Finish and the system will be created.
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6.4.9.2. A system with support for one robot and one positioner external axis

Overview

In this example we will use the System Builder to create an offline system to use in a new
RobotStudio station with one IRB1600 robot and one IRBP 250D positioner external axis.

Prerequisites
When creating systems for positioner external axes, you need the media pool and the license
key file for that specific positioner. In this example we will use a media pool and license key
file for a demo positioner.
Paths to files and folders assume that RobotStudio and the RobotWare media pool have been
installed at their default locations on Windows XP. If not, adjust the paths accordingly.

Starting the New Controller System Wizard
To create a system like the one described above, follow these steps:

1. Click System Builder to bring up a dialog box.
2. Inthe dialog box, click Create New to bring up the New Controller System Wizard.

3. Read the welcome text, and click Next to continue to the next page.

Entering the controller key
1. Select the Virtual key check box. A virtual controller key now appears in the Controller
Key box. In this example we will use the default media pool and RobotWare version.

2. Click Next to continue to the next page.

Entering drive keys
1. Click the Right Arrow button next to the Enter Drive key box to create one drive key
for the robot.

2. Click Next to continue to the next page.

Adding options
This is where we point out the key file for the positioner.
1. Next to the Enter key box, click the browse button and select the key file.

In this example, browse to and select the file extkey.kxt in the folder C:\Program
Files\ABB Industrial IT\Robotics IT\MediaPool\3HEA-000-00022.01.

¥

TIP!

In the MediaPool folder media pools for several standard positioners are installed. They
are named by the positioner’s article number, with a suffix that indicates if it is configured
for single-robot or MultiMove systems.

2. Click the Right Arrow button next to the Enter key box to add the key for the positioner.
3. Click Next and continue to the next page of the wizard.

Continues on next page
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6.4.9.2. A system with support for one robot and one positioner external axis

Continued

Modifying options

When creating robot systems from real robot keys, the key sets the options. But since we are
using a virtual key, we have to set the options manually. To set the options necessary for a
positioner, follow these steps:

1. Scroll down to the RobotWare / Hardware group and select the 709-x DeviceNet check

box.
This option is for the communication between the controller and the track external axis.

. Scroll down to the DriveModulel / Drive module application group and expand the

ABB Standard manipulator option. Select the IRB 1600 option.
This option sets the robot to an IRB 1600-5/1.2.

. Scroll down to the DriveModulel > Drive module configuration group; select the Drive

System 04 1600/2400/260 option; expand the Additional axes drive module group and
select the R2C2 Add drive option.

1. Expand the Drive type in position Z4 group and select the 753-1 Drive C in pos Z4
option

2. Expand the Drive type in position Y4 group and select the754-1 Drive C in pos Y4
option

3. Expand the Drive type in position X4 group and select the755-1 Drive C in pos X4
option

This option adds drive modules for the positioner axes.

NOTE!

When using the latest drive system, do the following:

Scroll down to the DriveModulel > Drive module configuration group; select the Drive
System 09 120/140/1400/1600 Compact option; expand the Power supply
configuration group and select 1-Phase Power supply or 3-Phase Power supply (as
applicable) > Additional axes drive module > Additional drive

1. Expand the Drive type in position X3 group and select the Drive ADU-790A in
position X3 option

2. Expand the Drive type in position Y3 group and select the Drive ADU-790A in
position Y3 option

3. Expand the Drive type in position Z3 group and select the Drive ADU-790A in
position Z3 option

. Click Finish and the system will be created. When starting the system in a RobotStudio

station, you have to set up the system to load a model for the positioner and to get the
motions to work properly. See Placing external axes on page 86 for more information.
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6.4.9.3. Options settings for systems with positioners

Overview
This is an overview of the RobotWare options to set when creating a system for positioner
external axes. Note that besides setting the RobotWare options, you must add an additonal
option key for the positioner.

Media pools and option keys for the positioners
If you have the media pool and option key for your positioner, you can use these files.

If not, media pools for standard positioners are installed with RobotStudio. The path to these
media pools in a default installation is: C.\program files\ABB Industrial IT\Robotics
IT\MediaPool. In this folder a media pool for each positioner is located. These are named by
the article number of the positioner, with a suffix that indicates if it is configured for a single-
robot or a MultiMove system.

In the Add additional options page of the System Builder, you should add the option for the

positioner by opening the mediapool folder for the positioner to add and selecting the
extkey.kxt file.

Options for positioners in single-robot systems
When adding a positioner to a single-robot system, the positioner will be added to the same
task as the robot. Below, the options to set on the Modify Options page of the System
Builder for such a system are listed:
* RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single

« Optionally, for using the system with ArcWare also add RobotWare > Application
arc > 633-1 Arc

» DriveModule 1 > Drive module configuration > Drive System 04 1600/2400/260 >
RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive T in pos Y4 > 755-3
Drive U in pos X4

Options for positioners in MultiMove robot systems
When adding a positioner to a MultiMove robot system, the positioner shall be added to a task
of its own (thus you also have to add a drive key for the positioner). Below, the options to set
on the Modify Options page of the System Builder for such a system are listed:
¢ RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single

* RobotWare > Motion coordinated part 1 > 604-1 MultiMove Coordinated
Optionally, expand the MultiMove Coordinated option and select process options for
the robots.

e Optionally, for using the system with ArcWare, add RobotWare > Application Arc
> 633-1 Arc

e DriveModule 1 > Drive module configuration > Drive System 04 1600/2400/260
> RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive T in pos Y4 > 755-3
Drive U in pos X4. For the other drive modules, no additional axes should be
configured.
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6.5. Handle 1/0

Overview

The 1/0 system handles input and output signals to and from the controller. Below are the
parts of the system described, as well as common types of signals.

The I/O system window is used to view and set previously configured signals, and to activate
and deactivate 1/0 units.

The I/O system

The 1/0 system of a controller consists of 1/0O buses, 1/0 units and 1/0 signals. The 1/O buses
are the controller's connections for I/O units (for instance 1/0 boards) and the 1/0 units
contain channels for the actual signals.

The 1/0 buses and units are displayed in the robot view, as child nodes under each controller
and the 1/0 signals are displayed in the 1/0 window.

I/O signals

1/0 signals are used to communicate between the controller and external equipment, or to
change variables within a robot program.

Input signals

Input signals notify something for the controller, for instance a feeder belt can set an input
signal when it has positioned a work piece. The input signal can then be programmed to start
a specific part of the robot program.

Output signals

The controller uses output signals to notify that a specified condition has been fulfilled. For
instance, after the robot has finished its sequence, an output signal can be set. This signal can
then be programmed to start a feeder belt, update a counter or trigger any other action.

Simulated signals

A simulated signal is a signal that is manually given a specific value that overrides the actual
signal. Thus simulated signals might be useful for testing robot programs without activating
or running equipment.

Virtual signals

Virtual signals are signals that are not configured to belong to a physical 1/0 unit. Instead,
they reside inside the controller's memory. A common use for virtual signals is to set variables
and store changes in a robot program.

Procedures

For using the 1/0 system window, see Inputs / Outputs on page 326.
For adding a signal, see Add Signals on page 337.
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6.6. Configure systems

Configuring system parameters

System parameters may be configured as follows:

« To view topics, types, instances and parameters

« To edit the parameters of an instance

* To copy and paste instances

* To add and delete instances

« To load and save complete configuration files to and from controllers

When working with configurations, the following tools, see Configuration editor on page

334, are useful:
Tool

The Configuration
Editor

The Instance Editor

Use

With the Configuration Editor you work with the types and instances of
a specific topic.

With the Instance Editor, you specify the values of the parameters in
the instances of system parameter types.

NOTE!
ﬂ To edit system parameters, you must have write access to the controller.

Terms

System parameters

Topic

Type

Instance

Parameter

Configuration file

The sum of all parameters that configure the system, these are divided
into topics and types.

A collection of parameters relating to a specific area, and the highest
level in the system parameter structure. Examples are Controller,
Communication and Motion.

A set of parameters for a specific configuration task. A type can be
seen as a pattern describing the construction and properties for the
parameters included in the task. For instance, the type Motion System
defines which parameters shall be used for configuring a motion
system.

An actualization of a type, an instance is a specific set of parameters
with unique values created from a type pattern. In the Configuration
Editor, each row in the Instance list is an instance of the type selected
in the Type list.

A property to set when configuring the robot system.

Contains all public parameters of a specific topic.

Continues on next page
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6.6. Configure systems

Continued

Viewing configurations
1.

To view the topics of a controller, from the Offline/Online tab, expand the Configuration
node for the controller.

All topics in are now displayed as child nodes to the Configuration node.

. To view the types and instances of a topic, double-click the topic node for the topic to

view.

The Configuration Editor is now opened, listing all types of the topic in the Type name
list. In the Instance list, each instance of the type selected in the Type name list is
displayed as row. The parameter values of the instances are displayed in the columns of
the instance list.

To view detailed parameter information for an instance, double-click the instance.

The instance editor now displays the current value, restrictions and limits of each
parameter in the instance.

Editing parameters

You can either edit the parameters of one single instance, or you can edit several instances at
one time. Editing several instances at one time is useful when you want to change the same
parameter in several instances, like when moving signals from one 1/O unit to another.

1.

In the Offline/Online tab, expand the Controller and the Configuration node and
double-click the topic that contains the parameters to edit.

This opens the Configuration Editor.

Inthe Type name list of the Configuration Editor, select the type that the parameter to edit
belongs to.

The instances of the type is now displayed in the Instance list of the Configuration Editor.

In the Instance list, select the instances to edit and press the Enter Key. To select several
instances at once, hold down the SHIFT or CTRL key while selecting.

The Instance Editor is now displayed.

In the Parameter list of the Instance Editor, select the parameter to edit and change the
value of the parameter in the Value box.

When editing several instances at one time, the parameter values you specify will be
applied to all instances. For parameters that you do not specify any new value, each
instance will keep its existing value for that parameter.

Click OK to apply the changes to the configuration database of the controller.

For many parameters, the changes will not take affect until the controller is restarted. If
your changes require a restart, you will be notified of this.

You have now updated the controller's system parameters. If the changes require a restart
of the controller, the changes will not take affect until you do this. If you are going to make
several changes, you can wait with the restart until all changes are done.

Continues on next page
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Continued

Adding instances

With the Configuration Editor, you can select a type and create a new instance of it. For
example, adding a new instance of the type Signal creates a new signal in the system.

1. Inthe Offline/Online tab, expand the Controller and the Configuration node and
double-click the topic that contains the type of which you want to add an instance.

This opens the Configuration Editor.

2. Inthe Type name list of the Configuration Editor, select the type of which you want to
add an instance.

3. On the Controller menu, point to Configuration and click Add type (the word type is
replaced by the type you selected previously).

You can also right-click anywhere in the configuration editor and then select Add type
from the shortcut menu.

A new instance with default values is added and displayed in the Instance Editor
window.

4. If required, edit the values.
5. Click OK to save the new instance.

The values in the new instance are now validated. If the values are valid, the instance is
saved. Otherwise, you will be notified of which parameter values to correct.

For many instances, the changes will not take affect until the controller is restarted. If your
changes require a restart you will be notified of this.

You have now updated the controller's system parameters. If the changes require a restart
of the controller, the changes will not take affect until you do this. If you are going to make
several changes, you can wait with the restart until all changes are done.

Copying an instance

1. Inthe Offline/Online tab, expand the Controller and the Configuration node and
double-click the topic that contains the instance to copy.

This opens the Configuration Editor.

2. Inthe Type name list of the Configuration Editor, select the type of which you want to
copy an instance.

3. Inthe Instance list, select one or several instances to copy.

If you select several instances and they don't have the same value for all parameters, these
parameters will have no default values in the new instances.

4. Onthe Controller menu, point to Configuration and click Copy Type (the word type is
replaced by the type you selected previously).

You can also right-click the instance to copy and then select Copy Type from the shortcut
menu.

A new instance with the same values as the one you copied is added and displayed in the
Instance Editor window.

Continues on next page

168

3HAC032104-001 Revision: D

© Copyright 2008-2010 ABB. All rights reserved.



© Copyright 2008-2010 ABB. All rights reserved.

6 Working online
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6.

6.6. Configure systems

Continued

Change the name of the instance. If required, also edit the other values.
Click OK to save the new instance.

The values in the new instance are now validated. If the values are valid, the instance is
saved. Otherwise, you will be notified of which parameter values to correct.

For many instances, the changes will not take affect until the controller is restarted. If your
changes require a restart you will be notified of this.

You have now updated the controller's system parameters. If the changes require a restart
of the controller, the changes will not take affect until you do this. If you are going to make
several changes, you can wait with the restart until all changes are done.

Deleting an instance

1.

In the Offline/Online tab, expand the Controller and the Configuration node and
double-click the topic that contains the type of which you want to delete an instance.

This opens the Configuration Editor.

In the Type name list of the Configuration Editor, select the type of which you want to
delete an instance.

In the Instance list, select the instance to delete.

On the Controller menu, point to Configuration and then click Delete type (the word
type is replaced by the type you selected previously).

You can also right-click the instance to delete and then select Delete type from the
shortcut menu.

A message box is displayed, asking if you want to delete or keep the instance. Click Yes
to confirm that you want to delete it.

For many instances, the changes will not take affect until the controller is restarted. If your
changes require a restart you will be notified of this.

You have now updated the controller's system parameters. If the changes require a restart
of the controller, the changes will not take affect until you do this. If you are going to make
several changes, you can wait with the restart until all changes are done.

Save one configuration file
The system parameters of a configuration topic can be saved to a configuration file, stored on
the PC or any of its network drives.

The configuration files can then be loaded into a controller. They are thereby useful as
backups, or for transferring configurations from one controller to another.

1.

In the Offline/Online tab, expand the Configuration node and select the topic to save to
afile.

On the Controller menu, point to Configuration and select Save System Parameters.

You can also right-click the topic and then select Save System Parameters from the
shortcut menu.

In the Save As dialog box, browse for the folder to save the file in.
Click Save.

Continues on next page
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Continued

Saving several configuration files

1
2.

In the Offline/Online tab, select the Configuration node.
On the Controller menu, point to Configuration and click Save System Parameters.
You can also right-click the configuration node and then click Save System Parameters.

In the Save System Parameters dialog box, select the topics to save to files. Then click
Save.

In the Browse for Folder dialog box, browse for the folder to save the files in, and then
click OK.

The selected topics will now be saved as configuration files with default names in the
specified folder.

Loading a configuration file
A configuration file contains the system parameters of a configuration topic. They are thereby
useful as backups, or for transferring configurations from one controller to another.

When loading a configuration file to a controller, it must be of the same major version as the
controller. For instance, you cannot load configuration files from an S4 system to an IRC 5
controller.

1.
2.

In the Offline/Online tab, select the Configuration node.
On the Controller menu, point to Configuration and select Load Parameters.

You can also right-click the configuration node and then select Load Parameters from
the context menu.

This opens the Select mode dialog box.

In the Select mode dialog box, select how you want to combine the parameters in the
configuration file to load with the existing parameters:

If you want to then

replace the entire configuration of the topic  select Delete existing parameters before
with the one in the configuration file. loading

add new parameters from the configuration click Load parameters if no duplicates
file to the topic, without modifying the existing
ones.

add new parameters from the configuration click Load parameters and replace
file to the topic and update the existing ones duplicates

with values from the configuration file.

Parameters that only exist in the controller

and not in the configuration file will not be

changed at all.

4.

Click Open and browse to the configuration file to load. Then click Open again.

In the information box, click OK to confirm that you want to load the parameters from
the configuration file.

When the loading of the configuration file is finished, close the Select mode dialog box.

If a restart of the controller is necessary for the new parameters to take affect, you will be
notified of this.
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6.7. Handle events

6.7. Handle events

Overview

An event is a message that notifies you that something has happened to the robot system, be
it merely a change in operation mode or a severe error that calls for your immediate attention.
If the event requires any action from you, this is stated in the event.

Events are displayed in the event logs of the FlexPendant and RobotStudio.

The event log keeps you informed of system status, allowing you to:

* view controller events.

o filter events.

e sort events.

» get detailed information about an event.

« save event log files on your PC.

« clear event records.

Event Log list

The event log list consists of all events matching your filter settings, with the following
information for each event:

Type The event type is an indication of the severity of the event.

Code The event code is a number that identifies the event message.

Title The event title is a short event description.

Category The event category is an indication of the source of the event.

Seq. Number The sequential number indicates the chronological order of the event.
Date and Time Date and time is when the event occurred.

When you select an event in the list, detailed information will appear to the right.

Event type

The event type is an indication of the severity of the event.

There are three types of events:

Eventtype

Information

Warning

Error

Description

A normal system event, such as starting and stopping programs, change of
operating mode, motors on/off and so on.

Information messages never require any action from you, but can be useful for
error tracking, statistics collecting or monitoring user triggered event routines.

An event that you need to be aware of, but not so severe that the process or
RAPID program needs to be stopped. Warnings, however, often indicate
underlying problems that sooner or later must be solved.

Warnings must sometimes be acknowledged.
An event that prevents the robot system from proceeding. The running
process or RAPID program cannot continue, but is stopped.

All errors must be acknowledged. Most errors also require some immediate
action from you in order to solve the problem.

Continues on next page
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6.7. Handle events

Continued
NOTE!

H This information is also indicated by color: blue for information, yellow for warning and red
for an error which needs to be corrected in order to proceed

Event code
The event code is a number that identifies the event message. Together with the event date
and time each event has a unique identity.

Event title

The event title is a short description of the event.

Event category

The category is an indication of the source of the event.

Category

Common
Operational
System
Hardware

Program

Motion

1/0 & Communica-
tion

User
Internal
Process

Cfg

Display

All recent events.

Events related to changes in operation or operating mode.
Events related to the current system.

Events related to controller hardware.

Events related to the running process applications and RAPID
programs.

Events related to the movement of robots or other mechanical units .

Events related to input and output signals, serial or network communi-
cation and process buses.

Custom messages that have been programed into RAPID programs.
Internal low-level controller errors for ABB service personnel.

Events related to Industrial Processes options., such as Spot, Arc and
Dispense.

Errors in a configuration file.

Depending on how the system is configured, additional categories may exist.

Sequential number

The sequential number indicates the chronological order of the event; the higher the number
the more recently the event occurred.

Date and time

Date and time indicate exactly when the event occurred. Along with the event code, this
timestamp guarantees that each event has a unique identity.

Event description

When you select an event in the list, detailed information about it will be displayed to the
right. This includes a description, and when appropritate also consequences, causes and
suggested actions to solve the problem.

Continues on next page
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6.7. Handle events

Continued

Overview
The Event Log automatically logs all controller events once it is started. By default, events
are displayed in the chronological order specified by Seq Numbers.
NOTE!

ﬂ Any modifications to the list you see will never affect the event log of the controller. What

you see is just a copy.

Managing events
1. Inthe Robot View Explorer, select a system.

2. Double-click the Events node.

To sort events Click the header for the column you want to sort by. To switch
between ascending and descending sorting, click the header
once again.

To filter events In the Category list select the event category you want
displayed.

To clear the event log Click Clear.

This will not affect the event log of the robot controller. It might
still be impossible, however, to retrieve all events from a cleared
record once again, as the oldest ones may have been erased
from the controller hard disk due to lack of space. It is therefore
recommended to save the record to a log file before clearing.

To save all events to a Check the Log to file check box.
single log file on the If it remains checked, the log file will be updated with new events
computer as they occur.

To save events of one or  Click Save and then make your category choice. Specify the
several categories to files  location for the log file(s) in the Browse For Folder dialog and
on the computer then click OK.
If you select All when selecting categories, a log file for each
event category will be created.

Retrieving controller events
To clear the list and retrieve all existing events from the robot controller:

1. Optionally, save the existing Event Log record.

2. Select whether you want the list to be updated when new events occur , or if you are only
interested in viewing events that have already occurred.

To ... ...then...

get automatic updates when new check the Auto Update check box. (Checked by
events occur default.)

say no to automatic updates when  clear the Auto Update check box.
new events occur

3. Click Get to clear the current list, fetch and display all events that are currently stored in
the controller log files.
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6.8. RAPID Watch Online

Overview

The RAPID Watch Online window displays the variable status during the program execution.

It has the following tabs:

Tab
Name
Value

Type
Source

On the RAPID Watch Online window, right-click to display the following context menu:

Iltem

Cut

Copy

Paste

Delete Watch
Select All
Clear All
Refresh

NOTE!

Description

Displays variable name
Displays variable value
Displays type of datatype
Displays system name

Description

Cuts the variable value
Copies the variable value
Pastes the variable value
Deletes the watch item
Selects all the variable value
Clears all the variable value
Updates the variable value

When running a program in continuos execution mode, the contents of RAPID Watch Online

window does not update until program execution stops.

To manually refresh the variable values, click Refresh from the context menu.
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7 The Application Menu

7.1. Overview

7 The Application Menu

7.1. Overview

Overview

The Application menu is accessed from the RobotStudio button in the upper left corner of the
GUL.
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7.2. New Station

7.2. New Station

Creating a station with a template system

1.

Click New Station to bring up a dialog box.
The Template System icon is already selected by default.

In the Select Template System list, either select an appropriate template or click Browse
and browse to one.

In the System group, enter a name and location, and then click OK.

Creating a station with an existing system

1.

Click New Station to bring up a dialog box.

2. Click the Existing system icon to bring up the Existing System dialog box.
3. Inthe Select System Pool list, select a folder.

4,

5. Click OK.

In the Systems Found list, select a system.

Creating an empty station

1
2.

Click New Station to bring up a dialog box.

Click the Empty Station icon. The station will be created and visible in the graphics
window.
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7 The Application Menu

7.3. Screenshot

7.3. Screenshot

Prerequisites
For optimal results, first configure the options, see Options:General:Screenshot on page 183.

Capturing the screen
1. Click Screenshot.

If the image is saved to file, this is reported in the output window.
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7.4. Pack & Go

7.4. Pack & Go

Packing a station

. Click Pack & Go to open the Pack & Go Wizard.
. On the Welcome to the Pack & Go Wizard page, click Next.
. On the Destination page, specifiy the destination directory of the package by either

entering the path in the box or browsing to it. Click Next.

. On the Libraries page, select one of the three options. Click Next.

. On the Systems page, select the check box to include backups of all robot systems.

Optionally, select the check box to include a media pool for additional options. Click
Next.

. On the Ready to pack page, review the information and then click Finish.
. On the Pack & Go succeeded page, review the results and then click Close.
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7 The Application Menu

7.5. Unpack & Work

7.5. Unpack & Work

Unpacking a station
1. Click Unpack & Work to open the Unpack & Work Wizard.

2. On the Welcome to the Unpack & Work Wizard page, click Next.

3. On the Select package page, specifiy the package to be unpacked by either entering the
path in the box or browsing to it. Specify as well the destination directory of the files.
Click Next.

4. On the Controller Systems page, specify the path to the media pool and the RobotWare
version. Optionally, select the check box to automatically restore backup. Click Next.

5. On the Ready to unpack page, review the information and then click Finish.
6. On the Unpack & Work succeeded page, review the results and then click Close.
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7.6. Station Viewer

7.6. Station Viewer

Overview
The Station Viewer can playback a station in 3D on computers that do not have RobotStudio
installed. It packages the station file together with files needed to view the station in 3D. It
can also play recorded simulations.

Prerequisites
*  Works on Windows XP SP2 and Windows Vista

e .NET Framework 2.0 must be installed on the playback computer

Creating and loading a Station Viewer
1. To create a Station Viewer, on the Application menu, click Collaborate.

2. Select Save Station as Viewer to bring up a dialog box.
3. Specify a file name and save as .exe file.

NOTE! Select the option Show comments on startup and add text in the box to view the
comment when the Station Viewer is started.

NOTE! Select the option Include last executed simulation to include a recording of the
simulation. By default this option is disabled.

4. To load a Station Viewer, double-click the package (.exe) file on the target computer.

The results are displayed in the Output window and the embedded station file is
automatically loaded and presented in a 3D view.

NOTE! You can open any station created in RobotStudio 5.12 with the Station Viewer.
You can pan, rotate, and navigate in the graphical viewer.

Configuring user settings of a Station Viewer
To configure the user settings of a Station Viewer, on the Application menu, click
RobotStudio Options.

Command Buttons

Apply Click this button to save all options in the current page.

Reset Click this button to reset to the settings you had before this
session all values that you have changed on the current
page.

Default Click this button to reset to their default values all settings on

the current page.

Options:General:Appearance

Select application Select the language to be used.

language NOTE! The default language is the same as that of the
target user's operating system if available, otherwise it is
English.

Select color theme Select the color to be used.

Continues on next page
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7 The Application Menu

7.6. Station Viewer

Continued

Options:General:Graphics
Select API to use for 3D  Select the low-level API to be used for rendering 3D graph-
graphics ics.The default value is Direct3D, but OpenGL might be
faster or stabler.
NOTE! No need to restart when changing this option.

Background color Select the color from the color theme, or from the color
stored in the stations.

Simulation
When you run a simulation, the movements and visibility of objects are recorded. This
recording is optionally included in the Station Viewer.
Simulation control buttons are enabled when the Station Viewer contains a recorded
simulation.

Following are the Simulation control buttons:

Play Starts or resumes simulation playback

Stop Stops simulation playback

Reset Resets all objects to their initial state and process time display to zero
Run mode Select to run the simulation once or continuously

Process time  Displays the current simulation time

NOTE! If the simulation executes a VSTA macro, it is not reflected when playing back the
simulation in the Station Viewer.
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7.7. RobotStudio Options

Common buttons

Apply
Reset

Default

Click this button to save all options in the current page.
Click this button to reset to the settings you had before this
session all values that you have changed on the current
page.

Click this button to reset to their default values all settings on
the current page.

Options:General:Appearance

Select application
language

Select color theme

Display Position Edit
boxes with Red/Green/
Blue background

Select the language to be used.

Select the color to be used.

Select the check box if you want to display the position boxes
in the modify dialog boxes with colored background. Default
value: selected.

Options:General:Licensing

View installed license
keys

Request a license
Install a license

Click to view the license keys per feature, version, type,
expiration date and status.

Click to request a license.
Click to install a license.

Options:General:Units

Quantity

Unit

Display decimals
Edit decimals

Select the quantity for which you want to change the units.
Select the unit for the quantity.
Enter the number of decimals that you want to be displayed.

Enter the number of decimals that you want when modifying.

Options:General:Advanced

Enable Windows Error
Reporting

Number of undo/redo
steps

Show acknowledge
dialog box when deleting
objects

Show acknowledge
dialog box when deleting
targets and correspond-
ing move instructions

Warn about running
Virtual Controller
processes on startup

Select this check box to send error data directly to a Microsoft
server to be downloaded and analyzed by ABB support.
Available only on Windows XP or later.

The number of operations that can be undone or redone.
Lowering this value can decrease memory usage.

Warns when deleting objects.

Warns when deleting targets and move instructions.

Warns of orphaned VC processes.

Continues on next page
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7.7. RobotStudio Options

Continued

Options:General:Files & Folders
User Project Folder Enter the path to your project folder. This will be the folder
displayed in the open and save dialog boxes in RobotStudio.
To browse for your project folder, click the browse button.

Automatically create Select this check box to enable the creation of individual
document subfolders subfolders for document types.

Enable Autosave Select the check box to automatically save the station with

defined intervals. Default value: cleared

Interval Specify the interval between the savings when using Autosave
in this box.
Clear Recent Stations Clears the list of recently accessed stations and controllers

and Controllers

Document Locations Launches the Document Locations dialog box. For more infor-
mation, see The Document Manager window on page 47.

Options:General:Screenshot

Entire application
window

Select this option to capture the entire application.

Active document window Select this option to capture the active document window,

© Copyright 2008-2010 ABB. All rights reserved.

Copy to clipboard

Save to file
Location

File name

The file suffix list

typically the graphics window.

Select this check box to save the captured image to the system
clipboard.

Select this check box to save the captured image to file.

Specify the location of the image file. The default location is the
"My Pictures” system folder.

Browse for the location.

Specify the name of the image file. The default name is "Robot-
Studio" to which is added a date.

Select the desired file format. The default format is JPG.

Options:General:Screen Recorder

Framerate

Same as window

Limit resolution
Maximum width
Maximum height
Output file format

Video compression

Start recording after

Stop recording after

Specify the framerate in frames per second.

Select this option to use the same resolution as in the graphics
window.

Select this option to scale down the resolution.
Specify the maximum width in pixels.

Specify the maximum height in pixels.

Select the output file format. The default format is AVI.

Select the video compression format.
NOTE! DivX format is not supported.

Select this option to start recording after the specified time.

Select this option to stop recording after the specified time.

Continues on next page

3HAC032104-001 Revision: D

183



7 The Application Menu

7.7. RobotStudio Options

Continued

Options:Robotics:Editor

Wrap long lines
Text styles
Text color

Select this check box if you want to wrap long lines.
Specify the appearance of the various text classes.
Specifies the text color of the editor.

Options:Robotics:Rapid

Show dialog when
warning for globally
defined workobjects

Show synchronize dialog
box after loading
program /module

Show notification that
default data is used

Show synchronization
notification

Set as active when
creating tooldata

Set as active when
creating workobjects

Select this check box if you want RobotStudio to display a
warning when there are workobjects with the same name that
have been declared as in other tasks. Default value: selected.

Select this check box if you want the synchronize dialog box to
be displayed when you have loaded a program or a module.
Default value: selected.

Select this check box if you want to be notified that wobjO and/
or tool0 is active and will be used in the current action. Default
value: selected.

Default value: selected.

Select this check box if you want newly created tooldata to be
set as active. Default value: selected.

Select this check box if you want newly created workobjects to
be set as active. Default value: selected.

Options:Robotics:Synchronization

Use default synchroniza-
tion locations

Show default synchroni-
zation locations notifica-
tion

Declaration default
locations

Converting data, such as target to Workobject, shall use the
default behavior for synchronization locations. Default value:
selected.

Notifies of the behavior above. Default value: selected.

Specify the locations for corresponding objects when synchro-
nizing to the VC.

Options:Robotics:Mechanism

Approach Vector
Travel Vector

Enable configuration
check for jump to target/
move instruction

Select the approach vector. Default value: Z.
Select the travel vector. Default value: X.

Select this check box if you want to enable the configuration
check configurations when jumping to target or move instruc-
tions. When selected and a target does not have a validated
configuration assigned, you will be asked to set one. When
cleared, the configuration closest to the current one is used.
Default value: selected.

Continues on next page
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7.7. RobotStudio Options

Continued

Options:Robotics:Virtual Controller

Always on top

Enable transparency

Logging

Show virtual Operator
Window

Select this check box if you want to have the virtual FlexPendant
always on top. Default value: selected.

Select this check box if you want parts of the virtual FlexPendant
to be transparent. Default value: selected.
When the controller is warm started,
» Select this check box to log the console output to "con-
sole.log" in the controller directory
» Select this check box to log the console ouput to a
console window

Select this check box to enable the Operator window feature.
Default value: Disabled.

Options:Online:Authentication

Recent Users

Remove/Remove All

Enable Automatic Logoff
Timeout

Lists the recent users.

Click these buttons to remove one or all recent users, respec-
tively.

Select the check box if you want to log off automatically.

Determines the length of the session before being automatically
logged off.

Options:Graphics:Renderer

Select API to use for 3D
graphics

Select the low-level API to be used for rendering 3D graphics.
The default value is OpenGL, but Direct3D might be faster or
stabler.

Options:Graphics:Appearance

Background color
Gradient

Show floor

Color

Transparent
Show UCS Grid

Grid Space X

Grid Space Y

Show coordinate system

Click the colored rectangle to change the background color.

Select the check box if you want to display the background color
in gradient style. Default value: cleared.

Select the check box if you want the floor (at z=0) to be
displayed. Change the floor color by clicking the colored
rectangle. Default values: selected.

Click the colored rectangle to change the color of the floor.

Select the check box if you want the floor to be transparent.
Default values: selected.

Select the check box if you want the UCS grid to be displayed.
Default value: selected.

Change the UCS grid space in the X coordinate direction by
entering the requested value in the box. Default value: 1000 mm
(or equivalent in other units).

Change the UCS grid space in the Y coordinate direction by
entering the requested value in the box. Default value: 1000 mm
(or equivalent in other units).

Select the check box if you want the coordinate systems to be
displayed. Default value: selected.

Continues on next page
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Continued

Options:Graphics:Performance

Detail level

Cull back-facing
triangles

Enable twosided lighting

Cull objects smaller than

Store model data on
graphics card (recom-
mended)

Select if the detail level is to be Auto, Fine, Medium or Coarse.
Default value: Auto.

Select the check box if you want to ignore the back-facing
triangles. Default value: selected.

Culling back-facing triangles improves the graphics
performance but may give unexpected display if surfaces in
models are not faced correctly.

Select the check box if you want to enable two-sided lighting.
Default value: cleared.

Select the size in pixels under which objects will be disregarded.
Default value: 2 pixels.

Select the check box if you want to store the model data on a
graphics card. Default value: cleared.

Storing model data on a graphics card improves graphics per-
formance, but causes stability problems for some hardware
combinations.

The settings you make here are generic for all objects in RobotStudio. With the Graphic
Appareance dialog box you can, however, override some of these settings for single objects.

Options:Graphics:Behavior

Navigation sensitivity

Selection radius (pixels)

Selection highlight

Highlight color

Activate selection
preview

Show local coordinate
system for selected
objects

Select the navigation sensitivity when using the mouse
movements or navigation buttons by clicking the bar and
dragging it into position. Default value: 1.

Change the selection radius (that is, how close the mouse
cursor click must be to an item to be selected) by entering the
requested pixel value in the box. Default value: 5.

Set if the selected object shall be distinguished in the Graphics
window by a color, by an outline or not at all. Default value: color.

Click the colored rectangle to change the highlight color.

Select the check box to enable temporarily highlighting of items
that may be selected when the mouse cursor passes over them.
Default value: selected.

Select the check box to show the local coordinate system for the
selected objects. Default value: selected.

Options:Graphics:Geometry

Normal Tolerance

Surface Tolerance

Curve Tolerance

Enter the maximum deviation of surface normals in the Fine,
Medium or Coarse boxes. Default values (in deg): Fine: 10,
Medium: 22.5, Coarse: 45 (or equivalent in other units).

Enter the maximum spatial deviation of surfaces in the Fine,
Medium or Coarse boxes. Default values (in deg): Fine: 2,
Medium: 10, Coarse: 50 (or equivalent in other units).

Enter the maximum spatial deviation of curves in the Fine,
Medium or Coarse boxes. Default values (in deg): Fine: 0.2,
Medium: 1, Coarse: 5 (or equivalent in other units).

Continues on next page
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7.7. RobotStudio Options

Continued

Options:Simulation:Collision
Perform collision
detection

Stop simulation at
collision

Log collisions to Output
window

Log collisions to file:

Enable fast collision
detection

View

Clear

Select if collision detection is to be performed during simulation
or always. Default value: During simulation.

Select this check box if you want the simulation to stop at a
collision. Default value: cleared.

Select this check box if you want the collisions to be logged to
the output window. Default value: selected.

Select this check box if you want to log the collisions to a file.
Browse for the file to log in by clicking the browse button. Default
value: cleared.

Select this check box to enhance the performance by detecting
collisions between geometrical bounding boxes instead of
geometrical triangles. This might result in falsely reported
collisions, since the triangles are the true geometry and the
bounding boxes always are larger. All true collisions will,
however, be reported. The larger the object, the greater the
number of false collisions that are likely to be detected.

Click this button to open the log file specified in the file box in
Notepad.

Click this button to delete the log file specified in the file box.

Click this button to browse for the file in which you want to log
the collisions.

Options:Simulation:Virtual Time
Virtual Time mode- Free
run

Virtual Time mode - Time
Slice

This option makes RobotStudio always use the free run mode.

This option makes RobotStudio always use the time slice mode.

Options:Simulation:Accuracy

Simulation speed
Simulation timestep

Sets the simulation speed relative to real time.
Specifies the simulation timestep.
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8 The Home Tab

8.1. Overview

8 The Home Tab

8.1. Overview

The Home tab

The Home tab contains the controls required for building stations, creating systems,
programming paths and placing items.
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8.2. ABB Library

8.2. ABB Library

About this button

With this button, you can choose robots, positioners and tracks from their respective galleries.
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8 The Home Tab

8.3. Import Library

8.3. Import Library

About this button
With this button, you can import equipment, geometries, positioners, robots, tools and
training objects to your station libraries.

Importing a library

1. Onthe Home menu, click Import Library and select one of the following controls:
« Equipment
e User Library
» Documents
* Locations
« Browse for Library

2. Click Equipment to import predefined ABB mechanism libraries.

3. Click User Library to select the user defined libraries.

4. Click Documents to open the Document Manager window. See .The Document Manager
window on page 47

5. Click Locations to open the Document Locations window. See Document Locations
window on page 52.

6. Click Browse for Library to select the saved library files.
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8.4. Robot System

8.4. Robot System

About this button

With the Robot System button, you can either create a system from layout or template,
choose an existing system, or select a system from a robot gallery and setup a conveyor
tracking mechanism.

Creating a system from layout

1
2.
3.

© N o o

Click From Layout to bring up the first page of the wizard.
In the Name box, enter the name of the system.

In the Location box, enter the path to the folder where the system will be stored.
Alternatively, click Browse and browse to the folder.

In the Media Pool box, enter the path to the media pool. Alternatively, click Browse and
browse to the folder.

In the RobotWare Version list, select the version of RobotWare you want to use.
Click Next.

In the Mechanisms box, select the mechanisms that you want to include in the system.
Click Next.

The wizard now proposes a mapping of the mechanisms to a specific motion task, in
accordance with the following rules:

e Only one TCP robot is allowed per task.

« Up to six motion tasks may be added, but only four TCP robots can be used, and they
must be assigned to the first four tasks.

e The number of tasks may not exceed the number of mechanisms.

« If the system contains one TCP robot and one external axis, they will be assigned to
the same task. It is, however, possible to add a new task and assign the external axis
to it.

« If the system contains more than one TCP robot, any external axes will be assigned to
a separate task. It is, however, possible to move them to other tasks.

e The number of external axes in a task is limited by the number of available drive
modules in the cabinet (one for large robots, two for medium, three for small).

NOTE! If only one mechanism was selected in the previous page, this page will not be
shown.

Tasks can be added and removed using the respective buttons; mechanisms can be moved
up or down using the respective arrows. To map the mechanisms to tasks, follow this step:

Optionally, make any edits in the mapping, and then click Next.
The System Option page appears.

Continues on next page
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8.4. Robot System

Continued

10. On the System Option page, you have the option to align Task Frame(s) with the
corresponding Base Frame(s).

For single robot system, select the checkbox to align task frame with base frame:

For MultiMove Independent system, select the check box to align task frame with base
frame for each robot.

For MultiMove Coordinated system, select the robot from the drop down list and
select the check box to align task frame with base frame for the selected robot.

11. Verify the summary and then click Finish.

If the system contains more than one robot, the number of tasks and the baseframe
positions of the mechanism should be verified in the System Configuration window.

Adding a template system

1. Click From Template to bring up a dialog box.

2. Inthe Select Template System list, either select an appropriate template or click Browse
and browse to one.

3. Inthe Libraries group, select whether to import libraries or to use the existing station
libraries.

4. Inthe System group, enter a name and location, and then click OK.

Adding an existing system

1. Click Existing to bring up a dialog box.

. In the Select System Pool list, select a folder.

2
3. Inthe Systems Found list, select a system.
4

. Inthe Libraries group, select whether to import libraries or to use the existing station
libraries.

5. Click OK.

Selecting a system from a robot gallery
1. Click Quick System to bring up a gallery, and then click the appropriate robot.

Continues on next page
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8.4. Robot System

Continued

Setting up a conveyor

1
2.

&>

© N o o

9.

Click Setup.

In the Part Sequence tab, select Part from Available Parts.

The right arrow button is enabled.

Click right arrow button to move the Part to Parts moved by Conveyor list.

Click up and down arrow buttons to move the selected part in Parts moved by Conveyor
list.

In the Part Tracking tab, select Part from Parts moved by Conveyor list.
Select CNV1 from the Mechanical Unit list.

Select a workobject from the Workobject list.

Click Add. The workobject appears in the list.

NOTE! If the same workpiece is tracked by more than one robot, add a pair of workobject
for each robot that tracks the workpiece. This procedure has to be repeated for each
workpiece that should be tracked.

Click OK.

10. Activate the Conveyor Mechanical Unit (CNV1). See Activate Mechanical Units on page

305

Removing objects from conveyor

1.

Click Setup.

The Conveyor Setup dialog box appears.

In the Part Sequence tab, select Part from the Parts moved by Conveyor list
The left arrow button is anabled.

Click left arrow to remove the part from the Parts moved by Conveyor list to Available
Parts list.
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8 The Home Tab

8.5. Import Geometry

8.5. Import Geometry

Importing geometry

. On the Home menu, click Import Geometry. and select one of the following controls:.

e User Geometry

« Browse for Geometry

. Click User Geometry to select the user defined geomtery.
. Click Browse for Geometry to browse to the folder where the geometry is located.

For predefined geometries, click the Geometry icon to the left in the dialog box.

. Select the required geometry and click Open.

If you want the geometry to move with another object, attach it to the requested object,
see Attach to on page 378.

To modify the detail level for import of geometries, see RobotStudio Options on page 182.
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8.6.1. Frame

8.6 Frame

8.6.1. Frame

Creating a frame

1. Click Frame.

2. In the dialog box, specify the positions for the frame.

Reference

Frame Position

Frame Orientation
Set as UCS

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the frame position in
the graphics window to transfer the values to the Frame
Position boxes.

Specify the coordinates for the frame orientation.

Select this check box to set the created frame as the user
coordinate system.
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8 The Home Tab

8.6.2. Frame from Three Points

8.6.2. Frame from Three Points

Creating a frame from three points

1. Click Frame from Three points to bring up a dialog box.

2. Decide how you want to specify the frame:

To specify the frame using Select

X, Y and Z coordinates, a point on the X axis Position

and a point in the X-Y plane

two points on the X axis and one point on the Three Point

Y axis

3. If you select Position:

« Enter the Position for the object.

« Enter the Point on X axis for the object.

« Enter the Point on X-Y plane for the object.

¢ Click Create.

4. If you select Three Point:

« Enter the First Point on X axis for the object. This is the point closest to the frame’s

origin.

« Enter the Second Point on X axis for the object. This is the point further away in the

positive X direction.

« Enter the Point on Y axis for the object.

¢ Click Create.

The Create Frame From Three Points dialog box

Position

Frame Position

Point on X axis

Point on X-Y plane

Three Point

First Point on X axis

Second Point on X axis

Select this option if you want to create the frame by using a
position and two points.

Click in one of these boxes, and then click the frame position in
the graphics window to transfer the values to the Frame
Position boxes.

Click in one of these boxes, and then click the point position in
the graphics window to transfer the values to the Point on X
axis boxes.

Click in one of these boxes, and then click the point position in
the graphics window to transfer the values to the Point on X-Y
plane boxes.

Select this option if you want to create the frame by using three
points.

Click in one of these boxes, and then click the point position in
the graphics window to transfer the values to the First Point on
X axis boxes.

Click in one of these boxes, and then click the point position in
the graphics window to transfer the values to the Second Point
on X axis boxes.

Continues on next page
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8.6.2. Frame from Three Points

Continued

Point on Y axis

Set as UCS

Click in one of these boxes, and then click the point position in
the graphics window to transfer the values to the Point on Y

axis boxes.

Select this check box to set the created frame as the user

coordinate system.
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8.7. Workobject

8.7. Workobject

Creating a workobject

1.
2.
3.

Click Workobiject to bring up a dialog box.
In the Misc Data group, enter the values for the new workobject.
In the User Frame group, do one of the following:

« Set the position of the user frame by entering values for the Position x, y, z and the
Rotation rx, ry, rz for the workobject by clicking in the Values box.

» Select the user frame by using the Frame by points dialog box.

In the Object Frame group you can reposition the object frame relative to the user frame
by doing any of the following:

» Set the position of the object frame by selecting values for Position X, y, z by clicking
in the Values box.

« For the Rotation rx, ry, rz, select RPY (Euler XYX) or Quaternion, and enter the
rotation values in the Values dialog box.

» Select the object frame by using the Frame by points dialog box.
In the Sync Properties group, enter the values for the new workobject.

Click Create. The workobject will be created and displayed under the Targets node under
the robot node in the Paths&Targets browser.

The Create Workobject dialog box

Name Specify the name of the workobject.

Robot holds workobject Select whether the workobject is to be held by the robot. If you

select True, the robot will hold the workobject. The tool can then
either be stationary or held by another robot.

Moved by mechanical Select the mechanical unit that moves the workobject. This

unit option is applicable only if Programmed is set to False.

Programmed Select True if the workobject is to use a fixed coordinate
system, and False if a movable (that is, external axes) will be
used.

Position x, y, z Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Rotation rx, ry, rz Specify the rotation of the workobject in the UCS.

Frame by points Specify the frame position of the user frame.

Position x, y, z Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Rotation rx, ry, rz Specify the rotation of the workobject.

Frame by points Specify the frame position of the object frame.

Storage type Select PERS or TASK PERS. Select the Storage Type TASK

PERS if you intend to use the workobject in multimove mode.

Module Select the module in which to declare the workobject.
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8.8. Tooldata

8.8. Tooldata

Creating tooldata

. In the Layout browser, make sure the robot in which to create the tooldata is set as the

active task.

2. Click Tooldata to bring up a dialog box.
. In the Misc Data group:

» Enter the Name of the tool.
« Select whether the tool is to be held by the robot in the Robot holds tool list.

. In the Tool Frame group:

« Define the Position X, y, z of the tool.
< Enter the Rotation rx, ry, rz of the tool.

. Inthe Load Data group:

« Enter the Weight of the tool.
« Enter the Center of gravity of the tool.
» Enter the Inertia of the tool.

. In the Sync Properties group:

« Inthe Storage type list, select PERS or TASK PERS. Select TASK PERS if you
intend to use the tooldata in MultiMove mode.

* In the Module list, select the module in which to declare the tooldata.

. Click Create. The tooldata appears as a coordinate system in the graphics window.
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8 The Home Tab

8.9.1. Teach Target

8.9 Target

8.9.1. Teach Target

Teaching a target
To teach a target, follow these steps:

1. Inthe Layout browser, select the workobject and tool for which you want to teach the
target.

2. Jog the robot to the preferred position.
NOTE: To jog a robot linearly, its VC must be running.
3. Click Teach Target.

4. A new target will be created in the browser, under the active workobject node. In the
graphics window a coordinate system will be created at the TCP position. The
configuration of the robot at the target will be saved.
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8.9.2. Create Target

8.9.2. Create Target

Creating a target

1.
2.

In the Layout browser, select the workobject in which you want to create the target.
Click Create Target to bring up a dialog box.

3. Select the Reference coordinate system you want to use to position the target:

If you want to position the target Select

absolute in the world coordinate system of ~ World

the station

relative to the position of the active Work Object

workobject

in a user-defined coordinate system ucs

4. In the Points box, click Add New and then click the desired position in the graphics

window to set the position of the target. You can also enter the values in the Coordinates
boxes and click Add.

Enter the Orientation for the target. A preliminary cross will be shown in the graphics
window at the selected position. Adjust the position, if necessary. To create the target,
click Create.

If you want to change the workobject for which the target is to be created, expand the
Create Target dialog box by clicking the More button. In the WorkObject list, select the
workobject in which you want to create the target.

If you want to change the target name from the default name, expand the Create Target
dialog box by clicking the More button and entering the new name in the Target name
box.

Click Create. The target will appear in the browser and in the graphics window.
NOTE: The created target will not get any configuration for the robot axes. To add the
configuration values to the target, use either ModPos or the Configurations dialog box.
NOTE: If using external axes, the position of all activated external axes will be stored in
the target.

The Create Target dialog box

Reference Select the reference coordinate system to which all positions or
points will be related.

Position Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Orientation Specify the orientation of the target.

Add Click this button to add a point and its coordinates to the Points
list.

Modify Click this button to modify an already defined point, after you
have selected it in the Points list and entered new values.

Points The target points. To add more points, click Add New, click the
desired point in the graphics window, and then click Add.

More/Less Click this button to expand or collapse parts of the create target
dialog box.

Continues on next page
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Target name

Workobject

8.9.2. Create Target

Continued

Here you can change the name of the target you are creating. It
is visible only when the create target dialog box is expanded.

Here you can change the workobject in which the target is to be
created. It is visible only when the create target dialog box is
expanded.
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8.9.3. Create Jointtarget

8.9.3. Create Jointtarget

Creating a jointtarget

1. Click Create Jointtarget to bring up a dialog box.

2. If youwant to change the default name of the jointtarget, enter the new name in the Name

box.

3. Inthe Axes Values group, do as follows:

* For the Robot axes, click the Values box and then click the down arrow. The Joint
Values dialog box will be displayed. Enter the joint values in the boxes and click

Accept.

» For the Joint axes, click the Values box and then click the down arrow. The Joint
Values dialog box will be displayed. Enter the joint values in the boxes and click

Accept.

4. Click Create. The jointtarget will appear in the browser and in the graphics window.

The Create Jointtarget dialog box

Name
Robot axes

External axes

Storage Type

Module

Specify the name of the jointtarget.

Click the Values list, enter the values in the Joint values dialog
box and click Accept.

Click the Values list, enter the values in the Joint values dialog
box and click Accept.

Select the Storage Type TASK PERS if you intend to use the
jointtarget in multimove mode.

Select the module in which you want to declare the jointtarget.
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8.9.4. Create Targets on Edge

8.9.4. Create Targets on Edge

Overview

Targets on Edge creates targets and move instructions along the edges of the geometric
surface by selecting target points in the graphics window. Each point on a geometric edge has
certain properties that can be used to position robot targets relative to the edge.

This can be an alternative to Path on Curve. For more information on creating path from
curve, see Path from Curve on page 208.

Creating targets on edge

1. Onthe Home tab, click Target and select Create Targets on Edge.

The Targets on Edge dialog box appears.

NOTE!

The selection mode in graphics window is automatically set to Surface, and the snap
mode is set to Edge.

. Click on the surface of the body or part to create target points.

The closest point on the adjacent edge is calculated and added to the list box on as target
points Point 1, Point 2 ....

NOTE!

When an edge is shared between two surfaces, the normal and tangent directions depend
on the surface selected.

3. Use the following variables to specify how a target is related to a point on the edge.

Select... to...

Vertical offset specify the distance from the edge to the target in the surface

normal direction.

Lateral offset specify the distance from the edge to the target perpendicular to

the edge tangent.

Approach angle specify the angle between the (inverse) surface normal and the

approach vector of the target.

Reverse travel direction specify if the travel vector of the target is parallel or inversely

parallel to the edge tangent.

NOTE!

For each target point, a preview of the approach and travel vectors are displayed as arrows
and as a sphere representing the point on the edge in the graphics window. The preview
of the arrows are updated dynamically once the variables are modified.

4. Click Remove to remove the target points from the list box.

Continues on next page
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8.9.4. Create Targets on Edge

Continued
5. Click More to expand the Create Targets on Edge dialog box and to choose the
following advanced options:
Use... to..
Target name change the target name from the default name to a new user
defined name
Task select the task for which to add targets.
By deafult, active task in the station is selected.
Workobject select the workobject for which you want to create the targets
on edge
Insert Move Instructions in create Move instructions in addition to targets, which will be
added to the selected path procedure.
The active process definition and process template will be
used.
6. Click Create.
The target points and Move instructions (if any) are created and are displayed in the
Output window and graphics window.
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8.10. Empty Path

8.10. Empty Path

Creating an empty path
1. Inthe Paths&Targets browser, select the folder in which you want to create the path.

2. Click Empty Path.

3. To set the correct motion properties for the targets, select the active process in the Change
Active Process box in the Elements toolbar.

4. NOTE: If the active template is set to MoveAbsJoint:

» Atarget that is dragged into a path will be converted into a jointtarget (recognized by
a different icon on in the browser).

« Jointtargets and their instructions can only use wobj0 and toolO.

« One target can not be used as different types, for example, MoveJoint, but must be
deleted and re-created.

* When the target has been synchronized with the virtual controller, the jointtarget
values will be calculated and inserted in the RAPID program.
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8.11. Path from Curve

Prerequisites

To create a path from a curve, the curve must first have been created in the station.

Creating a path from a curve

1. Inthe Layout browser, select the task in which you want to create the path.
2. Click Path From Curve to bring up a dialog box.

3. Inthe Select curves from graphics box, click Add New and then click the requested
curve in the graphics window.

4. Select Create on curve or Reference surface:

To Select
ensure that the path is generated on the Create on curve
curve.

If cleared, the path may be generated on the
reference surface, if one is used.

use a reference surface. Reference Surface

The initial orientation of the target will be
normal to the surface, and the parameters of
the target will relate to this orientation.

5. Select the workobject in which targets are to be created from the Insert targets in
workobject list.

6. Setthe Target Parameters:

To Enter values in
specify the rotation around the X axis. Approach
specify the rotation around the Y axis. Travel

specify the rotation around the Z axis. Spin

create a start target at the specified distance Approach
from the first target on the curve, in the
approach direction.

create a departure target at the specified Depart
distance from the last target on the curve, in
the approach direction.

start the path at a different location along the Offset Start
curve than the start point.

end the path at a different location along the Offset End
curve than the end point.

create an offset which will be the same at Local Target Offset
every target along the path.

Continues on next page
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7. Set the Approximation Parameters:

To

specify the maximum allowed deviation
between the chord of the curve and the path.
A low tolerance will generate more targets
than a high tolerance.

select whether a linear motion shall represent
the curve or if circular motion should be used
in the path.

specify the minimum distance between the
targets. This box is applicable only if a linear
motion has been selected above.

select the maximum radius for circular
motions in the path. Larger circular motions
will be replaced by a linear motion. This box
is applicable only if a circular motion has
been selected above.

8.11. Path from Curve

Continued

Select or enter values in

Max chord dev

Line/circular

Min dist.

Max rad.

8. Click Create. The path and its targets appear in the browser and in the graphics window.

NOTE!

ﬂ The targets created do not have any robot axis configurations set, which is required for use in
programs with configuration monitoring. For information about setting robot axes
configurations, see Setting robot axis configuration for paths on page 96.

The Create Path From Curve dialog box

Select curves from
graphics

Create on curve

Reference Surface

Insert targets in
workobject

Target Parameters
Approach

Travel

Spin

Approach

Depart

Offset Start

Offset End

Select the curve that you want to create a path from by clicking
Add New and then clicking the selected curve in the graphics
window.

This check box ensures that the path is generated on the curve.
If cleared, the path may be generated on the reference surface
if one is used.

This check box is selected when a reference surface is to be
used. The initial orientation of the target will be normal to the
surface, and the parameters of the target will relate to this orien-
tation.

Select the workobject in which you want to create the path from
the list.

Specifies the rotation angle around the X axis.
Specifies the rotation angle around the Y axis.
Specifies the rotation angle around the Z axis.

Creates a start target at the specified distance from the first
target on the curve, in the approach direction.

Creates a departure target at the specified distance from the last
target on the curve, in the approach direction.

If you want a different starting point than the beginning of the
curve, enter the offset from the start point in the Offset Start
box.

If you want a different end point than the end of the curve, enter
the offset from the end point in the Offset End box.

Continues on next page
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8.11. Path from Curve

Continued

Local Target Offset

Max Chord Dev

Linear/circular

Min Distance

Max Rad

Enter the local target offset to generate the same offset at each
target.

Specifies the maximum allowed deviation between the chord of
the curve and the path. A low tolerance will generate a more
accurate path with more targets than a high tolerance.

Selects whether linear segments shall represent the curve or if
circular segments should be used in the path.

Specifies the minimum distance between the targets. This box
is only applicable for linear paths.

Specifies the maximum radius for circular movements in the
path. Larger circular segments will be replaced by linear
segments. This box is applicable only for circular paths.
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8.12. MultiMove

8.12. MultiMove

Overview

For browsing between the pages of the MultiMove window, click the tabs in the navigation
pane. By default the tabs are arranged in an order that corresponds to the typical workflow:

Setup tab

System
Config

Path Config

Start
Position

Select System

System

Enable

Type

Robot
Update

Paths

Enable

Order

Path

Select Robot that other shall jump
to

Apply

Here you select the system that
contains the robots to program.

Each robot in the system is presented
in its own row in this grid. In the
columns you make the settings as
described below.

Select this check box to use the robot
in the MultiMove program.

Specify if the robot holds the tool or
the work piece.

Displays the name of the robot.

Click this button to update the paths in
the grid if any of the paths have been
changed. The button turns red if a
change has been detected and an
update is necessary.

Each path in the station is presented
in its own row in this grid. In the
columns you make the settings as
described below.

Select this check box for the paths to
use for the program.

Displays the order in which the paths
will be executed. To change the order,
use the lists in the path column for
rearranging the rows in which the
paths appear.

Sets the path to be executed here.

When creating a new start position,
select a robot that the other will try to
reach here.

Jumps the other robots to the new
start position.

Continues on next page
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8.12. MultiMove

Continued

Motion Behavior tab

This is used for specifying constraints and rules for how the robots shall move relative to each
other. The default setting is no particular constraints, which results in the fewest joint
movements. However, changing the motion behavior might be useful for:

» Locking the orientation or position of the tool.
« Optimizing cycle time or reachability by allowing tolerances.
« Avoiding collisions or singularity by restricting joint motions.

Both Joint Influence and TCP Constraints restrict the robot’s motions. Changes in these
settings might result in lower performance or situations where it is impossible to find proper
solutions. The weight values for Joint Weights and TCP Constraints set how much the setting
for each joint or TCP direction shall affect the robots relative to each other. It is the difference
between the weight values that matters, not the absolute values. If contradicting behaviors
have been set, the one with the lowest weight value will win.

Tool Tolerance, instead of restricting, enables more motions. Therefore, tolerances may
improve cycle and process times and enhance the reachability of the robots. Tolerances, too,
have weight value; here is set how much the robots shall use the tolerance. A low value
indicates that the tolerance will be used a lot, while a high value means that the robots will
try to avoid using the tolerance.

The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while increasing
it will promote motion on this axis relative to alternative axes.

The TCP constraints control the position and orientation of the tool. Enabling a TCP
constraint will decrease the motion of the tool and increase the motion of the work piece.

The tool tolerances control the allowed deviation between the tool and the work piece. By
default, tolerances are not enabled, which means that no deviation is allowed. Enabling a
tolerance, if applicable, might improve motion performance. For example, if the tool is
symmetric around its Z axis, you can enable the Rz tolerance without affecting the accuracy
of the generated paths.

The tool offset sets a fixed distance between the tool and the paths.

Joint Select Robot Select the robot’s joints to constrain in
Influence this box.
Joints for Robot Displays the robot’s joints and their

constraint weights. Each joint is
presented in its own row.

AXxis Displays which axis the constraint
affects.
Influence Specify how much the motion for the

axis is constrained. 0 means a locked
axis, while 100 means no constraint
relative to default constraint values.

TCP Active TCP This grid displays the position and
Constraints rotations of the TCP together with
their constraint weights.

Enable Select this check box to activate the
constraint for this TCP pose.

Continues on next page
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Value

Influence

Tool Enable
Tolerance
Pose

Value

Influence

Tool Offset  Enable

Pose

Offset

8.12. MultiMove

Continued

Displays the TCP pose that is affected
by the constraint.

Specify the pose value to constrain at.
Either type the value, or click the Pick
from TCP button to use the values of
the current TCP position.

Specify how much the motion for the
TCP value is constrained. 0 means a
locked TCP at this pose, while 100
means no constraint relative to default
constraint values.

Select this check box to activate the
tolerance for this tool pose.

Displays the tool pose that is affected
by the constraint.

Specify the pose value to apply the
tolerance around.

Specify the size of the tolerance. 0
means no deviation is allowed, while
100 means all deviations are allowed.

Select this check box to activate the
offset for this tool pose.

Displays the tool pose that is affected
by the offset setting.

Specify the value of the offset here.

Create Paths tab

This tab is used for creating RobotStudio paths for the MultiMove robots. The created paths
will accord with the motions displayed during the most recently played test simulation.

With the settings group you set up the MultiMove properties that connect the tasks for the tool

robot and work piece robot to each other.

With the WP robot settings group you set up the properties for the task that will be generated

for the work piece robot.

The generate path group contains the button that creates the paths.

Settings Start ID

ID step index

Sync ident prefix

Task list prefix

Path Prefix

Specify the first ID number for the syn-
chronization of the instructions for the
robots.

Specify the gap between the
succeeding ID numbers.

Specify a prefix for the syncident
variable, which connects the sync
instructions in the tasks for the tool
robot and the work piece robot with
each other.

Specify a prefix for the tasklist
variable, which identifies the tasks for
the tool robot and work piece robot to
synchronize.

Specify a prefix for the generated
paths.

Continues on next page
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Continued

WP robot
settings

Generate
Paths

Target Prefix

WP Workobject

WP TCP

Create paths

Specify a prefix for the generated
targets.

Specify the work object to which the
targets generated for the work piece
robot shall belong.

Specify which tool data the work piece
robot shall use when reaching its
targets.

Clicking this button generates paths in
RobotStudio for the latest tested
motions according to the settings
specified.

MultiTeach tab

With this tab you teach complete synchronized move instructions for the robots in the
MultiMove program.

Settings

Path Prefix
Target Prefix

Start ID

ID step index

Sync ident prefix

Task list prefix

Select type of Sync instruction

Setup

Specify a prefix for the paths to create.

Specify a prefix for the generated
targets here.

Specify the first ID number for the syn-
chronization of the instructions for the
robots.

Specify the gap between the
succeeding ID numbers.

Specify a prefix for the syncident
variable, which connects the sync
instructions in the tasks for the tool
robot and the work piece robot with
each other.

Specify a prefix for the tasklist
variable, which identifies the tasks for
the tool robot and work piece robot to
synchronize.

Select the type of synchronization to
use.

Coordinated implies that all move
instructions are synchronized for the
robots.

Semicoordinated implies that the
robots work independently at some
times and wait for each other at other
(like when repositioning the work
piece).

For detailed information about the
coordination types, see the
Application manual - Multimove.

Select the robots for teaching targets.
This grid also displays the
workobjects and tools that will be used
for the targets.

Continues on next page
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Continued

Teach MultiTeach Information Displays a hierarchal tree which
contains the created move instruc-
tions. The tree is organized the same
way as the tree in the Layout browser.

MultiTeach Creates move instructions for the
robots selected in the settings to their
current positions. The created move
instructions are immediately inserted
at their correct places in the
MultiTeach Information tree.

Done Confirms the creation of the instruc-
tions.

Test tab
RobotStudio’s MultiMove window has a page with commands for testing multimove
programs. Its default placement is at the bottom of the MultiMove window.

The status group displays the status of the simulation, that is, whether the current settings
have been tested or if errors have occurred.

In addition to the status group, information from the virtual controller is also displayed in
RobotStudio’s Output window during simulation.

Play <<<>>> Jumps the robots, respectively, to the
previous and next targets in paths.
The double arrow buttons jump
several targets at once, while the
single arrow buttons jump one target
for each click.

Play Click this button to move the robots
along the paths.

Play also has a list box in which you
can activate the following commands:

e Savecurrent position: Saves
the current start position. Since
the calculated motions are
based on the robot start
position saving the start
position is useful when testing
alternative solutions.

e Restore saved position:
Moves the robots back to the
saved start positions.

* Restore last closed loop
position: Moves the robots
back to the list used start
position.

e Close loop: Finds a suitable
start position based on the
robots’ current positions and
prepares the calculation of
movements.

e Calculate: Calculates and
executes the movements.

Simulation speed Sets the speed at which the simulation
is performed.

Continues on next page
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Continued

Settings

Simulate Online

Cancel on error

Watch Close Loop

Select this check box to make the
simulation stop after running the paths
one time. If cleared, the simulation will
continue playing over and over until it
is stopped manually.

Select this check box to run the
simulation as the movements are
calculated.

This is useful for troubleshooting
purposes, since itdisplays and reports
targets the robot cannot reach.

Select this check box to stop the
simulation if an error occurs. Cancel
on errors is recommended to use
when simulate online is used to
minimize the number of error
messages once the first error is
identified.

Select this check box to display the
search for a suitable start position in
the graphics window.

Clear the check box to jump the robots
to the start position when it is found.

The MultiMove configure system wizard

The MultiMove configure system wizard guides you through configuring robots and
workobjects for MultiMove system. If the workobjects are not configured correctly when the
MultiMove functions are started, you will be asked whether to run the wizard. You can also
start it manually from the Tools page of MultiMove.

The wizard contains four pages, the information pane at the bottom indicates the current page.

Workpiece robot

Tool robots

Workobjects

Result

The workpiece robot page contains a list in which you select the
robot that holds the workpiece.

Only one robot can be set up as workpiece robot. If your station
has several robots that hold the workpiece, set up one of them
as workpiece robot and the other as tools robots, and create
paths for these robots in which they only hold the workpiece.

The tool robots page contains a list in which you select the
robots that operate on the work piece.

All robots selected as tools robots will be coordinated to the
workpiece robot. Any robot of the system that is selected neither
as workpiece robot or tool robot will not be coordinated.

The Workobjects page contains a box for each tool robot in
which you specify the workobject in which the targets for the
MultiMove paths shall be created. The wizard will attach this
workobject to the workpiece robot, for enabling MutliMove.

Either type in a name for a new Workobject to create in the box,
or select the Use existing WorkObject check box and then
select one from the list.

The Result page displays a summary of the station configura-
tion.

Either click Done to finish or Previous to go back and change
the setup.

Continues on next page
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Continued

NOTE!

H The wizard will not help you configure the RobotWare system correctly. If the correct options
are not used you will not be able to synchronize generated MultiMove paths to the virtual
controller, even if you can use the MultiMove functions in RobotStudio.

The Analyze path tool
This tool checks whether existing paths are coordinated correctly for MultiMove.

The analyzer opens in a window of its own and contains three pages. The information pane
at the bottom indicates the current page.

Select Paths Enable Select to include the task in the
analysis.
Task Displays the name of the task.
Path Select the path to analyze for the
current task.
Analyze Analyze Click this button to start the analysis.
Report OK. The paths are compatible in the

. .__.;' specified aspect.
xx0600002648

Information. The paths are not fully

compatible in the specified aspect, but
@ the robot program may still be
xx0600002649 executable.

Error. The paths are not compatible in
'z the specified aspect, and the robot

program is not executable.
xx0600002650

The Recalculate ID tool
This is one of the tools for working manually with MultiMove programs. It sets new sync 1D
arguments to the move instructions in a MultiMove path. By using the tool with the same start
ID and ID step index on all paths that shall be synchronized, you can be sure that the IDs
match if all paths contain the same number of move instructions.

Title Displays the name of the path to recalculate IDs for.
Start ID Sets the number of the first ID in the path.
ID Step index Sets the size of the step to increase the ID number for each

move instruction.
Only update instructions Select this check box to recalculate only those IDs for instruc-
that has ID defined tions that have existing IDs.
Clear this check box to also create IDs for instructions that have
no IDs (for example, if you have added new move instructions
that shall be coordinated).
The Only update instruc- Select this check box to affect only those move instructions that
tions between SyncMove belong to already synchronized parts of the path.
On/Off check box. Clear this check box to update IDs for instructions in all parts of
the path.

Continues on next page
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The Convert path to MultiMove path tool
This is one of the tools for working manually with MultiMove programs. It adds sync ID
arguments to all move instructions in the path and, optionally, SyncMoveOn/off
instructions, thus preparing an ordinary path for MultiMove use.

You use the tool on one path a time, so for creating a MultiMove program, you convert one
path for each robot and then create a tasklist and syncidents which you add to the Sync
instructions.

Title Displays the name of the path to recalculate IDs for.
Start ID Sets the number of the first ID in the path.
ID Step index Sets the size of the step to increase the ID number for each

move instruction.

Add SyncMove On/Off Select this check box to add instructions that start and stop the
before and after synchronization.

The Create Tasklist tool
This is one of the tools for working manually with MultiMove programs. It creates a variable
of the RAPID data type tasks, which identifies the tasks that will be synchronized. In each
SyncMoveOn Of WaitSyncTask instruction, you then specify which tasklist to use.

Tasklist name Specifies the name of the tasklist.
Tasks that will be Select the check box for each task to include in the list.
included

The Create Syncident tool
This is one of the tools for working manually with MultiMove programs. It creates a variable
of the RAPID data type syncIdent, which identifies the sync instructions that shall be
synchronized.

Syncident name Specifies the name of the SyncIdent variable to create.

Tasks that Syncldent will Select the check box for each task to use this Syncident in.
be created in
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8.13. Teach Instruction

Teaching a move instruction
1. Inthe Layout browser, make sure the settings for active robot, workobject, tool, motion
type and path are appropriate for the move instruction to create.

2. Jog the robot to the desired location. If jogging the robot using the freehand mode, you
can also use snap modes for snapping its TCP to objects in the station.

3. Click Teach Instruction. A move instruction is now created last in the path.
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8.14. Move Instruction

Creating a move instruction and a corresponding target
To create a move instruction, follow these steps:

1.
2.
3.

Click Move Instruction to bring up a dialog box.
Select the Reference coordinate system for the move instruction.

Enter the Position to reach for the move instruction by clicking Add New in the
Coordinates box and then click the required to-points in the graphics window. You can
also enter the values in the Coordinates boxes and click Add.

Enter the Orientation for the move instruction.

By clicking the More/Less button, you can expand or collapse the Create Move
Instruction dialog box. When the dialog box has been expanded, you can change the
Target name and the Work object to which the target (with the move instruction) will
belong.

Click Create to create the move instruction. The move instruction will appear under the
path node as a reference to the target.

The Create Move Instruction dialog box for jointtarget movements

Name Here you can change the name of the target you create when

creating the move instruction.

Robot axes Specify the joint values for the robot. Select the box and click the

list to set the values.

External axes box Specify the joint values for external axes, if any exist in the

station. Select the box and click the list to set the values.

Storage Type Click this button to expand or collapse parts of the create move

instruction dialog box.

Module Specify the module in which the jointtarget shall be declared.
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8.15. Action Instruction

Creating an action instruction
1. Inthe Paths&Targets browser, select where to insert the action instruction.

To insert the action instruction Select
at the beginning of a path the path
after another instruction the proceeding instruction

2. Right click Path and select Insert Action Instruction.
The Create Action Instruction dialog box appears.
3. From the Instruction Templates list, select the action instruction to create.

4. Optionally, modify instruction arguments in the Instruction Arguments grid. For
detailed information about the arguments for each instruction, see the Rapid reference
manual.

5. Click Create.
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8.16. Instruction Template Manager

Overview

The Instruction Template Manager is used to add support for instructions other than the
default set that comes with the RobotStudio.

For example, a robot controller system with the RobotWare Dispense option has specialized
move instructions related to glueing like DispL and DispC. You can manually define the
instruction templates for these using the Instruction Template Manager. The instruction
templates are exported to XML format and reused later.

RobotStudio has pre-defined XML files that are imported and used for robot controller
systems with the appropriate RobotWare options. These XML files has both the Move and
Action instructions.

NOTE! It is recommended to use RobotStudio ArcWelding PowerPac while using
RobotWare Arc.

The instruction template supports the following Robotware options:
« Cap (Continuous Application Process)
« Disp (Dispense)
« Trigg (Fixed Position Events)
e Spot Pneumatic
e Spot Servo
» Spot Servo Equalizing
o Paint

e—t

Instruction Descriplion [MoviesAlsd]
Mama Datatgn Aczmisittn [ Optiond PoniTypn tynelatormentin

xx0600003320

Continues on next page
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8.16. Instruction Template Manager

Continued

Description

Buttons for importing, exporting and validating.

The instruction template tree. This hierarchal tree set organizes the templates.

Templates are always the lowest level nodes. For details about specific nodes
in the tree, see item 5 and below.

Brief description for editing and creating instruction templates.

The Instruction grid. All arguments and settings for the object selected in the
tree are displayed here. Only white boxes are editable. Red values indicate
that the values are invalid.

The Instruction templates top node. Here you can see to which task the
templates belong.

The Action instructions node contains everything related to action instruction
templates.

An Action instruction description node, here represented by the Set DO
instruction, defines the arguments that can be set for the action instruction
templates of that kind.

You can create action instruction descriptions for all action instructions known
by the system running on the virtual controller.

An Action instruction template node, here represented by Default, contains
instances of the action instruction descriptions, with defined values for the
arguments.

The Move instructions node contains everything related to move instruction
templates.

The Move instruction descriptions node contains all move instructions
descriptions for the task.

If the description for an instruction is not present in the list, right-click this node
to add it. You can create move instruction descriptions for all move instructions
known by the system running on the virtual controller.

A Move instruction description node, here represented by the MoveAbsJ
node, defines the arguments that can be set for the move instruction templates
of that kind.

Unlike action instructions, instruction templates related to a certain move
instruction descriptions are not stored in child nodes under the description, due
to a more complex hierarchy.

The Process definitions node, which gathers all process definitions, contains
sets of process templates which in turn contain instruction templates optimized
for specific processes.

A Process definition node, here represented by the generic Move process,
contains sets of process templates which in turn contain instruction templates
optimized for specific processes.

A Process template node, here represented by the generic Default process,
contains sets of move instruction templates with argument values optimized
for specific processes.

A process template can hold one move instruction template for each move
instruction type defined by a move instruction description.

A Move instruction template node, here represented by MoveJ, contains
instances of move instruction descriptions with argument values customized
for specific processes.

Continues on next page
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Continued

Importing a template
1. Click Import to bring up the Open File dialog box.

2. Select the file to import, and click OK.

Exporting a template
1. Select an exportable node in the tree view and click Export to bring up the Save File
dialog box.

2. Click OK.

Validating the templates
1. Select a node in the tree view and click Validate.

Any invalidity will be reflected by the icons and ToolTips of the respective node and
reported in the Output window.
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8.17 The Freehand Group

8.17.1. Move

Moving an item

1. Inthe Layout browser, select the item you want to move.
2. Click Move.
3. In the graphics window, click one of the axes and drag the item into position.
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8.17.2. Rotate

Rotating an item

. In the Layout browser, select the item you want to rotate.
. Click Rotate.

. In the graphics window, click one of the rotational rings and drag the item into position.

If you press the ALT key while rotating, the item will snap 10 degrees at a time.
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8.17.3. Jog Joint

Jogging the joints of a robot
1. Inthe Layout browser, select the robot you want to move.

2. Click Jog Joint.
3. Click the joint you want to move and drag it to the preferred position.

If you press the ALT key when jogging the joints of the robot, the robot will move 10
degrees at a time. If you press the f key, the robot will move 0.1 degree at a time.

3HAC032104-001 Revision: D 227



8 The Home Tab

8.17.4. Jog Linear

8.17.4. Jog Linear

Jogging the TCP of a robot
1. Inthe Layout browser, select the robot you want to move.

2. Inthe Freehand group, click Jog Linear. A coordinate system will be displayed at the
TCP of the robot.

3. Click the axis you want to move and drag the TCP to the preferred position.

If you press the f key while jogging the robot linearly, the robot will move with a smaller
step size.
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8.17.5. MultiRobot Jog

Jogging robots in multirobot mode
1. Inthe Freehand group, click MultiRobot Jog. Select the robots to be jogged from the list
of available robots.

2. Select the jogging mode, jog one of the robots and the other ones will follow the
movement.
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8.18. Viewpoint

Overview

A Viewpoint stores the location and direction of a virtual camera in the 3D environment. It
stores points of interest in a station and to create camera movements during simulation.

Creating Viewpoint

You can create a viewpoint in a station in two ways:

1. Inthe Home tab, click View and select Create Viewpoint.

2. Inthe Layout browser, right-click the station and select Create Viewpoint.

A viewpoint is created and displayed (as an eye icon) in the layout browser to the left.

NOTE! The position and direction of the Viewpoint can also be visualized as an arrow in the

3D graphics.

NOTE! By default, the newly created viewpoints are not visible and cannot be selected by

clicking on the graphics.

Viewpoint functions

In the Layout browser, right-click Viewpoint to perform these function:

Function

Move to Viewpoint
Set to current

Visible

Delete

Rename

Description

Moves the active 3D view to the location stored in the viewpoint

Modifies the viewpoint to the current location and direction of
the active 3D view.

NOTE! This action cannot be undone.

Toggles the visibility of the viewpoint 3D representation
NOTE! This action cannot be undone.

Deletes the viewpoint
NOTE! This action cannot be undone.

Renames the viewpoint
NOTE! This action cannot be undone.

Continues on next page
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8.18. Viewpoint

Continued

Move to Viewpoint

You can also move active 3D view to the location stored in the Viewpoint using Event
manager.

1. Create a viewpoint. See Creating Viewpoint on page 230.

2.

N o a &

Add an event. See Event Manager on page 298
The Create new event dialog box appears.

Select Simulation under Activation and Simulation time under Event trig type. Click
Next.

Set the activation time. Click Next.

Select Move to Viewpoint from Set Actio type. Click Next.

Select the viewpoint from select Viewpoint and set the transition time.
Click Finish.

NOTE! Move to viewpoint function is also executed when replaying the simulation in a
Station Viewer.
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9.1. Overview

9 The Modeling Tab

9.1. Overview

The Modeling tab

The Modeling tab contains the controls for creating and grouping components, creating
bodies, measurements and CAD operations.
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9.2. Component Group

9.2. Component Group

Creating a component group
1. Click Component Group. The Group node will be displayed in the Layout browser.

2. Click the objects to add to the group. Drag them to the Group node.
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9.3. Empty Part

Creating an empty part
1. Click Empty Part. The Part node will be displayed in the Layout browser.
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9.4 Smart Component

9.4.1. Smart Component

Overview

Smart Component is a RobotStudio object (with or without a 3D graphical representation)
that has the behavior which can be implemented by code-behind and/or aggregation of other

Smart Components.

Terminology

The following table describes the different terminologies that you come across when working

with Smart Component.

Term
Code behind

[Dynamic] property

[Property] binding

[Property] attributes

[I/O] signal

[I/O] connection

Aggregation

Asset

Definition

A .NET class associated with a Smart Component that can
implement custom behavior by reacting to certain events, for
example simulation time steps and changes in property values.

An object attached to a Smart Component that has value, type
and certain other characteristics. The property value is used by
code behind to control the behavior of the Smart Component.

Connects the value of one property to the value of another
property.

Key-value pairs that contain additional information about a
dynamic property, for example value constraints.

An object attached to a Smart Component that has a value and
a direction (input/output), analogous to I/O signals on a robot
controller. The signal value is used by code behind to control the
behavior of the Smart Component.

Connects the value of one signal to the value of a different
signal.

The process of connecting several Smart Components using
bindings and/or connections in order to implement a more
complex behavior.

Data object contained in a Smart Component. Uses include
code behind assembly and localized resources.
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9.4.2. Smart Component Editor

Overview
The Smart Component Editor allows you to create, edit, and aggregate Smart Components
using a graphical user interface. It is an alternative to using the xml based library compiler.

Layout of a Smart Component Editor
It onsists of an icon, the name, the description for the component wherein the description can
be madified by typing in the text box, and a combo box.

The combo box specifies the language for editing localized strings (captions and descriptions)
in the component. The default language is always English, even if the application language is
different. For more information, see Assets on page 239.

The Smart Component Editor consists of the following tabs:
« The Compose tab on page 238
e The Properties and Bindings tab on page 241
« The Signals and Connections tab on page 244
e The View tab on page 247

Opening a Smart Component Editor
1. Click Smart Component or select Edit Component from the context menu.

The Smart Component Editor window appears.
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9.4.3. The Compose tab

Overview

The Compose tab consists of the following:

« Child components on page 238

« Saved States on page 239

e Assets on page 239

Child components

Itis a list box that displays all the objects contained by the component. Objects connected to
a library have an overlay that indicates that the objects are locked. Smart Components are
displayed first followed by other type of objects.

If an object is selected from the list, the following commands are displayed in the right panel:

Command

Add component

Edit parent

Disconnect from library

Export to XML

Description

Adds a child object to the component from the list.

You can select a built-in base Smart Component, a new empty
Smart Component, a library from file or a geometric part from
file. For more information about base Smart Component, see
Basic Smart Components on page 248.

Sets the context of the Editor to the parent of the component that
is currently being edited. If the parent is the station, see Station
Logic on page 304.

Disconnects the selected object from library, allowing it to be
edited.

Saves the component as a Component XML File (*.rsxml)

Right-click on the selected object to display the following context menu items

Iltem

Edit

Delete

Show in Browser

Set as Role

Properties

Description

Sets the context of the Editor to the selected child object.
Deletes the child object.

Indicates if the object should be displayed in the Layout
browser.

Sets the object as the Role of the component. The Smart
Component will inherit certain characteristics of the Role object.
For example, attaching a component with a tool as Role to a
robot will cause a ToolData to be created.

Opens the Property editor dialog box for the object. See
Property Editor on page 265.

Continues on next page
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9.4.3. The Compose tab

Continued

Saved States
The state of the component can be saved to be restored later. The state contains selected
modifiable aspects of the component and its child components at the time when the state was
saved. The following commands are available:

Command Description

Save Current State Opens the Save Current State dialog box. See Save Current
State on page 239.

Restore Selected State Restores the component to the selected state.

Details Opens a window that displays detailed information about the
selected state.

Delete Deletes the selected state.

Save Current State
1. Inthe Name text box, enter a name for the state. If a state with the same name already
exists, you will be asked to overwrite the existing state.

2. In the Description text box, enter the description for the state.
In the Values to save, select the value to be saved.
4. RecursiveSelect the check box to save the state of all child components.

NOTE!
When working on a station level,

« Inthe Values to save, you can also select certain Virtual Controller values in the saved
states.

* You need not select the option Recursive as the state of the station is always saved.

For more information, see Station Logic on page 304.

Assets
The assets contained in the component are displayed as grid.
The following commands are available:

Command Description

Add Asset Opens a dialog box and allows you to browse and select any file
as an asset.

Set Icon Opens a dialog box and allows you to browse and select an

image that represents a Smart Component.

Update All Assets Replaces the data of all the assets with the data of the corre-
sponding file on the disk. If the file is not available, a warning
message is displayed in the output window.

View Opens the selected asset in the associated program
Save Opens a dialog box and allows you to save the selected asset.
Delete Deletes the selected asset.

Continues on next page
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9.4.3. The Compose tab

Continued

NOTE!

H The text resources (descriptions) for properties and signals are stored in an asset called
Resources.<language-id>.xml. If this is deleted, the texts for that language will be empty and
the default (English) will be used. The default language when authoring a component is
always English, regardless of the application language.
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9.4.4. The Properties and Bindings tab

9.4.4. The Properties and Bindings tab

Overview
The Properties and Bindings tab consists of the following:

« Dynamic Properties on page 241

« Property Bindings on page 242

Dynamic Properties
The dynamic properties contained in the component are displayed in a grid.
The following commands are available
Command Description

Add Dynamic Property Opens the Add Dynamic Property dialog box. See Add or Edit
Dynamic Property on page 241.

Expose Child Property Opens the Expose Child Property dialog box. See Expose Child
Property on page 242.

Edit Opens the Edit Dynamic Property dialog box for the selected
property.
Delete Deletes the selected property.

Add or Edit Dynamic Property
The Add Dynamic Property dialog box allows you to create a new dynamic property or edit
an existing property.

The following controls are available:

Control Description
Property Identifier Specifies an identifier for the property. The identifier must be
alphanumeric, start with a letter and must be unique.
Description Detailed description of the property.
Read-only Indicates if the property value should be possible to modify in
GUI such as the Property Editor.
Property Type Specifies the type of the property from a list of allowed types.
Property Value Specifies the value of the property. The control is updated when
you change the property type and/or attributes.
Attributes Allows you to add, remove, and modify property attributes.
The following lists the available attributes:
e MinValue
e MaxValue
e Quantity
e Slider
e AutoApply

NOTE! Numeric attributes are specified in S| units.

NOTE: When editing an existing property, the Identifier and Type controls are locked and
cannot be modified. If the input is valid the OK button is enabled, allowing the you to add or
update the property. If not, an error icon is displayed.

Continues on next page
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Continued

Expose Child Property

The Expose Child Property dialog box allows you to add a new property and bind to an
existing property in a child object. The new property will have the same type and attributes

as the child property.

The following controls are available:

Control

Property Identifier

Binding Direction
Source or Target Object

Source or Target
Property

Description

Identifier of the new property. By default, this is the same as the
identifier of the selected child property.

Specifies the direction of the property binding
Specifies the child object for which to expose a property.
Specifies the child property.

Property Bindings

The property bindings contained in the component are displayed in a grid.

The following commands are available:

Command

Add Binding
Add Expression Binding
Edit

Delete

Add or Edit Binding

Description

Opens the Add Binding dialog box.
Opens the Add Expression Binding dialog box.

Opens the Edit Binding or Edit Expression Binding dialog box,
depending on the type of binding selected.

Deletes the selected binding.

The Add Binding dialog box allows you to create or edit a property binding.

The following options are available:

Control

Source Object
Source Property
Target Object
Target Property

Allow cyclic binding

Description

Specifies the owner of the source property.
Specifies the source of the binding.
Specifies the owner of the target property.

Specifies the target of the binding.

NOTE! Only properties of the same type as the source property
type are listed.

Allows the target property to be set two times in the same
context, which otherwise generates an error.

NOTE! The target list box, besides dynamic properties also
displays some common properties such as object transform that
can only be used as target and not as source.

Continues on next page
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Add or Edit Expression Binding

9.4.4. The Properties and Bindings tab

Continued

The Add Expression Binding dialog box allows you to specify a mathematical expression
as the source of a property binding.

The following controls are available:

Control

Expression

Target Object
Target Property

Description

Specifies the mathematical expressions.

The following lists the allowable mathematical expressions:
« Allowed operators: +, - (unary and binary) *, /,
(power), Sin(), Cos(), Sqgrt(), Atan() and Abs().

* Allowed operands: Numeric constants, PI, and
Numeric dynamic properties on the current smart
component and any child smart components.

NOTE! The text box has the IntelliSense-like funtionality which
allows you to select from the available properties. If the
expression entered in the text box is invalid, an error icon is
displayed.

Specifies the owner of the target property.

Specifies the target of the binding.
NOTE! Only numeric properties are listed.
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9.4.5. The Signals and Connections tab

Overview
The Signals and Connections tab consists of the following:
« 1/O Signals on page 244
e 1/O Connections on page 245
I/O Signals

Add or Edit I/O signals

The 1/O Signals contained in the component are displayed in a grid.

The following commands are available:

Command

Add 1/O Signals

Expose Child Signal

Edit
Delete

Description

Opens the Add I/O Signals dialog box.
Opens the Expose Child Signal dialog box.
Opens the Edit Signal dialog box.

Deletes the selected signal.

The Add 1/0O Signals dialog box allows you to edit an I/O signal, or add one or more 1/O

signals to the component.

The following controls are available:

Control

Type of Signal

Signal Base Name

Signal Value
Description

Auto-reset
Number of Signals
Start Index

Step
Minimum

Maximum

Hidden

Description

Specifies the type and direction of the signal.
The following are the available types of signals:

» Digital
e Analog
 Group

Specifies the name of the signal.

The name must contain an alphanumeric character and start
with a letter (a-z or A-Z).

NOTE! If more than one signal is created, numeric suffixes
specified by Start Index and Step are added to the names.

Specifies the initial value of the signal.

Text that describes the signal. When creating multiple signals,
all will have the same description.

Specifies that a digital signal should have transient behavior.

NOTE! This applies to digital signals only. Indicates that the
signal value is automatically reset to 0.

Specifies the number of signals to create.
Specifies the first suffix when creating multiple signals.
Specifies the suffix interval when creating multiple signals.

Specifies the minimum value for an analog signal.
NOTE! This applies to Analog signal only.
Specifies the maximum value for an analog signal.
NOTE! This applies to Analog signal only.

Indicates if the property should not be visible in GUI such as the
Property Editor and 1/O Simulator.

Continues on next page
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Control

Read only

9.4.5. The Signals and Connections tab

Continued

Description

Indicates if the property value should be possible to modify in
GUI such as the Property Editor and 1/0O Simulator.

NOTE! When editing an existing signal, only the Signal VValue and Description can be
modified, while all other controls are locked.

If the input is valid,OK is enabled allowing you to create or update the signal. If not, an error

icon is displayed.

Expose Child signal

The Expose Child Signal dialog box allows you to add a new 1/O signal that is connected to

a signal in a child object.

The following controls are available:

Control

Signal Name

Child Object
Child Signal

Description

Specifies the name of the signal to be created. By default, it is
the same as the name of the selected child signal.

Specifies the object for which to expose a signal.
Specifies the child signal.

I/O Connections

The 1/O Connections contained in the component are displayed in a grid.

The following controls are available:

Control

Add I/0 Connection

Edit

Manage I/O Connections
Delete

Move Up or Move Down

Add or Edit /0O Connection

Description

Opens the Add I/O Connection dialog box.
Opens the Edit 1/0 Connection dialog box.
Opens the Manage I/0 Connections dialog box.
Deletes the selected connection.

Sorts by moving the selected connections up and down the list.

The Add 1/O Connection dialog box allows you to create an I/O connection or edit an

existing connection.

The following controls are available:

Control

Source Object
Source Signal

Target Object
Target Signal

Allow cyclic connection

Description

Specifies the owner of the source signal.

Specifies the source of the connection. The source must either
be an output from a child component, or an input to the current
component.

Specifies the owner of the target signal.

Specifies the target of the connection. The target must be of the
same type as the source, and either an input to a child
component or an output from the current component.

Allows the target signal to be set two times in the same context,
which would otherwise generate an error.

Continues on next page
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Continued

Manage I/O Connections
The Manage 1/0 Connections dialog box displays a graphical view of the I/O connections of

the component.

It allows you to add, remove, and modify connections. Only digital signals are displayed.

The following controls are available:

Control

Source / Target Signals

Connections
Logic Gates

Add

Remove

Managing I/O connections
Use this procedure to add, remove, and create new I/O connections:

1. Click Add and select Add Source or Add Target or Add Logic Gate to add a source
signal or target signal or logic gate respectively.

Description

Lists the signals used in the connections, source signals to the
left and target signals to the right. Each signal is specified by the
owner object and the signal name.

Displays connections as an arrow from source to target

Specifies a logic operator and a delay time. It performs digital
logic on input signals.

e Add Source - Adds a source signal to the left.
e Add Target - Adds a target signal to the right.
e Add Logic Gate - Adds a logic gate at the center

Removes the selected signal, connection or logic gate.

2. Move the cursor towards the Source Signal until a cross hair appears.

3. Click and drag the left mouse button towards the logic gate to create a new 1/O

connection.

4. Select the signal, connection, or logic gate and click Remove to delete.
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9.4.6. The View tab

9.4.6. The View tab

Overview
The View tab displays a graphical view of the structure of the component. It includes the child
components, internal connections, and bindings.
The Smart Component can be organized on the viewing screen and their viewing position will

be stored with the station.The view can be zoomed using a slider. Connections and bindings
are color coded.

NOTE!
H This tab requires.NET Framework 3.5 SP1to be installed, if not a blank page is displayed.
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9.4.7. Basic Smart Components

Overview

The base components represent a complete set of basic building block components. They can
be used to build user defined Smart Components with more complex behavior.

This lists the basic Smart Components available and are described in the following sections:
< Signals and Properties on page 248
e Parametric Primitives on page 252
e Sensors on page 254
e Actions on page 257
e Manipulators on page 259
e Other on page 261

Signals and Properties

LogicGate
The signal Output is set by the logical operation specified in Operator of the two signals
InputAand InputB, with the delay specified in Delay.
Properties Description
Operator The logical operator to use.
The following lists the various operators:
e AND
« OR
¢ XOR
« NOT
« NOP
Delay Time to delay the output signal.
Signals Description
InputA The first input.
InputB The second input.
Output The result of the logic operation.
LogicMux

Output is set according to: Output = (Input A * NOT Selector) + (Input B * Selector)

Signals Description

Selector When low, the first input is selected.
When high, the second input is selected.

InputA Specifies the first input.
InputB Specifies the second input.
Output Specifies the result of the operation.

Continues on next page
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LogicSplit

LogicSRLatch

Converter

9.4.7. Basic Smart Components

Continued

The LogicSplit takes Input and sets OutputHigh to the same as Input, and OutputLow as the

inverse of Input.

PulseHigh sends a pulse when Input is set to high, and PulseLow sends a pulse when Input is

set to low.

Signals
Input
OutputHigh
OutputLow
PulseHigh
PulseLow

Description

Specifies the input signal.

Goes high (1) when input is 1.

Goes high (1) when input is 0.

Sends pulse when input is set to high.

Sends pulse when input is set to low.

TheLogicSRLatch has one stable state.
e When Set=1, Output=1 and InvOutput=0
¢ When Reset=1, Output=0 and InvOutput=1

Signals
Set

Reset
Output
InvOutput

Description

Sets the output signal.

Resets the output signal.
Specifies output signal.
Specifies Inverse output signal.

Converts between property values and signal values.

Properties

AnalogProperty
DigitalProperty
GroupProperty
BooleanProperty

Signals
Digitallnput
DigitalOutput
Analoglnput
AnalogOutput
Grouplnput
GroupOutput

Description

Converts to AnalogOutput.

Converts to DigitalOutput.

Converts to GroupOutput.

Converts from Digitallnput and to DigitalOutput.

Description

Converts to DigitalProperty.
Converted from DigitalProperty.
Converts to AnalogProperty.
Converted from AnalogProperty.
Converts to GroupProperty.
Converted from GroupProperty.

Continues on next page
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Continued
VectorConverter
Converts between Vector3 and X, Y,and Z values.
Properties Description
X Specifies the X-value of Vector.
Y Specifies the Y-value of Vector.
Z Specifies the Z-value of Vector
Vector Specifies the vector value..
Expression
The Expression consists of numeric literals (including PI), parentheses, mathematical
operators +,-,* ./~ (power) and mathematical functions sin, cos, sqrt, atan, abs. Any other
strings are interpreted as variables, which are added as additional properties. The result is
displayed in Result.
Signals Description
Expression Specifies the expression to evaluate.
Result Specifies the result of evaluation.
NNN Specifies automatically generated variables.
Comparer

The Comparer compares First value with Second value, using Operator. Output is set to 1 if
the condition is met.

Properties Description

ValueA Specifies the first value.

ValueB Specifies the second value.
Operator Specifies the comparison operator.

The following lists the various operators:

. >
. >=
. <
3 <=
Signals Description
Output True if the comparison evaluates to true, otherwise false.

Continues on next page
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Counter

9.4.7. Basic Smart Components

Continued

Count is increased when the input signal Increase is set, and decreased when the input signal
Decrease is set. Count is reset when the input signal Reset is set.

Properties

Count

Signals

Increase
Decrease
Reset

Repeater

Description

Specifies the current count.

Description
Adds one to the Count when set to True.
Subtracts one from the Count when set to True.

Resets the Count to zero when set to high.

Pulses Output signal Count number of times.

Properties

Count

Signals

Execute
Output

Timer

Description

Number of times to pulse Output.

Description

Set to high (1) to pulse Output Count times.
Output pulse.

The Timer pulses the Output signal based on the given interval.

If Repeat is unchecked, one pulse will be triggered after the time specified in Interval.
Otherwise, the pulse will be repeated at the interval given by Interval.

Properties
StartTime

Interval
Repeat
Current time

Signals

Active
Output

Description

Specifies the time to pass before the first pulse.

Specifies the simulation time between the pulses.

Specifies if the signal should be pulsed repeatedly or only once.
Specifies the current simulation time.

Description

Set to True to activate the timer, and False to deactivate it.

Sends pulses at the specified time intervals.

Continues on next page
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Continued

StopWatch

The StopWatch measures time during simulation (TotalTime). A new lap can be started by
triggering the Lap input signal. LapTime shows the current lap time. The time is only
measured when Active is set to 1. The times are reset when the input signal Reset is set.

Properties
TotalTime
LapTime
AutoReset

Signals
Active
Reset
Lap

Description

Specifies the accumulated time.
Specifies the current lap time.

If true, TotalTime and LapTime will be set to 0 when the
simulation starts.

Description

Set to True to activate the stop watch, and False to deactivate it.
Resets Total time and Lap time when set to high.
Starts a new lap.

Parametric Primitives

ParametricBox

ParametricCircle

The ParametricBox generates a box with dimensions specified by length, width, and height.

Properties

SizeX
SizeY
Sizez
GeneratedPart
KeepGeometry

Signals
Update

Description

Specifies the length of the box in the X-axis direction.
Specifies the length of the box in the Y-axis direction.
Specifies the length of the box in the Z-axis direction
Specifies the generated part.

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

Description

Set to high (1) to update the generated part.

The ParametricCircle generates a circle with a given radius.

Properties

Radius

GeneratedPart
GeneratedWire
KeepGeometry

Signals
Update

Description

Specifies the radius of the circle.
Specifies the generated part.
Specifies the generated wire object.

False to remove the geometry data from the generated part.
This can make other components such as Source execute faster

Description

Set to high (1) to update the generated part.

Continues on next page
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ParametricCylinder

ParametricLine

LinearExtrusion

9.4.7. Basic Smart Components

Continued

The ParametricCylinder generates a cylinder with the dimensions given by Radius and

Height.

Properties

Radius
Height
GeneratedPart

KeepGeometry

Signals

Update

Description

Specifies the radius of the cylinder.
Specifies the height of the cylinder.
Specifies the generated part.

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

Description

Set to high (1) to update the generated part.

The ParametricLine generates a line with a given end point or a given length. If either of them
is changed, the other one will be updated accordingly.

Properties

EndPoint
Length
GeneratedPart
GeneratedWire

KeepGeometry

Signals
Update

Description

Specifies the end point for the line.
Specifies the length of the line.
Specifies the generated part.
Specifies the generated wire object.

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

Description

Set to high (1) to update the generated part.

The LinearExtrusion extrudes SourceFace or SourceWire along the vector given by

Projection.

Properties
SourceFace
SourceWire
Projection
GeneratedPart
KeepGeometry

Description

Specifies the face to extrude.
Specifies the wire to extrude.
Specifies the vector to extrude along.
Specifies the generated part.

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

Continues on next page
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Continued

CircularRepeater

LinearRepeater

The CircularRepeater creates a number of given copies of Source around the center of the
SmartComponent with a given DeltaAngle.

Properties Description

Source Specifies the object to copy.

Count Specifies the number of copies to create.
Radius Specifies the radius of the circle.
DeltaAngle Specifies the angle between the copies.

The LinearRepeater creates a number of copies of Source, with the spacing and direction
given by Offset.

Properties Description
Source Specifies the object to copy.
Offset Specifies the distance between copies.
Count Specifies the number of copies to create.
MatrixRepeater
The MatrixRepeater creates a specified number of copies in three dimensions, with the
specified spacing of the object in Source.
Properties Description
Source Specifies the object to copy.
CountX Specifies the number of copies in the X-axis direction.
CountY Specifies the number of copies in the Y-axis direction.
Countz Specifies the number of copies in the Z-axis direction.
OffsetX Specifies the offset between the copies in the X-axis direction.
OffsetY Specifies the offset between the copies in the Y-axis direction.
Offsetz Specifies the offset between the copies in the Z-axis direction.
Sensors

CollisionSensor

The CollisionSensor detects collisions and near miss events between the First object and the
Second object. If one of the objects is not specified, the other will be checked against the
entire station. When the Active signal is high and a collision or a near miss event occurs and
the component is active, the SensorOut signal is set and the parts that participate in the
collision or near miss event are reported in the first colliding part and second colliding partof
the Property editor.

Properties Description

Objectl The first object to check for collisions.
Object2 The second object to check for collisions.
NearMiss Specifies the near miss distance.

Continues on next page
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LineSensor

PlaneSensor

Properties

Partl
Part2
CollisionType

Signals

Active

SensorOut

9.4.7. Basic Smart Components

Continued

Description

The part of First object that has a collision.
The part of Second object that has a collision.

* None

¢ Near miss

¢ Collision
Description

Specifies if the CollisionSensor is active or not.

True if there is a NearMiss or Collision.

The LineSensor defines a line by the Start, End, and Radius. When an Active signal is high,
the sensor detects objects that intersect the line. Intersecting objects are displayed in the
ClosestPart property and the point on the intersecting part that is closest to the line sensors
start point is displayed in the ClosestPoint property. When intersection occurs the SensorOut

output signal is set.

Properties

Start

End

Radius
SensedPart

SensedPoint

Signals

Active
SensorOut

Description

Specifies the start point.
Specifies the end point.
Specifies the radius.

Specifies the part that intersects the line sensor.

If several parts intersect, then the one closest to theStart point is
listed.

Specifies the point on the intersecting part, closest to the Start
point.

Description

Specifies if the LineSensor is active or not.
True if the sensor intersects with an object.

The PlaneSensor defines a plane by Origin, Axis1, and Axis2. When the Active input signal
is set the sensor detects objects that intersect this plane. Intersecting objects are displayed in
the SensedPart property and when intersection occurs the SensorOut output signal is set.

Properties
Origin
Axisl
Axis2
SensedPart

Description

Specifies the origin of the plane.
Specifies the first axis of the plane.
Specifies the second axis of the plane.

Specifies the part that intersects the PlaneSensor.

If several parts intersect, then the one listed first in the Layout
browser is selected.

Continues on next page
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Continued

Signals

Active
SensorOut

PositionSensor

Description

Specifies if the PlaneSensor is active or not.
True if the sensor intersects with an object.

The PositionSensor monitors the position and orientation of an object.

NOTE! The position and orientation of an object is updated only during the simulation.

Properties
Object
Reference
ReferenceObject
Position
Orientation

ClosestObject

Description

Specifies the object to monitor.

Specifies the reference coordinate system (Parent or Global).
Specifies the reference object, if Reference is set to Object.
Specifies the position of the object relative to Reference.

Specifies the orientation (Euler ZYX) relative to Reference.

The ClosestObject defines a Reference object or a Reference point. When the Execute signal
is set, the component finds the ClosestObject, ClosestPart, and the Distance to the reference
object, or to the reference point if the reference object is undefined. If RootObject is defined,
the search is limited to that object and its descendants. When finished and the corresponding
properties are updated the Executed signal is set.

Properties

ReferenceObject
ReferencePoint
RootObject

ClosestObject
ClosestPart

Distance

Signals

Execute
Executed

Description

Specifies the object to get the closest object to.
Specifies the point to get the closest object to.

Specifies the object whose children to search.
Empty means entire station.

Specifies the object closest to Reference object or Reference
point.

Specifies the part closest to Reference object or Reference
point.

Specifies the distance between the Reference object and the
Closest object.

Description

Set to True to find the Closest part.
Sends a pulse when completed.

Continues on next page
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Continued

Actions
Attacher
The Attacher will attach Child to Parent when the Execute signal is set. If the Parent is a
mechanism, the Flange to attach to must also be specified. When the input Execute is set, the
child object is attached to the parent object. If Mount is checked, the child will also be
mounted on the parent, with the Offset and Orientation specified. The output Executed will
be set when finished.
Properties Description
Parent Specifies the object to attach to.
Flange Specifies the Index of mechanism flange to attach to.
Child Specifies the object to attach.
Mount If true, the object to attach mounts on the attachment parent.
Offset Specifies the position relative to the attachment parent when
using Mount.
Orientation Specifies the orientation relative to the attachment parent when
using Mount.
Signals Description
Execute Set to True to attach.
Executed Sends a pulse when completed.
Detacher

The Detacher will detach the Child from the object it is attached to when the Execute signal
is set. If Keep position is checked, the position will be kept. Otherwise the child is positioned
relative to its parent. When finished, the Executed signal will be set.

Properties Description

Child Specifies the object to detach.

KeepPosition If false, the attached object is returned to its original position.
Signals Description

Execute Set to True to remove the attachment.

Executed Sends a pulse when completed.

Continues on next page
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Continued

Source

Sink

Show

The Source property of the source component indicates the object that should be cloned when
the Execute input signal is received. The parent of the cloned objects is specified by the Parent
property and a reference to the cloned object is specified by the Copy property. The output
signal Executed signifies that the clone is complete.

Properties
Source

Copy
Parent

Position
Orientation
Transient

Signals

Execute
Executed

Description

Specifies the object to copy.
Specifies the copied object.

Specifies the parent to the copy.
If not specified, the copy gets the same parent as the source.

Specifies the position of the copy relative its parent.
Specifies the orientation of the copy relative its parent.

Marks the copy as transient if created during simulation. Such
copies are not added to the undo queue and are automatically
deleted when the simulation is stopped. This is used to avoid
increased memory consumption during simulation.

Description

Set to True to create a copy of the object.
Sends a pulse when completed.

The Sink deletes the object referenced by the Object property. Deletion happens when the
Execute input signal is received. The Executed output signal is set when the deletion is

finished.

Properties

Object

Signals

Execute
Executed

Description

Specifies the object to remove.

Description

Set to True to remove the object.
Sends a pulse when completed.

When the Execute signal is set, the object referenced in Object appears. When finished,

Executed signal will be set.

Properties
Object

Signals

Execute
Executed

Description

Specifies the object to show.
Description

Set to True to show the object.
Sends a pulse when completed.

Continues on next page
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Continued

When the Execute signal is set, the object referenced in Object will be hidden. When finished,

Executed signal will be set.

Properties
Object

Signals

Execute
Executed

Description

Specifies the object to hide.

Description

Set to True to hide the object.
Sends a pulse when completed.

Manipulators

LinearMover

The LinearMover moves the object referenced in the Object property with a speed given by
the Speed property in the direction given by the Direction property. The motion starts when
the Execute input signal is set and stops when Execute is reset.

Properties

Object
Direction
Speed
Reference

ReferenceObject

Signals

Execute

Rotator

Description

Specifies the object to move.
Specifies the direction to move the object.
Specifies the speed of movement.

Specifies the coordinate system in which values are specified. It
can be Global, Local, or Object.

Specifies the reference object, if Reference is set to Object.

Description

Set to True to start move the object, and False to stop.

The Rotator rotates the object referenced in the Object property with an angular speed given
by the Speed property. The axis of rotation is given by CenterPoint and Axis. The mation
starts when the Execute input signal is set and stops when the Execute is reset.

Properties
Object
CenterPoint
Axis

Speed
Reference

ReferenceObject

Description

Specifies the object to rotate.
Specifies the point to rotate around.
Specifies the axis of the rotation.
Specifies the speed of the rotation.

Specifies the coordinate system in which values are specified. It
can be Global, Local, or Object.

Specifies the object which are relative to CenterPoint and Axis,
if Reference is set to Object.

Continues on next page
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Continued

Signals

Execute

Positioner

Description

Set to True to start rotating the object, and False to stop.

The Positioner takes an Object, Position, and Orientation as properties. When the Execute
signal is set the object is repositioned in the given position relative to the Reference. When
finished the Executed output is set.

Properties

Object
Position
Orientation
Reference

ReferenceObject

Signals

Execute
Executed

PoseMover

Description

Specifies the object to position.
Specifies the new position of the object.
Specifies the new orientation of the object.

Specifies the coordinate system in which values are specified. It
can be Global, Local, or Object.

Specifies the object which are relative to Position and Orienta-
tion, if Reference is set to Object.

Description

Set to True to start move the object, and False to stop.
Set to 1 when operation is completed.

The PoseMover has a Mechanism, a Pose, and Duration as properties. When the Execute
input signal is set the mechanism joint values are moved to the given pose. When the pose is
reached the Executed output signal is set.

Properties

Mechanism
Pose
Duration

Signals

Execute
Pause
Cancel
Executed
Executing
Paused

Description

Specifies the mechanism to move to a pose.
Specifies the Index of the pose to move to.
Specifies the time for the mechanism to move to the pose.

Description

Set to True, to start or resume moving the mechanism.
Pauses the movement.

Cancels the movement.

Pulses high when the mechanism has reached the pose.
Goes high during the movement.

Goes high when paused.

Continues on next page
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Continued
JointMover
The JointMover has a Mechanism, a set of Joint Values and a Duration as properties. When
the Execute input signal is set the mechanism joint values are moved to the given pose. When
the pose is reached the Executed output signal is set. The GetCurrent signal retrieves the
current joint values of the mechanism.
Properties Description
Mechanism Specifies the mechanism to move to a pose.
Relative Specifies if J1-Jx are relative to the start values, rather than
absolute joint values.
Duration Specifies the time for the mechanism to move to the pose.
J1 - Jx Joint values.
Signals Description
GetCurrent Retrieve current joint values.
Execute Set to True to start moving the mechanism.
Pause Pauses the movement
Cancel Cancels the movement
Executed Pulses high when the mechanism has reached the pose.
Executing Goes high during the movement.
Paused Goes high when paused.
Other
GetParent
The GetParent return the parent object of the input object. The executed signal is triggered if
a parent is found.
Properties Description
Child Specifies the object to whose parent is to be found.
Parent Specifies the parent of the child
Signals Description
Output Goes high (1) if the parent exists.
GraphicSwitch

Switches between two parts, either by clicking on the visible part in the graphics or by setting
and resetting the input signal.

Properties

PartHigh
PartLow

Signals
Input

Description

Displayed when the signal is high.
Displayed when the signal is low.

Description

Input signal.
Continues on next page
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Signals
Output

Highlighter

Description

Output signal.

The Highlighter temporarily sets the color of the Object to the RGB-values specified in Color.
The color is blended with the original color of the objects as defined by Opacity When the
signal Active is reset, Object gets its original colors.

Properties

Object
Color
Opacity

Signals

Active

Logger

Description

Specifies the object to highlight.
Specifies the RGB-values of the highlight color.

Specifies the amount to blend with the object's original color (O-
255).

Description

True sets the hightlight. False restores the original color.

Prints a message in the output window.

Properties

Format

Message
Severity

Signals

Execute

MoveToViewPoint

Description

Format string.

Supports variables like {id:type}, where type can be d (double),
i (int), s (string), o (object)

Formatted message.
Message severity: 0 (Information), 1 (Warning), 2 (Error).

Description

Set to high (1) to print the message.

Moves to the selected viewpoint in the given time, when the input signal Execute is set. The
output signal Executed is set when the operation is completed.

Properties
Viewpoint
Time

Signals

Execute
Executed

Description

Specifies the viewpoint to move to.
Specifies the time to complete the operation.

Description

Set to high (1) to start the operation.
Goes high (1) when the operation is completed.

Continues on next page
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Continued

Determines if ObjectA is the same as ObjectB.

Properties

ObjectA
ObjectB

Signals

Output

Queue

Description

Specifies the object to compare.

Specifies the object to compare.

Description

Goes high if the objects are equal.

The Queue represents a FIFO (first in, first out) queue. The object in Back is added to the
gueue when the signal Enqueue is set. The front object of the queue is shown in Front. The
object in Front is removed from the queue when the signal Dequeue is set. If there are more
objects in the queue, the next object is shown in Front. All objects in the queue are removed
from the queue when the signal Clear is set.

If a transformer component (such as LinearMover) has a queue component as its Object, it
will transform the contents of the queue, rather than the queue itself.

Properties

Back

Front

Queue
NumberOfObjects

Signals

Enqueue
Dequeue
Clear
Delete

DeleteAll

SoundPlayer

Description

Specifies the object to enqueue.

Specifies the first object in queue.

Contains unique IDs of the queue’s elements.
Specifies the number of objects in the queue.

Description

Adds the object in Back to the end of the queue.
Removes the object in Front from the queue.
Removes all objects from the queue.

Removes the object in Front from the queue and from the
station.

Clears the queue and removes all objects from the station

Plays the sound specified by Sound Asset when the input signal Execute is set. The asset must

be a .wav file

Properties

SoundAsset

Signals

Execute

Description

Specifies the sound file that should be played. Must be a .wav
file.

Description

Set to high to play the sound.

Continues on next page
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Continued

StopSimulation

Stop a running simulation when the input signal Execute is set.

Signals

Execute

Random

Description

Set to high to stop the simulation.

Random generates a random number between Min and Max in Value when Execute is

triggered.

Properties
Min

Max

Value

Signals

Execute
Executed

Description

Specifies minimum value.
Specifies maximum value.
Specifies a random number between Min and Max.

Description

Set to high to generate a new random number.

Goes high when the operation is completed.
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9.4.8. Property Editor

Overview

The Property editor is used to modify the values of dynamic properties and 1/O signals for a
Smart Component. By default, the Property editor is displayed as a tool window to the left.

Each dynamic property is represented by a control. The type of control that is displayed
depends on the property type and property attributes.

Properties with the Hidden flag set to true are not displayed. Read-only properties cannot be
modified but are only displayed.

The values are validated according to the property attributes. If an invalid value is entered, an
error icon is displayed next to the control and the Apply button is disabled.

If you set the AutoApply attribute of a property to true, the value is applied whenever you
change the value in the control. You can apply the values of other properties by clicking the
Apply button. If the component has no properties without AutoApply, then the Apply button
will never be enabled.

You can toggle the value of a digital signal by clicking the control. Similarly, you can change
the value of an analog or group signal by entering the new value in the text box.

Opening the Property editor

You can open the Property editor dialog box in any one of the following ways:
« Right-click context menu for a Smart Component and select Properties.
» Launches automatically when the Smart Component Editor is started.

« Launched when you add a base component. See Basic Smart Components on page
248.
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9.4.9. The Simulation Watch window

Overview
The Simulation Watch allows you to monitor the values of dynamic properties and 1/0 signals
in Smart Components. It specifies the simulation that should be paused when a value changes
or meets a condition.

Layout of the Simulation Watch window
The Simulation Watch window by default takes the lower tab area in the RobotStudio GUI.

The window contains a list view of four columns with one row for each watch item:

Watch item Description
Break Specifies the Simulation break point and Break Condition.
For more information, see Setting Breakpoints on page 267.
Object Specifies the object that owns the property or signal (for station
signals the name of the station is displayed).
Property/Signal Specifies the watched property or signal.
Value Specifies the current value of the property or signal.

Adding and Deleting the Watch items
Use this procedure to add or delete a watch item.

NOTE!
H As a prerequisite, you should add smart component, its properties and signals. For more
information, see Smart Component Editor on page 237.

1. Inthe Simulation Watch window, right-click and select Add to display the Add
submenu.

The Add submenu displays a recursive view of all the smart components, their properties
and signals. The top level submenu displays the station signals.

NOTE!
Watch items that are already watched are not displayed in the recursive view.

2. From the Add submenu, select property or signal to add a single property or signal of a
component.

Continues on next page
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3. From the Add submenu, select Add all to add all the properties and signals of a
component.

4. In the Simulation Watch window, right-click on the row of the watch item and select
Delete to delete one or more watch items.

NOTE!
The Watch items are saved in the station and are restored when the station is opened.

Setting Breakpoints
You can set the breakpoint in one of the following ways:

1. To set the simulation breakpoint, select the check box next to a watch item.

NOTE!
By default, the simulation is paused whenever the value of the property or signal changes.

2. In the Simulation Watch window, right-click on the row of the watch item and select
Break Condition.

The Break Condition dialog box appears.

» Set the simulation to paused, when the value meets a certain logical condition. The
condition can be viewed in the Break column of the Watch window.

< When a breakpoint is reached, the simulation is paused which is indicated by both the
Play and Stop buttons being enabled.

e If the Simulation Watch window is hidden behind the other windows, it is brought to
the front and the text of the corresponding watch item turns red.

NOTE!

« Break condition can be specified only for the properties of numeric and string types,
and not for the object types.

« After the current simulation time step is completed, all the remaining Smart
component events are executed before the simulation is actually paused.
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9.5. Solid

Creating a solid

1. Click Solid and then click the type of solid you want to create to bring up a dialog box.

2. Enter requested values in

in the dialog box and click Create. For detailed information

about the specific dialog box for the curve to create, see below:

The Create Box dialog box

xx0600002655

Reference

Corner Point (A)

Orientation

Length (B)
Width (C)
Height (D)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the corner pointin the
graphics window to transfer the values to the Corner Point
boxes, or type the position. The corner point will be the local
origin of the box.

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Specify the box dimension along its X axis.
Specify the box dimension along its Y axis.

Specify the box dimension along its Z axis.

The Create Box from 3-Points dialog box

>

xx0600002662

Reference

Corner Point (A)

Select the Reference coordinate system to which all positions
or points will be related.

This point will be the local origin of the box.

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

Continues on next page
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Point on diagonal of XY-
plane (B)

Indication Point Z-axis

©

9.5. Solid

Continued

This point is the the corner, diagonal to the local origin. It sets
the X and Y directions of the local coordinate system, as well as
the dimension of the box along these axes.

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

This point is the corner above the local origin, It sets the Z
direction of the local coordinate system, as well as the
dimension of the box along the Z axis.

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

The Create Cone dialog box

xx0600002663

Reference

Base Center Point (A)

Orientation

Radius (B)
Diameter
Height (C)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the cone.

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Specify the radius of the cone.
Specify the diameter of the cone.
Specify the height of the cone.

Continues on next page
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The Create Cylinder dialog box

xx0600002664

Reference

Base Center Point (A)

Orientation

Radius (B)
Diameter
Height (C)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the cylinder.

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Specify the radius of the cylinder.
Specify the diameter of the cylinder.
Specify the height of the cylinder.

The Create Pyramid dialog box

xx0600002667

Reference

Base Center Point (A)

Orientation

Center to Corner Point
(B)

Height (C)

Number of Sides

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the pyramid.

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Either type the position, or click in the box and then select the
point in the graphics window.

Specify the height of the pyramid.

Specify the number of sides of the pyramid. The maximum
number of sides is 50.

Continues on next page
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Continued
The Create Sphere dialog box
xx0600002668
Reference Select the Reference coordinate system to which all positions
or points will be related.
Center Point (A) Click in one of these boxes, and then click the center point in the

graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the sphere.

Radius (B) Specify the radius of the sphere.
Diameter Specify the diameter of the sphere.
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9.6. Surface

Creating a surface

1. Click Surface and then click the type of solid you want to create to bring up a dialog box.

2. Enter requested values in in the dialog box and click Create. For detailed information
about the specific dialog box for the curve to create, see below:

The Create Surface Circle dialog box

xx0600002669

Reference

Center Point (A)

Orientation

Radius (B)
Diameter

Select the Reference coordinate system, to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the circle.

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Specify the radius of the circle.
Specify the diameter of the circle.

The Create Rectangle dialog box

C
A <
B
xx0600002671
Reference

Start Point (A)

Orientation

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Start Point boxes,
or type the position. The start point will be the local origin of the
rectangle.

If the object shall be rotated relative the reference coordinate
system, specify the rotation.

Continues on next page
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Length (B)
Width (C)

9.6. Surface

Continued

Specify the length of the rectangle.
Specify the width of the rectangle

The Create Surface Polygon dialog box

xx0600002670

Reference

Center Point

First Vertex Point

Vertices

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the polygon.

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

Specify the number of the vertices here. The maximum number
of vertices is 50.

The Create Surface from Curve dialog box

Select Curve from
graphics

Select a curve by clicking it in the graphics window.
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9.7. Curve

Creating a curve

1. Click Curve and then click the curve you want to create to bring up a dialog box.

2. Enter requested values in in the dialog box and click Create. For detailed information
about the specific dialog box for the curve to create, see below:

The Create Line dialog box

A

xx0500001513

Reference

Start point (A)

End Point (B)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.

Click in one of these boxes, and then click the end point in the
graphics window to transfer the values to the End Point boxes.

The Create Circle dialog box

xx0500001512

Reference

Center point (A)

Orientation

Radius (A-B)
Diameter

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Center Point
boxes.

Specify the orientation coordinates for the circle.
Specify the radius of the circle.

Alternatively, specify the diameter.
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Continued
The Create Three Points Circle dialog box
B C
A
xx0500001518
Reference Select the Reference coordinate system to which all positions
or paints will be related.
First Point (A) Click in one of these boxes, and then click the first point in the
graphics window to transfer the values to the First Point boxes.
Second Point (B) Click in one of these boxes, and then click the second point in
the graphics window to transfer the values to the Second Point
boxes.
Third Point (C) Click in one of these boxes, and then click the third point in the
graphics window to transfer the values to the Third Point
boxes.

The Create Arc dialog box

B C
A

xx0500001520

Reference Select the Reference coordinate system to which all positions
or points will be related.

Start Point (A) Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.

Mid Point (B) Click in one of these boxes, and then click the second point in
the graphics window to transfer the values to the Mid Point
boxes.

End Point (C) Click in one of these boxes, and then click the end point in the

graphics window to transfer the values to the End Point boxes.

Continues on next page
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The Create Elliptical Arc dialog box

C
N
BAag\l_
/
_ b

xx0500001522

Reference

Center Point (A)

Major Axis End Point (B)

Minor Axis End Point (C)

Start Angle (o)

End Angle (B)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Center Point
boxes.

Click in one of these boxes, and then click the end point for the
major axis of the ellipse in the graphics window to transfer the
values to the Major Axis End Point boxes.

Click in one of these boxes, and then click the end point for the
minor axis of the ellipse in the graphics window to transfer the
values to the Minor Axis End Point boxes.

Specify the start angle for the arc, measured from the major
axis.

Specify the end angle for the arc, measured from the major axis.

The Create Ellipse dialog box

xx0500001521

Reference

Center Point (A)

Major Axis End Point (B)

Minor Radius (C)

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of the Center Point boxes, and then click the center
point in the graphics window to transfer the values to the Center
Point boxes.

Click in one of these boxes, and then click the end point for the
major axis of the ellipse in the graphics window to transfer the
values to the Major Axis End Point boxes.

Specify the length of the minor axis of the ellipse. The minor
radius will be created perpendicular to the major axis.

Continues on next page
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Continued

The Create Rectangle dialog box

<

xx0500001516

Reference

Start Point (A)

Orientation
Length (B)
Width (C)

Select the Reference coordinate system to which all positions
or paints will be related.

Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.
The rectangle will be created in the positive coordinate
directions.

Specify the orientation coordinates for the rectangle.
Specify the length of the rectangle along the x axis.
Specify the width of the rectangle along the y axis.

The Create Polygon dialog box

xx0500001514

Reference

Center Point (A)

First Vertex Point (B)

Vertices

Select the Reference coordinate system to which all positions
or points will be related.

Click in one of these boxes, and then click the center point in the
graphics window to transfer the values to the Center Point
boxes.

Click in one of these boxes, and then click the first vertex point
in the graphics window to transfer the values to the First Vertex
Point boxes. The distance between the center point and the first
vertex point will be used for all vertex points.

Specify the number of points to be used when creating the
polygon. The maximum number of vertices is 50.

Continues on next page
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The Create Polyline dialog box

xx0500001515

Reference

Point Coordinates

Add
Modify

List

Select the Reference coordinate system to which all positions
or points will be related.

Specify each node of the polyline here, one at a time, by either
typing the values, or by clicking in one of these boxes, and then
selecting the point in the graphics window to transfer its coordi-
nates.

Click this button to add a point and its coordinates to the list.

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

The nodes of the polyline. To add more nodes, click Add New,
click the desired point in the graphics window, and then click
Add.

The Create Spline dialog box

xx0500001517

Reference

Point Coordinates

Ad
Modify

List

Select the Reference coordinate system to which all positions
or points will be related.

Specify each node of the spline here, one at a time, by either
typing the values, or by clicking in one of these boxes, and then
selecting the point in the graphics window to transfer its coordi-
nates.

Click this button to add a point and its coordinates to the list.

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

This nodes of the spline. To add more nodes, click Add New,
click the desired point in the graphics window, and then click
Add.
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9 The Modeling Tab

9.8. Border

9.8. Border

Creating a curve
1. Click Border and then click the border you want to create to bring up a dialog box.

2. Enter requested values in in the dialog box and click Create. For detailed information
about the specific dialog box for the border to create, see below:

The Create Border Between Bodies dialog box
To use the create border between bodies command, the station must contain at least two
objects.

xx0500001524

First Body Click in this box and then select the first body in the graphics
window.

Second Body Click in this box and then select the second body in the graphics
window.

The Create Border Around Surface dialog box
To use the create border around surface command, the station must contain at least one object
with a graphical representation.

xx0500001523

Select Surface Click in this box and then select a surface in the graphics
window.

Continues on next page
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9 The Modeling Tab

9.8. Border

Continued

The Create Border From Points dialog box

To use the create border from points command, the station must contain at least one object.

en0500001531

Selected Object

Point Coordinates

Add
Modify

List

Click in this box and then select an object in the graphics
window.

Specify the points that define the border here, one at a time, by
either typing the values, or by clicking in one of these boxes, and
then selecting the point in the graphics window to transfer its
coordinates.

Click this button to add a point and its coordinates to the list.

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

The points that define the borders. To add more points, click
Add New, click the desired point in the graphics window, and
then click Add.
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9 The Modeling Tab

9.9. Intersect

9.9. Intersect

The Intersect dialog box

xx0600002673

Keep Original

Intersect... (A)

...and (B)

Select this check box to keep the original bodies when creating

the new body.

Select the body from which you want to make an intersection (A)
by clicking it in the graphics window.

Select the body with which you want to make an intersection (B)
by clicking it in the graphics window.
A new body will be created based on the common area between

the selected bodies A and B.
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9 The Modeling Tab

9.10. Subtract

9.10. Subtract

The Subtract dialog box

A

xx0600002674

Keep Original

Subtract... (A)

..with (B)

Select this check box to keep the original bodies when creating
the new body.

Select the body from which you want to subtract (A) by clicking
it in the graphics window.

Select the body you want to subtract (B) by clicking it in the
graphics window.

A new body will be created based on the area of body A
subtracted with the common volume between body A and B.
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9 The Modeling Tab

9.11. Union

9.11. Union

The Union dialog box

A

xx0600002672

Keep Original

Union... (A)

...and (B)

Select this check box to keep the original bodies when creating
the new body.

Select the body that you want to unify (A) by clicking it in the
graphics window.

Select the body that you want to unify (B) by clicking it in the
graphics window.

A new body will be created based on the areas of the two
selected bodies A and B.
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9 The Modeling Tab

9.12. Extrude Surface or Curve

9.12. Extrude Surface or Curve

Extruding a surface or curve
1. From the selection level toolbar, select Surface or Curve, as appropriate.

2. In the graphics window, select the surface or curve you wish to extrude. Click Extrude
Surface or Extrude Curve, as appropriate. The Extrude Surface or Curve dialog box
opens below the Modeling browser.

3. For extrusion along a vector, fill in the values.

For extrusion along a curve, select the Extrude Along Curve option. Click the Curve
box, and select the curve in the Graphics window.

4. If you wish the form to appear as a surface model, clear the Make Solid check box.

5. Click Create.

The Extrude Surface or Curve dialog box

Surface or Curve

Extrude Along Vector
From Point (mm)

To Point (mm)
Extrude Along Curve

Curve

Make Solid

Denotes the surface or curve to be extruded.

To select the surface or curve, first click in the box, then select
the surface or curve in the graphics window.

Enables extrusion along a specified vector.
The start point of the vector.

The end point of the vector.

Enables extrusion along a specified curve.
Denotes the curve used as a sweep path.

~—

xx0600003076

To select the curve, first click the box, then the curve in the
graphics window.

Select this check box to convert the extruded form into a solid.
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9 The Modeling Tab

9.13. Line from Normal

9.13. Line from Normal

Creating a line from normal

1.

Click Surface Selection.

2. Click Line to Normal to bring up a dialog box.

3. Click on a face to select it in the Select Face box.
4.
5
6

In the Length box, specify a length for the line.

. Optionally, select the Invert Normal check box to invert the direction of the line.
. Click Create.
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9.14. The Measure Group

9.14. The Measure Group

TIP!

Q Make sure to select the appropriate snap mode and selection levels before making your

measurements.

Measuring distances or angles
1. Click the type of measurement you want to use:

To measure the

distance between two points you select in the graphics window.

angle defined by three points you select in the graphics window.
The first point to select is the converging point, thereafter you
shall select one point on each line.

diameter, with the circle defined by three points you select from
the graphics window.

closest distance between two objects you select in the graphics
window.

Select

Point to point
Angle

Diameter

Minimum distance

The mouse pointer will turn into a ruler when you have activated any of the measurement

functions.

2. In the graphics window, select the points or objects to measure between. Information
about the measuring points is displayed in the Output window.

The results will be displayed in the Measurements tab in the Output window when all

points have been selected.

3. Optionally, repeat step 3 for making a new measurement of the same type.

TIP!

Q You can also activate and deactivate the measurement functions from the measurement

toolbar.
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9 The Modeling Tab

9.15. Create Mechanism

9.15. Create Mechanism

Create a new mechanism

1.

10.

11.

12.

13.
14.

1